
StruxureWare™ Power Monitoring Expert 8.2
Software Modules – Configuration Guide

7EN42-0148-04
04/2017



Legal Information
The Schneider Electric brand and any registered trademarks of Schneider Electric Industries SAS
referred to in this guide are the sole property of Schneider Electric SA and its subsidiaries. They
may not be used for any purpose without the owner's permission, given in writing. This guide and its
content are protected, within themeaning of the French intellectual property code (Code de la
propriété intellectuelle français, referred to hereafter as "the Code"), under the laws of copyright
covering texts, drawings andmodels, as well as by trademark law. You agree not to reproduce,
other than for your own personal, noncommercial use as defined in the Code, all or part of this guide
on any medium whatsoever without Schneider Electric's permission, given in writing. You also
agree not to establish any hypertext links to this guide or its content. Schneider Electric does not
grant any right or license for the personal and noncommercial use of the guide or its content, except
for a non-exclusive license to consult it on an "as is" basis, at your own risk. All other rights are
reserved.

Electrical equipment should be installed, operated, serviced andmaintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of
the use of this material.

As standards, specifications and designs change from time to time, please ask for confirmation of
the information given in this publication.



Safety Information

Important Information
Read these instructions carefully and look at the equipment to become familiar with the
device before trying to install, operate, service or maintain it. The following special
messages may appear throughout this bulletin or on the equipment to warn of potential
hazards or to call attention to information that clarifies or simplifies a procedure.

The addition of either symbol to a "Danger" or "Warning" safety label indicates
that an electrical hazard exists which will result in personal injury if the
instructions are not followed.
This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

DANGER
DANGER indicates a hazardous situation which, if not avoided, will result in death or serious
injury.

WARNING
WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

CAUTION
CAUTION indicates a hazardous situation which, if not avoided, could result inminor or
moderate injury.

NOTICE
NOTICE is used to address practices not related to physical injury.

Please Note
Electrical equipment should be installed, operated, serviced andmaintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of
the use of this material.

A qualified person is one who has skills and knowledge related to the construction, installation, and
operation of electrical equipment and has received safety training to recognize and avoid the
hazards involved.
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Safety precautions
During installation or use of this software, pay attention to all safety messages that occur in the
software and that are included in the documentation. The following safety messages apply to this
software in its entirety.

DANGER
ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

• Apply appropriate personal protective equipment (PPE) and follow safe electrical work
practices. In the USA, see NFPA 70E.

• Only qualified electrical workers should install this equipment. Read the entire set of
instructions before performing this work.

• NEVER work alone.
• Disconnect all sources of electric power before performing visual inspections, tests, or
maintenance on this equipment. Assume that all circuits are live until they have been
completely de-energized, tested, and tagged. Pay particular attention to the design of the
power system.

• Consider all sources of power, including the possibility of backfeeding.
• Turn off all power supplying the powermeter and the equipment in which it is installed before
working on it.

• Always use a properly rated voltage sensing device to confirm that all power is off.
• Carefully inspect the work area for tools and objects that may have been left inside the
equipment before closing all covers and doors.

• Use caution while removing or installing panels so that they do not extend into the energized
bus; avoid handling the panels, which could cause personal injury.

• NEVER bypass external fusing.
• Install the powermeter in a suitable electrical enclosure.

Failure to follow these instructions will result in death or serious injury.

WARNING
UNINTENDED EQUIPMENT OPERATION

• Only personnel with a thorough understanding of ION architecture and the system in which the
meters and software are installed can configure ION modules and registers.

• Do not usemeters or the software for critical control or protection applications where human or
equipment safety relies on the operation of the control circuit.

• Do not use an ION meter's digital output for any safety critical application.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.



WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the devices and software.
• Do not rely solely on reports to determine if the system is functioning correctly or meeting all
applicable standards and requirements.

• Use reports as a supplement to proper workplace practices or equipment maintenance, not as
a substitute.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

WARNING
INACCURATE DATA RESULTS

Do not install incorrect drivers for the circuit breakers in your system.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

• Change default passwords to help prevent unauthorized access to device settings and
information.

• Disable unused ports and default accounts to helpminimize pathways for malicious attackers.
• Place networked devices behindmultiple layers of cyber defenses (such as firewalls, network
segmentation, and network intrusion detection and protection.)

• Use industry-accepted Information Technology andOperational Technology cyber security
practices to help prevent loss or exposure of data, modification or deletion of logs and data,
and interruption of services.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

NOTICE
LOSS OF SYSTEM CONFIDENTIALITY / INTEGRITY / AVAILABILITY

Do not store the username and password in a file.

Failure to follow these instructions can result in unauthorized access to, modification of,
and unavailability of the system.

Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide Safety precautions
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Software Modules
In addition to the foundational solution, a set of softwaremodules is available to use with Power
Monitoring Expert, and the Data Center and Healthcare Editions (hereafter collectively referred to as
PowerMonitoring Expert). Depending on your system, thesemodules enhance the capabilities of
PowerMonitoring Expert by helping to better manage system equipment, increase power efficiency
and capacity, monitor and log data to capture electrical events, and bill tenants.

The following diagram illustrates the softwaremodules that can be used with PowerMonitoring
Expert:

This guide includes detailed information on how to configure the PowerMonitoring Expert software
modules.

NOTE: Each softwaremodule requires a license to be used. Contact your Schneider Electric
representative for more information.
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Breaker Performance
The Breaker Performancemodule lets youmanage and report on breaker performance and wear.

The Breaker Performancemodule includes the following configuration tool and report:

l "Breaker Aging Configuration Tool" on page 12

l "Circuit Breaker Aging Report" on page 25

Breaker Aging Configuration Tool
The Breaker Aging Configuration Tool supplies circuit breaker aging and wear data for devices in
your system to PowerMonitoring Expert. Using this feature, you canmonitor and report on the
status of circuit breaker aging and wear in your electrical system.

WARNING
INACCURATE DATA RESULTS

Do not install incorrect drivers for the circuit breakers in your system.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Supported devices
The Breaker Aging Configuration Tool in PowerMonitoring Expert supports the following devices:

Standard / Country Circuit Breaker Range Control Unit Range

IEC

l Masterpact NT

l Masterpact NW

l Compact NS630b-3200

l Micrologic 2 A/E

l Micrologic 5 A/E/P/H

l Micrologic 6 A/E/P/H

l Micrologic 7 A/P/H

Micrologic 5.2/6.2/5.3/6.3 A/E
l Micrologic 5 A/E

l Micrologic 6 A/E/E-M

China

Compact NS630b-1600

l Micrologic 2 A

l Micrologic 5 A

l Micrologic 6 A

Masterpact MT

l Micrologic 2 A

l Micrologic 5 A/E/D/P/H

l Micrologic 6 A/E/D/P/H

l Micrologic 7 A/P/H

PowerPact H-, J-, and D-Frame Same asabove



Standard / Country Circuit Breaker Range Control Unit Range

USA

l Masterpact NT for IEC, UL, and
ANSI standards

l Masterpact NW for IEC, UL, and
ANSI standards

l Compact NS630b-3200

l PowerPact H-, J-, and L-Frame

l Micrologic 2 A

l Micrologic 3 A

l Micrologic 5 A/P/H

l Micrologic 6 A/P/H

PowerPact H-, J-, and D-Frame Same asabove

Setting up the system

Adding Circuit Breaker devices
Add all necessary Circuit Breaker devices to your PowerMonitoring Expert system using the
Management Console.

For instructions on how to add Circuit Breaker devices toManagement Console, see "Adding the
SER-2408/SER-3200 toManagement Console" on page 281.

Starting the ION software Modbus Gateway service
1. Open theWindows Services panel by clickingStart > Administrative Tools > Services.

2. Make sure that ION software Modbus Gateway Service is both enabled and started/running.
If the service is not enabled, then start and enable the service.

Adding new calculation service provider
1. InWindows Explorer navigate to ...\[Install path]\system\bin and double-click

ModbusServiceConfigurationTool.exe to run it. The configuration dialog appears.

2. Click Add. TheAdd Service Window dialog appears.

Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide Breaker Performance
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3. From Available Services select Breaker Aging Calculation Service.

4. InUnit ID enter a value of 1 if this is the first service provider you are adding. Otherwise, enter
the next logical value for Unit ID.

NOTE: If you have already setup the "Telvent Weather Data Import Service" on page 213
and used UNIT ID = 1, then youmust enter a unit ID other than 1, (for example, 2).

5. Click Configure. TheBreaker Aging Service Configuration dialog appears. Leave these
values as the default.

Real Time Request Polling Interval (in sec): This is the frequency (in seconds) that is used
to request real-timemeter data for calculations.

Real Time Request Priority Level: This is the level of priority for real-timemeter request.
The levels are:

Frequency (in seconds) Priority

0 Low

250 Medium

500 High

1000 Intermediate

5000 Urgent

10000 Control

NOTE: These settings are for advanced users only andmay bemodified if certain load
conditions in the system require that the polling priority and frequency of real-timemeter
data be decreased or increased.

NOTE: These settings only apply to real-time data requests These settings only apply to
real-time data requests for breaker aging and wear calculations, and are independent of
other types of requests in the system (such as VISTA diagrams, Gadgets, and so forth.)



6. Click OK. TheBreaker Aging Calculation Service appears in the list.

A dialog appears informing you about the configuration change.

7. Click Yes to continue and to restart theModbus Software Gateway Service.

Adding a new site for the calculation service
Add a new site in Management Console that will communicate with the Circuit Breaker Aging
Calculation service.

NOTE: These steps are only necessary if you have not yet set up and configured a site for a
service (that uses theModbus Software Gateway Service), such as the Telvent Weather Data
Import Service. If you have already set up and configured a site for a service, you can ignore
the following steps.

1. OpenManagement Console. TheManagement Console dialog appears.

2. In the left pane, click Site.

3. Right-click the dialog and chooseNew > Ethernet Gateway Site.
TheEthernet Gateway Site Configuration dialog appears. Complete the fields.

Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide Breaker Performance
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4. Name: EnterBreakerAgingWearSite.

5. TCP/IP Address: Enter <your local PME server IP address>.

6. TCP/IP Port: EnterModbusTCP Device|502.

7. Computer: Enter <your local PME server IP address>.

8. Click OK. The new site is created.

Adding new device for the calculation service
Add a new device in Management Console to the new BreakerAgingWearSite that will
communicate with the Circuit Breaker Aging Calculation service.

1. OpenManagement Console. TheManagement Console dialog appears.

2. In the left pane, click Device.

3. Right-click on the dialog and chooseNew > Serial Device on Ethernet Gateway Site. The
Serial Device Configuration dialog appears. Complete the fields. Items in red areman-
datory.



4. Group: EnterBREAKERS.

5. Name: EnterBreakerAgingWearProvider.

6. Device Type: EnterBreaker Aging And Wear Provider.

7. Unit ID: Enter the sameUnit ID you configured in theModbus Gateway Service configuration
tool.

8. Site: Enter the same site name you entered in the configuration tool. Ideally, the site name you
enter can be shared for both Breaker Aging and Telvent.

9. Enabled: EnterYes.

10. Click OK. The new device appears in the list.

Configuring breaker devices
Use the Breaker Aging Configuration Tool to configure breaker devices.

To configure breaker devices:

1. Navigate to the ...\system\bin folder and then double-click Breaker Aging Con-
figuration Tool. If this is the first time you are configuring data, choose the regional setting for
circuit breaker and wear library and then click OK.

TheBreaker Aging Configuration Tool dialog appears.

Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide Breaker Performance
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2. Click theBreaker Device tab, and then click New to add one or more breakers to the system.
The configuration dialog appears.

3. For each breaker device enter the following information:

l Name: Enter a unique name to identify this breaker in the generated Vista diagrams and the
Circuit Breaker Aging report.

l Source: Associate the device that is to provide data for this breaker (such as load values,
total harmonic distortion, and so forth). Note that you can only associate each device in the
system with one breaker device.

l Use the dropdown lists to select values forRange, Designation, Rating, andControl
Unit Rating.

l Voltage: Enter a value.



4. Click Is existing breaker device? if the breaker device already exists in the system.

NOTICE
UNINTENDED OPERATION

If you select the check box for Is existing switchboard?, go to the PME Exchange
Community web site and search for "Is existing switchboard." Open and read the
knowledgebase article, and then follow the instructions.

Failure to follow the instructions in the knowledgebase article will result in this
feature not functioning as intended.

5. If you select this check box, complete the available fields for each existing breaker device.

After you finish adding and configuring all necessary breaker devices, create any switchboards
necessary.

Configuring switchboards
To configure the switchboards:

1. InWindows Explorer navigate to the ...\system\bin folder and double-click Breaker
Aging Configuration Tool. If this is the first time you are configuring data, choose the
regional setting for circuit breaker and wear library and then click OK.

TheBreaker Aging Configuration Tool dialog appears.

2. Click theSwitchboard tab, and then click New to add one or more Switchboards to the sys-
tem. The configuration dialog appears.

Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide Breaker Performance
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3. For each switchboard enter the following information:

l Name: Enter a unique name to identify this switchboard in the generated Vista diagrams
and the Circuit Breaker Aging report

l Critical Threshold % andModerate Threshold %: Enter default values (0-100%) to be
used for each breaker associated with this switchboard when performing analysis of their
electrical aging and electrical wear levels.

l Environmental Conditions: Use dropdown lists to select values forSwitchboard IP,
Salty Atmosphere, Corrosive Gas, andDust Level.

l Sensor Data: Select one of twomodes, and then use the dropdown lists to select values for
the parameters.

l Manual: Define static values for humidity, temperature, and vibration levels experience
in the switchboard.

l Monitored: Associate the switchboard with an optional IO device in the system that is to
provide real-time values for humidity, temperature, and vibration levels measured in the
switchboard.

NOTE: If you enter a value of "0" (zero), that level is ignored for the calculations.

l Breakers: Select one or more breakers from the list. Note that each breaker can be asso-
ciated with only one switchboard in the system.

4. Click Is existing switchboard? if the switchboard already exists in the system.



NOTICE
UNINTENDED OPERATION

If you select the check box for Is existing switchboard?, go to the PME Exchange
Community web site and search for "Is existing switchboard." Open and read the
knowledgebase article, and then follow the instructions.

Failure to follow the instructions in the knowledgebase article will result in this
feature not functioning as intended.

5. If you select this check box, use the dropdown lists to complete the fields forVibration Level,
Temperature, andHumidity for each existing switchboard.

After you finish configuring all existing switchboards, create any groups as necessary.

Configuring groups
Use the Breaker Aging Configuration Tool to configure groups. Youmust configure groups to
generate the Circuit Breaker Aging Report.

To configure groups:

1. Navigate to the ...\system\bin folder and double-click Breaker Aging Configuration
Tool. If this is the first time you are configuring data, choose the regional setting for circuit
breaker and wear library and then click OK.

TheBreaker Aging Configuration Tool dialog appears.

2. Click theGroups tab, and then click New to add one or more Switchboards to the system. The
configuration dialog appears.

Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide Breaker Performance

© 2017Schneider Electric. All RightsReserved. Page 21 of 308

https://exchangecommunity.schneider-electric.com/community/power-management-community/software/pme
https://exchangecommunity.schneider-electric.com/community/power-management-community/software/pme


Breaker Performance Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide

Page 22 of 308 © 2017 Schneider Electric. All RightsReserved.

3. For each group enter the following information:

l Name: Enter a unique name to identify this group in the generated Vista diagrams and the
Circuit Breaker Aging report

l SwitchboardsSelect one or more switchboards from the list. Note that a switchboard can
be used inmultiple groups, if necessary.

After you have created all breakers, switchboards, and groups, you can generate a set of
optional Vista diagrams.

4. Click theGroups tab, and then click Generate Vista Diagrams. A Vista Diagram Gen-
eration configuration dialog appears.



NOTE: TheOutput Path shows the location where the Vista diagram.dgm file is saved
after clickingGenerate Vista Diagrams.

5. Click Include Custom Logo and then navigate to and select the file to include a custom logo
in your diagrams. Otherwise, a Schneider Electric logo appears.

6. UnderOptions, drag the indicator to define the width of Vista diagrams you generate.

7. Click Generate Vista Diagrams to generate the DMG files, then click OK andClose.

Pasting the Circuit Breaker Aging Framework in VIP

WARNING
UNINTENDED EQUIPMENT OPERATION

• Only personnel with a thorough understanding of ION architecture and the system in which the
meters and software are installed can configure ION modules and registers.

• Do not usemeters or the software for critical control or protection applications where human or
equipment safety relies on the operation of the control circuit.

• Do not use an ION meter's digital output for any safety critical application.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

1. Open theDesigner tool and open theVIP.<server_name>. node.

2. Go to ...\config\fmwk\BreakerAging\CB Aging Grouping Status Frame-

work.fwn and select Edit > Paste to paste the framework.

Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide Breaker Performance
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3. Connect the inputs of each AND/OR module labeled Device_xx to the Breaker Aging and
Wear Provide overall status (Nodes > Status Measurements > Overall Status
> OverallStatus@CBname).

4. Repeat this step for each Circuit Breaker in Group_01 and for all other groups as required.

5. Delete the Devices_xx andGroups_xx that do not exist.

6. Save the framework.

Opening Vista Diagrams and Linking the Status
1. Log in to Vista, select Open File and then browse to ...\-

config\diagrams\ud\BreakerAging\Groups.dgm.

2. Manually link the status object to the framework you pasted in VIP in the previous steps.

For example:

3. Repeat this step for all other groups. Your Circuit Breaker Monitoring system is now setup.

For example:



NOTE: Any Circuit Breakers in the groups that require attention show a red LED indicator.

4. Manually link the status object from the framework you pasted in the VIP in previous steps.

After you finish configuring all circuit breakers, you can configure and generate the Circuit Breaker
Aging Report.

Circuit Breaker Aging Report
Use PowerMonitoring Expert > Web Applications > Reports to configure and generate the Circuit
Breaker Aging Report.

WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the devices and software.
• Do not rely solely on reports to determine if the system is functioning correctly or meeting all
applicable standards and requirements.

• Use reports as a supplement to proper workplace practices or equipment maintenance, not as
a substitute.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

To configure and generate the Circuit Breaker Aging Report:

1. Complete the fields to define the report:

l Title - Enter a name for the report. It appears in the header section of the report.

l Select Group - Select a group from the dropdown list to be used for determining which
switchboards and breakers are used for the analysis.

l Grouped By - Select from the dropdown list to determine how the circuit breaker aging and
electrical wear analysis results are sorted.

Switchboard Name first and Threshold Level second - The results are sorted first by
the names (in alphabetical order) of all the switchboards associated with the selected group,
and then by the criticality level in descending order of importance (Critical, Moderate,
Minor).

Threshold Level first and Switchboard Name second - The results are sorted first by
criticality level in descending order of importance (Critical, Moderate, Minor), and then by
the names (in alphabetical order) of all the switchboards associated with the selected group

l Include Breakers with Minor Aging and Wear - Select Yes or No. Selecting Yes allows
all the breakers to appear in the report regardless of the current electrical aging and electrical
wear levels. Selecting No allows only breakers with moderate or critical electrical aging and
electrical wear to appear.

l Include Data Warnings - Select Yes or No.

2. Click Generate Report to produce the report.

Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide Breaker Performance
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Formore information on generating andmanaging reports, see the "Reports" section of theWeb
Applications help file.



Energy Analysis
The Energy Analysis module lets you understand energy usage patterns to find energy waste,
analyze transformer and circuit capacity as configurations change, determine what factors
contributemost to energy usage, and assess energy usage by process area or by product output.

The Energy Analysis module consists of the following reports:

l "Energy Regression Analysis Report" on page 27

l Duration Curve Report 1

l Energy Usage per State Report 1, 2

l Multi Equipment Operation Reports 1, 2

l Power Usage per State Report 1, 2

l Single Equipment Operation Reports 1, 2

1 Formore information on how to use the Energy Analysis reports, see PowerMonitoring Expert
Web Applications help.

2 Formore information on how to configure the equipment state reports, see How to Configure the
Energy Analysis Module on the PME Exchange Community.

Energy Regression Analysis Report
TheEnergy Regression Analysis report lets you analyze building energy systems, monitor
energy consumption, andmonitor for anomalies or changes in system behavior. Based on the report
results, you can perform energy efficiency upgrades or fixes as needed, or model energy data one
independent variable at a time with a wide range of desired independent variables.

Configure and generate the Energy Regression Analysis Report
Use the Reports module inWeb Applications to configure and generate the Energy Regression
Analysis Report.

1. Complete the fields to define the report:

l Title - Enter a name for the report. It appears in the header section of the report.

l Driver Data Source - Select a grouping and single source for the report.

l Driver Data Quantity - Select a grouping and a corresponding single quantity that is used to
calculate the values for the X-axis of the Regression Analysis Chart. For example, you can
use a weather data source and quantity as the driver for themodel you intend to generate.

l Model Data Source - Select a grouping and single source for the report.

l Model Data Quantity - Select a grouping and a corresponding single quantity that is used to
calculate the values for the X-axis of the Regression Analysis Chart. For example, you can
use a building electrical consumption data source and quantity as the input data for the
model you intend to generate.
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l Reporting Period - Select from the list to specify a period of time for the report that is used
to query data from the database for driver andmodel data. Select the server time from the
next dropdown list.

l Regression Type - Select Single Line or Broken Line as the type of line to be used in the
report.

l X-Axis Calculation Method - Select how data is grouped for the X-axis values from these
calculationmethod options: Cooling Degree Days (CDD), Heating Degree Days (HDD),
Average (AVG), Sum, and Delta.

Driver quantity data is retrieved differently depending on which calculationmethod you
select:

l Cooling Degree Days: All data points within the selected reporting period that are above
the Degree Days Pivot Point temperature are retrieved from the database. Any data point
at or below the Degree Days Pivot Point temperature is set to 0.

l Heating Degree Days: All data points within the selected reporting period that are below
the Degree Days Pivot Point temperature are retrieved from the database. Any data point
at or above the Degree Days Pivot Point temperature is set to 0.

l Average: All data points within the selected reporting period are retrieved from the data-
base.

l Sum: All data points within the selected reporting period are retrieved from the database,
and values are summedwith previous points as they are inserted into the X data table.

l Delta: All data points within the selected reporting period are retrieved from the database,
and values are calculated by subtracting previous points before inserting them into the X
data table.

NOTE: This parameter depends on selecting the Driver Data Quantity parameter. You
can select either "Cooling Degree Days" or "Heating Degree Days" only if the driver
data is weather temperature data in Celsius or Fahrenheit degrees.

l Degree Days Pivot Point - Enter a value in degrees Celsius to define the base tem-
perature in the heating degree days and cooling degree days calculations. By default, this
value is set to 18, which represents 18 degrees Celsius.

NOTE: This parameter depends on selecting the Driver Data Quantity parameter. The
units for this valuemust match the units for the Driver Data Quantity value.

l Y-Axis Calculation Method - Select how data is grouped for the Y-axis values from these
calculationmethod options: Average, Sum, and Delta.

Model quantity data is retrieved differently depending on which calculationmethod you
select:

l Average: All data points within the selected reporting period are retrieved from the data-
base.

l Sum: All data points within the selected reporting period are retrieved from the database,
and values are summedwith previous points as they are inserted into the Y data table.



l Delta: All data points within the selected reporting period are retrieved from the database,
and values are calculated by subtracting previous points before inserting them into the Y
data table.

NOTE: This parameter depends on selecting theModel Data Quantity parameter.
Select Sum only if themodel data is interval data. Select Delta only if themodel data
is cumulative data.

l Aggregation Interval - Select how driver andmodel data will be combined to be processed
from these two options:

l Day - For daily aggregation, the data collected over the designated reporting period is
grouped into days, and an average value is taken for each day.

l Week - For weekly aggregation, the data collected over the designated reporting period is
grouped into weeks, and an average value is taken for each week.

l Exclude Incomplete Weeks - Determines if incomplete sets of data from the report cal-
culations are removed.

When you select Yes, any week that does not have a value very close to the start (within
the first hour of the first day of the week) and a value very close to the end (within the last
hour of the last day of the week) is considered incomplete, and any data for that week will be
disregarded.

This parameter depends on the Aggregation Period parameter. This check is only used
when you select "Week" for the aggregation period.

l Exclude Incomplete Days - Determines if incomplete sets of data from the report cal-
culations are removed.

When you select Yes, then any day that does not have at least 80% of the calculated
average number of values collected per day is considered incomplete, and any data for that
day will be disregarded.

This parameter depends on the X- and Y- Axis CalculationMethod parameters. This check
is used on both axes when you select "CDD,"HDD," "AVG," or "Sum."

l Exclude Days with Rollover - Determines if incorrect data from the report calculations is
removed due to ameter register rollover.

When you select Yes, then if the absolute value of the data point at the end of the day is
greater than the absolute value of the data point at the beginning of the day, rollover has
occurred, and any data for that day will be disregarded.

This parameter depends on the Y- Axis CalculationMethod parameter. This check is only
used on the Y-axis when you select "Delta."

l Deviation Type - Allows you to select "Percent" or "Absolute Value" deviation type from
the list to specify how the report determines when data exceptions appear in the report
charts and tables. These deviations refer to discrepancies in the Y-axis between the ideal
regression line and real data points.
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There are two deviation types:

l Percent - Select "Percent" to specify that themaximum authorized deviation value has
percentage units. Exceptions are displayed on the charts and logged in the Exceptions
Table for any data points whose Y value falls outside of the designated percent range
above or below the ideal regression line. This range will grow as one shifts rightwards
along the regression line and Y values become larger.

l Absolute Value - Select "Absolute Value" to specify themaximum authorized deviation
value has the same units as the Y-axis measurement. Exceptions are displayed on the
charts and logged in the Exceptions Table for any data points whose Y value falls outside
of the designated value range above or below the ideal regression line. This range will
stay constant as one shifts rightwards along the regression line.

l Max Authorized Deviation - Enter a value in the field. This parameter depends on what
you select for Deviation Type. If you select "Percent," the units for Max Authorized Devi-
ation will be percent. If you select "Absolute Value," the units for Max Authorized Deviation
will correspond to the units for theModel Data Quantity.

l Include Data Warnings - Select "Yes" to include informational messages related to the
report, or "No" to exclude thesemessages.

l Include Report Parameters Summary - Select "Yes" to include a summary of the input
parameters at the beginning of the generated report, or select "No" to exclude them.

2. Click Generate Report to produce the report.

See "Interpreting the Energy Regression Analysis Report results" on page 285 for information on
reading and interpreting the report.

For more information on generating andmanaging reports, see the "Reports" section of theWeb
Applications help file.



Energy Billing
The Energy BillingModule is a fully functional energy-based billing reporting system that consists of
the following reports:

l Billing Report

l Billing Summary Report

l Multiple Billing Report

l Multiple Billing Export Report

For more information on how to use the Billingmodule, see the BillingModule Toolkit on the PME
Exchange Community.
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IT Billing
The IT BillingModule provides information on energy usage for use within a data center facility for
billing purposes.

The IT BillingModule includes the "Energy by IT Customer Report" on page 32.

NOTE: The IT BillingModule also includes the "Energy Billing" on page 31.

Energy by IT Customer Report
The Energy by IT Customer Report is used by data center operators to generate a report that
provides information regarding energy usage for customers within the data center facility.

NOTE: This report requires a license to be used. Contact your Schneider Electric representative
for more information.

Use the Energy by IT Customer Report to:

l Troubleshoot your billing system

l Export your billing system (for CSV export)

l Examine customer specific energy usage.

NOTE: For the Energy by IT Customer Report to provide accurate information, devices must be
installed, configured, and communicating correctly, the hierarchy must be set up and configured
correctly, and theManaged Circuits feature run each time a device configuration change is
made. If any of these tasks are not performed correctly, your reports will provide inaccurate
information.

For more information on generating andmanaging reports, see the "Reports" section of theWeb
Applications help file.

NOTE: Report output will vary depending on which hierarchy you are using.

Energy by IT Customer Report Example
The Energy by IT Customer Report data depends on the selections youmake while configuring the
report and the contents of the PowerMonitoring Expert or Data Center database.



Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide IT Billing

© 2017Schneider Electric. All RightsReserved. Page 33 of 308



EmergencyPower SupplySystem (EPSS) Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide

Page 34 of 308 © 2017 Schneider Electric. All RightsReserved.

Emergency Power Supply System (EPSS)
The Emergency Supply System (EPSS)Module is a licensablemodule you can add to Power
Monitoring Expert solutions.

PowerMonitoring Expert provides datamonitoring and logging to capture electrical events and
readings. The EPSS module provides the specific tools and reports to help staff at medical facilities
manage the power data specifically for EPSS tests or during loss of power from amain utility.

Schneider Electric or Schneider Electric System Integrators generate reports that government and
organizational inspectors may view as an aid to help determine if an EPSS is in an adequate state to
generate electrical power during a utility outage.

NOTE: A PowerMonitoring Expert system supports both Open Transition Transfer (OTT) and
Closed Transition Transfer (CTT). By default, the PowerMonitoring Expert system is set for
OTT. However, if your customer needs to run a CTT test, navigate to the PowerMonitoring
Expert Exchange Community web site, in the Install andMaintain section, and then download
and run the necessary SQL script.

In addition to the features provided by the base system, the EPSS provides these capabilities:

l Vista diagrams –Generates the system Vista diagrams based on the transfer switch and
backup generator configuration.

l Real-time data in Vista – Diagrams show electrical data, generator status, transfer switch
status and electrical data, and fuel management data.

l EPSS Test Report – A comprehensive report of load supporting capabilities for the transfer
switches, generators, and equipment. You can use this report to evaluate the overall condition
of the EPSS.

l Run history viewer – Displays Test, Load Shedding, and Power Outage run activities stored
in the system history.

WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the EPSS system, this can lead to inaccurate reports and/or data
results.

• Do not rely solely on EPSS reports to determine if the EPSS system is functioning correctly or
meeting all applicable standards and requirements.

• Use EPSS reports as a supplement to proper workplace practices or equipment maintenance,
not as a substitute.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

https://exchangecommunity.schneider-electric.com/community/power-management-community/software/pme
https://exchangecommunity.schneider-electric.com/community/power-management-community/software/pme


EPSS configuration overview
To configure PowerMonitoring Expert with the EPSS Test module, follow these general steps:

1. Obtain and install a license for the EPSS Test module.

2. Set up the installed ION meters, including ATS and generator frameworks. See "ION power
meter configuration" on page 222 for details.

3. Set up the installed non-ION meters, including digital and analog outputs. See "Non-ION
powermeter configuration" on page 242 for details.

4. Generate and configure Vista diagrams of EPSS equipment. See "Generating the EPSS Vista
diagrams" on page 58.

5. Set up reporting entities in the configuration tool. See "Generator Performance Configuration
Tool with EPSS Test Module" on page 36.

6. Configure and run the EPSS Test Report. See "EPSS Test Report" on page 62.

Before you start the configuration process, review the following sections to learnmore about the
EPSS Test module.

About Emergency Power Supply System (EPSS)
An Emergency Power Supply System (EPSS) provides emergency electrical power to any facilities
requiring continuous power, 24 hours a day, 7 days a week. Among these facilities are hospitals and
medical centers.

In many jurisdictions, hospitals andmedical centers need to test their emergency power supply
systems on a periodic basis and keep records of such tests. Hospitals andmedical centers in the
USA, for example, must meet the standards specified by the Joint Commission on Accreditation of
Hospital Organizations (JCAHO) to operate their facilities. These standards include the testing of
generator systems. These JCAHO standards are derived from both National Fire Protection
Association (NFPA) and National Electrical Code (NEC) requirements.

PowerMonitoring Expert uses the Generator Performance Configuration Tool with EPSS Test
Module to generate reports that government and organizational inspectors may view as an aid to
help determine if an EPSS is in an adequate state to generate electrical power during a utility
outage. These reports demonstrate compliance not only with the JCAHO standards, but also with
the standards mandated by many other geographies, such as:

l National Electric Code Article 220.87 for the United States of America.

l HTM 0601 for the United Kingdom.

l AS/NZS 3009 for Australia and New Zealand.

l 60364-7-710 for Europe.

l CSA Z32 for Canada.

EPSS test sequence of events
The following diagram represents what happens in a backup power system when the power supply
system is tested.
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The diagram depicts:

l The ATS events Normal, Test, and Emergency along the top.

l The corresponding GEN (generator) events Stop, Start, and Running along the bottom.

These ATS andGEN events are required by the Test Report to execute its logic.

You can use this diagram to identify which events in the power system correspond to the ATS and
GEN events represented in the diagram, and to help ensure that the correct signals are wired to the
meter's digital inputs.

The diagram also identifies which events are used to control logging of Analog and Load Profile
data, shown beginning at GEN Start in the diagram.

Generator Performance Configuration Tool with EPSS
Test Module

NOTE: If your installation does not include the EPSS, see "Generator Performance
Configuration Tool" on page 71.

Use theGenerator Performance Configuration Tool with EPSS Test Module to configure the
transfer switches, generators, and other equipment to report the data and status of the power
system, including EPSS components.

In the configuration tool, you can also generate the Vista diagrams for the configured devices. This
feature of the tool produces the diagrams faster than building the diagrams manually. Generated
diagrams may still need some adjustment—you can use Vista to finalize the diagrams

After your system is configured using the Generator Performance Configuration Tool with EPSS
Test Module, you can use the following generator-related reports:

l Generator Activity Report

l Generator Battery Health Report



l Generator Capacity Report (available for PowerMonitoring Expert 8.2 – Healthcare Edition
only)

l Equipment Capacity Report (available for PowerMonitoring Expert 8.2 – Healthcare Edition
only)

l EPSS Test Report (requires a license for the EPSS Module)

Prerequisites
l Before opening the configuration tool, make sure the sources—which represent metering
devices—are added inManagement Console and they are communicating.

Starting the Generator Performance Configuration Utility with EPSS
To start the Generator Performance Configuration Tool with EPSS Test Module, open the Power
Monitoring Expert folder on the desktop and double-click the Generator Performance Configuration
Tool shortcut.

TheGenerator Performance Configuration Tool with EPSS Test Module window contains these
tabs: Groups, Generators, Transfer Switches, Equipment, andRun History. On these tabs, you
create the entities and groups for equipment in the system. You also create Vista diagrams and
view data for prior test run results. Use the tabs to define new entities or update existing entities.

When you first use the configuration utility, define generators, transfer switches, and other
equipment on the applicable tabs. After you do this, define the device groups on theGroups tab.
The device groups are necessary for reporting and Vista diagrams.

Use the following tabs to configure the tool:

l Groups tab - "Define EPSS groups" on page 52

l Generators tab - "Define EPSS generators" on page 38

l Transfer Switches tab - "Define EPSS transfer switches" on page 46

l Equipment tab - "Define EPSS Equipment" on page 51

l Run History tab - "View EPSS run history" on page 55

Use the following common controls for the tabs:

l Help - Click this to view online help for the tab.

l New - Creates a new entry in the grid.

l Delete - Deletes the selected entry from the grid.

l Revert - Returns amodified record to its original values, if OK orApply have not been clicked.

l OK - Saves all changes and exits the configuration tool.

l Cancel - Exits the tool without saving changes.

l Apply - Saves all changes and leaves the tool open.

TheModified column in the grid area shows the status of the row data:

+ (plus) - a new entry.

* (asterisk) - a modified entry.
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! (exclamationmark) - entry needs more information before it can be saved.

Define EPSS generators
Use theGenerators tab to create or update entities representing the generators in the emergency
power supply system. Configure this tab to successfully generate reports for generator data. After
you configure the generators, you can generate the Generator Test, Generator Load Summary,
Generator Capacity, and the Generator Battery Health reports from this information.

You can perform the following actions on this tab:

l Click New to define the properties of the generators in the system. See "Creating
EPSS generators" on page 38.

l Click Clone to define a new generator that is like an existing generator. The system copies
many details of the existing device into the new entry. You can then enter the unique details of
the new device. If you need to define several devices that are similar, this feature can help you
define them quickly. See "Cloning EPSS generators" on page 42.

l Click Delete to remove records from the system.

l Click Revert (before you click Apply orOK) if youmake changes to a record and want to revert
to your initial settings.

Creating EPSS generators
TheEdit Generator area on the tab is used to create a generator entry and to define specific values
for it.

To create an EPSS generator:



1. On theGenerator tab, click New.

2. Complete the following fields to define a generator.

l Name - Enter a unique name to identify the generator.

l Description - (Optional) You can add specific information about the generator, such as
make andmodel.

l Electrical Data

l Source - Select a source name from the dropdown list. The source represents the device
that records the electrical data from the generator.

l Prime Nameplate Rating - Enter themaximum power load for the generator. Refer to
the generator's nameplate for this value.

l Unit - Select the unit of measurement for the power load.

l Engine Temperature Data - (Optional) To capture engine temperature data, check the box
and complete these fields:

l Source - Select a source name. The source represents the device that records the
engine temperature of the generator.

l Measurement - Select the engine temperaturemeasurement.

l Unit - Select either F (for Fahrenheit) or C (for Celsius) for the temperature unit of meas-
urement.

NOTE: The EvaluationMethod does not convert units from one type to another. Set
the Unit type for Engine Temperature Data on theGenerators tab to the sameUnit
type in the EvaluationMethod.

l Click Edit Evaluation Method to open theEvaluation Method editor. TheEvaluation
Method editor is used to select the evaluationmethod and the respective pass/fail cri-
teria that you want to use when evaluating a generator. See "Editing the EPSS generator
evaluationmethod" on page 43.

l Click Assign Engine Data to open theEngine Data Measurements editor. TheEngine
Data Measurements editor is used to define engine data values and other custom data
values for generators. Defining engine datameasurements is optional. See "Editing
engine data" on page 44.

l Click Assign Engine Data to open theAssign Engine Data Measurement editor. The
Engine Data Measurement editor is used to associate engine data values with specific
generator measurements. For information about this activity, see "Assigning engine data"
on page 46.

l Exhaust Gas Temperature Data - (Optional) If exhaust gas data is not being captured, you
do not need to select and complete these values. To capture exhaust data, check the box
and complete these fields:

l Source - Select a source name. The source represents the device that records the
exhaust gas temperature of the generator.
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l Single Exhaust orDual Exhaust - Select one of these options to indicate whether the
exhaust gas temperature is measured for a single exhaust or a dual exhaust generator.

l Measurement - Select the exhaust gas temperaturemeasurement.

l Unit - Select either F (for Fahrenheit) or C (for Celsius) for the temperature unit of meas-
urement.

l Click Edit Evaluation Method to open theEvaluation Method editor. TheEvaluation
Method editor is used to select the evaluationmethod and the respective pass/fail cri-
teria that you want to use when evaluating a generator. See "Editing the EPSS generator
evaluationmethod" on page 43.

l Click Assign Engine Data to open theEngine Data Measurements editor. TheEngine
Data Measurements editor is used to define engine data values and other custom data
values for generators. Defining engine datameasurements is optional. See "Editing
engine data" on page 44.

l Click Assign Engine Data to open theAssign Engine Data Measurement editor. The
Engine Data Measurement editor is used to associate engine data values with specific
generator measurements. For information about this activity, see "Assigning engine data"
on page 46.

l Status Measurements - Use this area to configure the states used to record the status of a
generator. A generator can be in one of three states: Starting, Running, andStopped.
When a generator is in one of the states, the active value is stored in themeasurement. The
states appear in theEvents Summary section of the EPSS Test Report.

l Source - Select a source name. The source represents the ION device that records the
status of a generator.

l Starting - (Optional) This state indicates that the generator is starting. Select the check
box, select themeasurement that provides the starting state input, and enter the active
value for themeasurement. If this setting does not apply to your installation, do not select
the check box.

l Running - This state indicates that the generator is running. Select ameasurement that
provides the running state input, and enter the active value for themeasurement.

l Stopped - This state indicates that the generator has stopped. Select ameasurement
that provides the stopped state input, and enter the active value for themeasurement.

NOTE: Two stop signals could be sent from the generator controller: the initial stop
signal which is followed by 3- to 5-minute cooling period, and the final stop signal after
the cooling period is complete. If the generator has two stop signals, be sure to use
themeasurement for the first stop signal before the generator goes into the cooling
mode. Do not use the stop signal after the cooling period.

The active value for themeasurements can be any value you choose.



For example, assume that the system has been configured with measurements of
GENStarting, GENRunning, and GENStopped. You assign thesemeasurements to
theStarting, Running, andStopped states respectively and enter 1 as the Active Value
for each.

l When the generator starts, the active value for GENStarting becomes 1, andStart-
ing is the state for the generator.

l When the generator is running, the active value for GENRunning becomes 1, andRun-
ning is the state for the generator.

l When the generator stops, the active value for GENStopped becomes 1, and
Stopped is the state for the generator.

When EPSS Test Report is generated, the states for the generator, and the time when
they occurred, are included in theEvents Summary section of the report. See Power
Monitoring Expert Web help for information about this report.

Additional notes about the Status Measurements:

If there is only onemeasurement to indicate that the generator is either running or
stopped, then you select that measurement for both theRunning andStopped states,
and assign a different active value for each. For example, if themeasurement used to
indicate whether a generator is running or not is GenRunningStopped, define the
states like this:

For theRunning state:

a. Select GenRunningStopped as themeasurement.

b. Set the Active Value to 1.

When the generator is running, the active value for GenRunningStopped is 1, and
Running is the state for the generator.

For theStopped state:

a. Select GenRunningStopped as the status measurement.

b. Set the Active Value to 0.

When the generator is stopped, the active value for GenRunningStopped is 0, and
Stopped is the state for the generator.

l Monitor for EPS Available - (Optional) This state indicates that the emergency
backup source is available.

Select the check box, select themeasurement that provides the available state input,
and then enter the active value for themeasurement. If this setting does not apply to your
installation, do not select the check box.

Recommended state is 0 or 1.

l Required Time (Seconds) - Enter a value in seconds. The Required Time value spe-
cifies the amount of time required to be considered a pass.
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NOTE: If you click Apply at this point, you can run the EPSS Test Report for date
ranges, but not for a run history.

l Battery Waveforms - (Optional) Use this area to if you want to configure and generate the
Generator Battery Health Report. To enable the report, check the box and complete these
fields:

l Source - Select a source name that is performing the waveform capture. This option is
only available for ION7550 and ION7650meters.

l Measurement - Select themeasurement recording the battery waveform. For a typical
configuration, this is the V4 waveform.

3. Click Apply to save the changes and remain on the tab.

4. Repeat these steps to define other generators.

5. If you are defining several similar generators, use theClone button. See "Cloning
EPSS generators" on page 42.

Cloning EPSS generators
You can quickly define several similar EPSS generators by cloning the properties of an existing
EPSS generator entity and then using those properties as the baseline for multiple
EPSS generators.

To clone an EPSS generator:

1. On theGenerators tab, select the generator you want to use as the baseline for another gen-
erator.

2. Click Clone to create a new generator based on a selected entity. Many fields are copied from
the selected generator. The fields which are not copied have an information icon to indicate
where you need to enter data, as follows:

l Name - Enter a unique name to identify the generator.

l Electrical Data -Source - Select a source name from the dropdown list. The source rep-
resents the device that records the electrical data from the generator.

l Status Measurements -Source - Select a source name. The source represents themeter-
ing device that records the status of a generator.

See "Creating EPSS generators" on page 38 for information on generator properties.

3. Click Assign Engine Data to define other engine details for the generator. See "Assigning
engine data" on page 46 for details.

4. Click Apply to save the new generator entity.



Editing the EPSS generator evaluation method
TheEvaluation Method editor is used to select the evaluationmethod and the respective pass/fail
criteria that you want to use when evaluating a generator.

1. Click Edit Evaluation Method to open theEdit Evaluation Method editor.

2. Complete the following to set up evaluation criteria for a generator:

l Evaluation Method - Select an evaluationmethod. For Load Bank, you can select from
one to three stages to include in the evaluation. If you select Load Bank, theGenerator
Load Summary section of the EPSS Test Report shows the details of the selected stages
of the load bank test. The stages are represented on the graph. The table below describes
the evaluationmethods.

l Number of Stages - Select the number of stages for the evaluation if you selected Load
Bank.

l Suggested Load % orMinimum Exhaust Gas Temperature - Depending on the eval-
uationmethod that you selected, enter a numerical value for the percentage or for the tem-
perature.

l Run Duration (Minutes) - Enter theminimum number of minutes that the test needs to run
for evaluation purposes.

3. Click OK to save the evaluation criteria and return to theGenerators tab.

The evaluationmethods and their respective pass/fail criteria are listed in the following table. Load
is the default evaluationmethod.
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Evaluation Method Pass/Fail Criteria

Load The generator must run at an electrical load%that is equal to or greater
than themanufacturer's suggested electrical load%for the run duration.

Engine Temperature The generator must run at an engine temperature that is less than or
equal to the engine temperature for the duration.

Exhaust GasTemperature The generator must run at an exhaust gas temperature that is equal to or
greater than themanufacturer's suggested exhaust gas temperature for
the run duration.

Load Bank The generator must pass the stages selected for the electrical load bank
test. If more than one stage is selected, the generator must passeach
stage consecutively.

LoadOR Engine Temperature The generator must passeither the electrical load or the engine
temperature test.

LoadOR Exhaust GasTemperature The generator must passeither the electrical load or the exhaust gas test.

Load AND Exhaust GasTemperature The generator must passboth the electrical load and the exhaust gas test.

Load AND Engine Temperature The generator must passboth the electrical load and the engine
temperature test.

LoadOR Engine Temperature OR Exhaust
GasTemperature

The generator must passeither the electrical load or the exhaust gas test
or the exhaust gas test.

LoadOR Engine Temperature AND Exhaust
GasTemperature

The generator must passeither the electrical load or the engine
temperature test and the exhaust gas temperature test.

Load AND Engine Temperature OR Exhaust
GasTemperature

The generator must passboth the electrical load and the engine
temperature test OR the exhaust gas temperature test.

Load AND Engine Temperature AND
Exhaust GasTemperature

The generator must passboth the electrical load and the engine
temperature test and the exhaust gas temperature test.

You can edit the test criteria for a test method by selecting the test name and then updating its
criteria. The following table shows the default test criteria for each evaluationmethod. Confirm that
these values meet the regulations mandated by local jurisdictions, or meet theminimum values
recommended by themanufacturer, and update them if necessary.

Test Name Stage Minimum Run Duration

Load 1 30% 30minutes

Engine Temperature 1 140 F 30minutes

Exhaust GasTemperature 1 900 F 30minutes

Load Bank 1 25% 30minutes

Load Bank 2 50% 30minutes

Load Bank 3 75% 60minutes

Editing engine data
TheEngine Data Measurements editor is used to define engine data values and other custom data
values for generators. The items beingmeasured, typically analog data, can differ from generator to
generator. Battery voltage and coolant temperature are two commonmeasurements.

If you want to use the Trend Report, Tabular Report, EPSS Test Report, and dashboard gadgets,
add the engine data values you need.



To add engine data values and other custom data values:

1. Click Edit Engine Data to open theEdit Engine Data Measurements editor.

2. Click New to enable the input fields.

3. Complete the following to define new data values:

l Name - Enter a name for the data value.

l Units - Enter a unit of measure for the data value.

4. Click OK to save the new data value and return to theGenerators tab.

Next, assign these data values to generator measurements. See "Assigning engine data" on page
46 for instructions.

Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide EmergencyPower SupplySystem (EPSS)

© 2017Schneider Electric. All RightsReserved. Page 45 of 308



EmergencyPower SupplySystem (EPSS) Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide

Page 46 of 308 © 2017 Schneider Electric. All RightsReserved.

Assigning engine data
TheEngine Data Measurement editor is used to associate engine data values with specific
generator measurements. See "Editing engine data" on page 44 for instructions to define custom
engine data values.

To assign engine data:

1. Click Assign Engine Data to open theAssign Engine Data Measurement editor.

2. Click New.

3. Complete these fields to associate a data value with a specific measurement:

l Engine Data Measurement - Select the data value. The dropdown list contains all the data
values that were configured on the Edit Engine DataMeasurements screen.

l Source - Select the device name that records the generator data.

l Measurement - Select themeasurement for the data value.

4. Click OK to save your changes and return to theGenerators tab.

Define EPSS transfer switches
Use the Transfer Switches tab to configure the automatic transfer switch entities in the system.
Complete this tab when you are configuring the EPSS Test Report.



You can perform the following actions on this tab:

l Click New to create a transfer switch entry and to define specific values for it. See "Creating
EPSS transfer switches" on page 47 for instructions.

l Click Clone to define a new transfer switch that is like an existing entry. The system copies
many details of the existing device into the new entry. You can then enter the unique details of
the new device. If you need to define several devices that are similar, this feature can help you
define them quickly. For more information, see "Cloning EPSS transfer switches" on page 49.

l Click Delete to remove records from the system.

l Click Revert (before you click Apply orOK) if youmake changes to a record and want to revert
to your initial settings.

l Click Edit Priority Levels to open thePriority Levels editor. TheEdit Priority Levels editor
is used to select at least one priority level that you want to apply to your transfer switches. See
"Editing EPSS transfer switch priority levels" on page 50 for instructions.

Creating EPSS transfer switches
TheEdit Transfer Switch area on the tab is used to create a transfer switch entry and to define
specific values for it.

1. Click New to create a transfer switch entity.

2. Complete the following to define a transfer switch.

l Name - Enter a unique name to identify the transfer switch.

l Description - optional. Enter other information that you want to use to identify the transfer
switch.
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l Load Data - Check this box if you want to generate the Equipment Capacity Management
Report for the ATS.

l Source - Select ameter source that is recording electrical data from the ATS.

l Measurement - Select the electrical measurement item you want to track when the
report is generated, such as Current Phase Average.

l Rating - Enter the rating value for themeasurement, such as 400.

l Unit - Enter the unit of measurement, such as A.

l Priority Level - Select a priority level from the dropdown list. You need to assign a priority
level to each transfer switch. After you assign a priority level, the required transfer time for it
appears under the dropdown list.

l Status Measurements - Configure the states used to record the status of the ATS. When a
transfer switch is in one of the states, the active value is stored in themeasurement. The
states appear in theEvents Summary section of the EPSS Test Report.

l Source - Select a source name. The source represents the device that records the status
of a transfer switch.

l Normal - The ATS is in the Normal position and power is supplied to the load from the util-
ity. Select themeasurement that provides the input indicating that the ATS is in the
Normal state, and then enter the active value for themeasurement.

l Test - The ATS is in the Test mode. Select themeasurement that provides the input indic-
ating that the ATS is in the Test state, and then enter the active value for themeas-
urement.

l Emergency - The ATS is in the Emergency position and power is supplied to the load
from the generator. Select themeasurement that provides the input indicating that the
ATS is in theEmergency state, and then enter the active value for themeasurement.

l Monitor for Power Outage - If you aremonitoring utility power, select this option. Select
themeasurement that indicates a power outage occurred and enter theActive Value for
themeasurement.

The active value for themeasurements can be any value you choose.

For example, assume that the system has measurements called EPSS_Norm, EPSS_
Test, EPSS_Emerg, and EPSS_Util. You assign thesemeasurements to theNormal,
Test, Emergency, andPower Outage states and enter 1 as the active value for each.

When the ATS is in the Normal position, the active value for EPSS_Norm is 1, andNormal
is the state for the ATS. When the ATS is set to the Test mode, the active value for EPSS_
Test is 1, and Test is the state for the ATS. When the ATS is in the Emergency position,
the active value for EPSS_Emerg is 1, andEmergency is the state for the ATS. If a power
outage occurs, the active value for EPSS_Util is 1, andPower Outage is the state for the
ATS.

In the EPSS Test Report, the states for the ATS and the time when they occurred are
included in the Events Summary section.



In the Automatic Transfer Switch Summary section of the report, the states are used to
derive the Transfer Time and In Emergency time:

l Transfer Time - The duration (in seconds) to switch to theEmergency state. For Test
mode, the Transfer Time is the time to switch from theNormal state to theEmergency
state once the test signal has been received. When an actual power outage occurs, the
Transfer Time is the time to switch from theNormal state to theEmergency state once
the power outage signal has been received.

l In Emergency - The duration (in hours, minutes, and seconds) the ATS receives power
from the generators. This is the time between theEmergency state and theNormal
state.

3. Click Apply to save the changes and remain on the tab.

4. Repeat these steps to define other transfer switches.

5. If you are defining several similar transfer switches, use theClone button. See "Cloning
EPSS transfer switches" on page 49.

Cloning EPSS transfer switches
You can define several similar EPSS transfer switches by cloning the properties of an existing
EPSS transfer switches entity and then using those properties as the baseline for multiple
EPSS transfer switches.

To clone an EPSS transfer switch:

1. On the Transfer Switches tab, select the transfer switch you want to use as the baseline for
another transfer switch.

2. Click Clone to create a new transfer switch based on a selected entity. Many fields are copied
from the selected transfer switch. The fields which are not copied have an information icon to
indicate where you need to enter data, as follows:

l Name - Enter a unique name to identify the generator.

l Status Measurements -Source - Select a source name.

l Click Apply to save the new transfer switch entity.
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Editing EPSS transfer switch priority levels
TheEdit Priority Levels editor is used to select at least one priority level that you want to apply to
your transfer switches.

1. Click Edit Priority Levels to open theEdit Priority Levels editor.

2. Click New to add a priority level.

3. Complete the following to define priority levels:

l Name - Enter a unique name to identify the priority level.

l Required Transfer Time (Seconds) - Enter the transfer time in seconds. This value indic-
ates themaximum acceptable time for the ATS to switch from the Test state to theEmer-
gency state.

l Evaluate this Priority Level when reporting on Power Outages - Select this check box
to include a priority level in the pass or fail grading. Clear the check box to exclude the pri-
ority level from grading. By excluding a priority level, you can exclude non-critical switches
from evaluation.

For example, if a transfer switch has a priority level of Life Safety and it must be graded
because of a power outage, then select this check box. Conversely, if a transfer switch has
a priority level of Equipment, this transfer switchmay not have to be graded because of a
power outage. In this case, clear the check box.

l Color Picker - Select the color that the priority level detail will appear in the test report.

Default priority levels are shown in the following table. You can change any of these to a
priority level scheme of your choice.

Name Required Transfer Time Power Outage Enabled

Life Safety 10 True



Name Required Transfer Time Power Outage Enabled

Critical 10 True

Equipment 30 False

4. Click OK to save the priority level and return to the Transfer Switch tab.

Define EPSS Equipment
Use theEquipment tab to create a logical device with a sourcemeasurement and rating. You can
add these logical devices to device groups for reporting. Complete this tab when you are configuring
reports.

You can perform the following actions on this tab:

l Click New to enter new record for a device. See "Creating EPSS equipment sources" on page
52 for instructions to define the devices.

l Click Clone to copy an existing record andmakeminor changes. The system copies many
details of the existing device into the new entry. You can then enter the unique details of the
new device. If you need to define several devices that are similar, this feature can help you
define them quickly.

l Click Delete to remove records from the system.

l Click Revert (before you click Apply orOK) if youmake changes to a record and want to revert
to your initial settings.
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Creating EPSS equipment sources
TheEquipment tab displays the equipment load sources andmeasurements defined in the system.

To create new EPSS equipment sources:

1. Click New to create a record.

2. Complete these fields:

l Name - Enter a unique name to identify the record.

l Description - Enter additional information about the device. Optional.

l Source - Select the load source for the device.

l Measurement - Select themeasurement for the device.

l Rating - Enter themaximum rated load for the device.

l Unit - Enter the unit of themeasurement.

3. Click Apply to save the record and remain on the tab.

4. Repeat these steps to enter additional devices.

Define EPSS groups
A performance group is a combination of generators, transfer switches, and other equipment for
reporting and generating Vista diagrams. Complete theGroups tab when you are configuring
reports.



You can perform the following actions on this tab:

l Click New to create a new group for generating reports and Vista diagrams. A group can contain
any device that has been configured on the other tabs. See "Creating EPSS groups" on page 53
for instructions to define the groups.

l Click Delete to remove records from the system.

l Click Revert (before you click Apply orOK) if youmake changes to a record and want to revert
to your initial settings.

l Click theEdit Load Sources to associate a group with the electrical loads that the group of
generators must carry in a power outage. See "Editing EPSS group load sources" on page 54
for instructions.

l Click Generate Vista Diagrams to generate the frameworks for the EPSS groups. You can
select which groups to include in the diagrams. See "Generate EPSS Vista Diagrams" on page
58 for instructions.

Creating EPSS groups
TheGroups tab displays the device groups defined in the system. The generators, and transfer
switches, and other equipment must be defined on their respective tabs before you can add them to
a group.

To create an EPSS group:

1. Click New to create a group.

2. Complete the following to define the values for a group:

l Name - Enter a unique name to identify the group.

l Test Frequency - Select the frequency, in days, that the group should be tested. Refer to
local regulations for an appropriate value.

l Generators - Select the generators to include in the group.

l Equipment - Select the equipment to include in the group.

l Transfer Switches - Select transfer switches to include in the group.
TheSelect All andSelect None options let you work easily with large numbers of sources
by selecting all check boxes or clearing all check boxes at the same time.

3. Click Apply to save the group and remain on the tab.

4. Repeat these steps to create other groups.

Editing EPSS group priority levels
The following reports use priority levels:

l Generator Capacity Report – Priority level values are required to accurately display the colors
indicated in the priority levels.

l EPSS Test Report – Priority level values are required for the ATSs in the system to PASS or
FAIL an ATS based on the required transfer time of the priority level.

Default priority levels are setup as default.
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TheEdit Priority Levels editor is used to select at least one priority level that you want to apply to
the equipment groups. The default priority level names and transfer times are:

l Critical - 10 sec

l Equipment - 30 sec

l Life Safety - 10 sec

You can change any of these names and transfer times and add new priority levels as necessary.

To edit EPSS group priority levels:

1. Click Edit Priority Levels. ThePriority Levels screen appears.

2. Click New to add a priority level.

3. Complete the following to define priority levels:

l Name - Enter a unique name to identify the priority level.

l Required Transfer Time (Seconds) - Enter the transfer time in seconds. This time indic-
ates themaximum acceptable time it takes the equipment to move from the Test state to
theEmergency state.

l Color - Click the color box to select a color for the priority level. This color appears on the
Generator Capacity Report summary page, where the generator loads are compared. See
"Generator Capacity Report example" on page 101 for an illustration.

4. Click OK to save the priority level and return to theGroups tab.

Editing EPSS group load sources
On theSelect Load Sources screen, you can associate a group with the various electrical loads
that the group of generators must carry during a power outage.

Before configuring load sources, define the priority levels for the system. See "Editing
EPSS transfer switch priority levels" on page 50 for details.



To edit EPSS group load sources:

1. Click Edit Load Sources. TheEdit Load Sources screen appears.

2. Click New to add a load source.

3. Complete these fields:

l Source - Select themeasurement source.

l Measurement - Select themeasurement to monitor.

l Priority Level - Select the priority level to assign to the load source.

4. Click OK to save the new load source and return to theGroups tab.

NOTE: You can use theClone button to associate a group with several sources where the
load is logged against the samemeasurement. The cloned group contains the same
measurement and priority level as the original.

View EPSS run history
Use theRun History tab to view ormodify run activities that represent the Test, Load Shedding,
and Power Outage activities that have occurred in the system. The history indicates when
components of the EPSS have become active, such as when a generator was running or when a
transfer switch entered test or emergency status. The runs stored in history can be used as input for
reports and dashboards in PowerMonitoring Expert.

Because the system stores the history of these activities, you can generate useful reports about the
equipment operation. The reports can identify when the system was active, why the system was
active, and what devices were active.
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The first time the history records are generated on theRun History tab, the systemmay take a long
time depending on the amount of history present in the system. When changes occur in the EPSS
configuration, the run history must be generated again.

For example, if you remove a generator from a group, the run history for that group needs to be
rebuilt because that generator may have been the reason for the detection of a run. Now that the
generator is not part of the group, the system needs to build the run history again to have accurate
data.

You can perform the following actions on this tab:

l Click Detection Options to modify the criteria of a run event that will cause it to appear on this
tab. See "Modifying EPSS run detection options" on page 56.

l Click Refresh Run History to update the tab with the latest run events that have occurred in
the system.

l Click Delete Run History to remove all run event records from the tab.

l Modify the name and run reason for a run event. See "Modifying EPSS run history details" on
page 57.

Modifying EPSS run detection options
Run detection options can be defined to help guard against bad data in the system. To record actual
run activities, you can set the parameters so the system only records runs that fall within the
criteria.



Theminimum run length value is present to prevent false positives, whichmay occur during
commissioning when the states of the generators and transfers switches are changing quickly and
seemingly at random. This may be due to signals being recorded that do not reflect actual generator
or transfer switch activity.

You can set themaximum run length to eliminate "hanging" runs. A hanging run occurs when the
stop signal for a generator is not recorded properly. As a result, every time during the test it records
a running signal but there is no way for the system to know when it stops. If the system does not
see a stop signal, it sets the end of the run to be the start of the run plus themaximum run duration.
Therefore, you cannot determine how long the generator was running.

To define the run criteria for the system to store runs in history:

1. Click Detection Options. TheRun Detection Options screen appears.

2. Change the values in theminimum andmaximum fields.

3. Click OK to save the changes and return to theRuns tab.

4. Click Refresh to update the tab with the run events that match the new detection criteria.

Modifying EPSS run history details
The system defines run data, such as name, start time, end time, reason, and active sources
automatically. You can change the name of the run event and the reason for the run.

l The default run name is the start date of the run, such as June 12 2011. If a group has mul-
tiple runs on the same date, the subsequent runs have the same date with the run number
appended, such as June 12 2011 Run 2 and June 12 2011 Run 3.

l The system automatically detects the reason for the run. If the detected reason is incorrect, you
can change the reason. For example, the reason appears as Test, but the run is actually Load
Shedding.

Other details about the run event cannot bemodified directly. If the sources for a run are not correct,
you can exclude or include specific sources when generating a report based on this run.

Tomodify EPSS run history details:

1. Click the run record you want to modify. The run details appear below the grid.

2. In theName field, change the suggested run name as necessary.

3. In theReason list, select the correct reason for the run.

4. Click OK to save the changes for the run.
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Generate EPSS Vista Diagrams
After the generators, transfer switches, and device groups are configured, you can generate the
Vista diagrams for the configured devices. The same information can be built manually in Vista, but
the Generator Performance Configuration Tool with EPSS Test Module provides a way to build
these diagrams automatically. Vista diagrams help provide you with real time insight into the
system.

After the diagrams are generated, you can open them in Vista or Designer and optimize the designs.
See "EPSS Vista diagram examples" on page 60 for descriptions and examples of the generated
diagrams.

EPSS Vista diagrams are useful to the customer so they can see real-time information about the
status of the generators, transfer switches, and other components of the system. The diagrams can
include the customer logo and amap of the customer's facility. The customer can view the
diagrams in the Diagrams module of PowerMonitoring Expert after the diagrams have been linked
to the Diagrams module.

The system includes a template that you can use to set up certain parts of the diagrams before you
generate them.

Setting up the EPSS template diagram
The template diagram allows you to produce a consistent structure for the generated diagrams. The
template file is used as a basis for the dynamically generated EPSS diagrams. The template is a
normal diagram file that the system uses to apply common elements to the generated diagrams.

With the template, you can apply linked-button elements to the generated diagrams, which will help
you reduce the amount of time to configure the diagrams.

To set up the EPSS template diagram:

1. Open the Vista Diagrams application.

2. Open ...\config\diagrams\ud\EPSS\templates\Epss_Template.dgm.

3. To the left side of the diagram, add the buttons with the appropriate links.

4. Do not link the EPSS button to any diagram, because you will already be on the EPSS pages
when they are generated.

5. Save and close the template diagram.

When the configuration tool generates diagrams, the template is read and any objects on the
diagram are added to every diagram created by the tool.

NOTE: On the generated diagrams, the background image is dynamically created. The
background does not come from the EPSS template diagram.

Generating the EPSS Vista diagrams
Before you generate the EPSS Vista diagrams, make sure all devices and groups are configured
correctly. Save the changes you havemade to the EPSS configuration.

To generate the Vista diagrams:



1. Click theGroups tab.

2. Click Generate Vista Diagrams. The Vista Diagram Generation screen appears.

3. In theOutput Path field, enter or select the folder where you want to store the diagrams.

4. (Optional) In the Included EPSS Groups box, select the device groups that you want to gen-
erate diagrams for. Uncheck any groups you do not want to generate.

5. (Optional) In the Transfer Switch Options box, select the colors you want to use for normal
and emergency status.

6. (Optional) Check the Include Test Button on Transfer Switches option if you want to add a
control object for each ATS on the diagrams. This object allows you tomanually test the ATS
from the diagram. The control must bemanually linked using Vista once the diagrams have
been created.

7. (Optional) Check the Include Links to EPSS Groups... option if you want the device dia-
grams to have a link to the EPSS Group diagram.

8. In theDiagram Width field, select the horizontal width in pixels of the diagrams.

9. Select Facility Logo and enter the image file if you want the diagrams to include the customer
logo at the top-left of every diagram.

10. Select Generate Facility Map if you want to include amapwith the diagrams. If you do this,
you will be able to add the generator and transfer switch device locations to themap.

a. Enter the Facility Name to appear on themap.

b. Select the image file for themap.

11. Click Generate Vista Diagrams to generate and store the diagrams in the selected output
folder.

Several diagrams will be created: the homepage that lists all EPSS groups, summary pages that list
all generators and transfer switches, and the detail pages for each EPSS Group, Generator and ATS
in the system.
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You can open the diagrams in Vista and optimize the designs if necessary. Refer to ION Reference
for information about configuring themodules in the diagram.

EPSS Vista diagram examples
When you generate the Vista diagrams, the following diagrams are produced:

Home Page Diagram

OneHomePage diagram is generated. This diagram contains a navigation bar that has links for the
facility map, device group diagrams, and device diagrams.

EPSS Group Diagram

For each group selected on the configuration screen, one group diagram is produced. This diagram
contains an object for each generator or transfer switch in the group. A Oneline diagram for each
device group is also generated and linked to the diagrams. You will need tomanually configure the
generated Oneline diagrams. Several default objects are included for assistance.



Device detail Diagram

For each generator and transfer switch in a group, a diagram is generated. The device diagram
includes status information for the device, including run status, test parameters, and real-time
electrical data.

Facility Map

This diagram is generated if the option was selected on the configuration screen. This diagram
includes amoveable icon for each generator and transfer switch in all the selected device groups.
On themap diagram, you can drag and drop the device icons to themap to represent the physical
locations of those devices.
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EPSS Test Report
The EPSS Test Report shows the run details and overall status for generators and transfer
switches in the group. For example, the report shows the transfer time of the lead ATS and indicates
whether the transfer time passes or does not pass the test requirements.

Use the Reports module inWeb Applications to configure and generate the EPSS Test Report.

For more information on generating andmanaging reports, see the "Reports" section of theWeb
Applications help file.

EPSS Test Report prerequisites
In the Generator Performance Configuration Tool with EPSS Test Module, define the following tabs
and fields to generate the report.

Generators Tab
l Name - Enter a name for the generator entity.

l Electrical Data - Enter themeasurement source, nameplate rating, and unit of measurement.

l Status Measurements - Enter the source of the status measurement and the start, run, and
stop values. Configure themeters that provide thesemeasurements.

l Evaluation Method - “Load” is default, but you can change this to accommodate customer
requirements.

See "Define EPSS generators" on page 38 for instructions on the above settings.



Transfer Switches Tab
l Name - Enter a name for the ATS entity.

l Status Measurements - Select the source of the status measurement and the start, run, and
stop values. Configure themeters that provide thesemeasurements.

l Priority Levels - Default levels are provided; however you can change these levels to accom-
modate customer requirements.

See "Define EPSS transfer switches" on page 46 for instructions on the above settings.

Groups Tab
l Name - Enter a name for the group entity.

l Select at least one entity from theGenerators, Transfer Switches, orEquipment lists. The
group can contain entities from each list combined.

See "Define EPSS groups" on page 52 for instructions.

After these required items are defined, the report can be configured and generated.

EPSS Test Report example
The following images are examples of various sections of an EPSS Test Report in the order in
which they occur.

Title Page
The title page of the test report shows the title, company name, group, the name of the person
preparing the report, and the test period.

Sources
TheSources section shows the devices in the selected group.
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Events Summary
TheEvents Summary section shows the status of the generators and transfer switches in the
group.

Automatic Transfer Switch Summary
TheAutomatic Transfer Switch Summary section includes sections for the Lead ATS, the Time
to Emergency Power Source Available, andAll Automatic Transfer Switches in the group.

Generator Summary
TheGenerator Summary section shows the evaluationmethod is being used to determine the
status of the generator being tested.



This example shows the Load Bank evaluationmethod was used on the generator.

Generator Load Summary
TheGenerator Load Summary section shows a chart of the electrical load data for the generator
being tested.

This is an example showing the Load Bank evaluationmethod was used.
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Longest Continuous Load
This section includes a table summarizing theminimum, average, andmaximum electrical readings
for the longest continuous load by load bank stages. The following images show data for each stage
of the load bank test.



Generator Engine Temperature Summary
This example shows the Load AND Engine Temperature AND Exhaust Gas Temperature
evaluationmethod used on the generator.

This section also includes a chart of the engine temperature readings for the longest continuous load
and a table summarizing theminimum, average, andmaximum engine temperature readings for the
longest continuous load.

Generator Engine Temperature Details
This section shows summarized engine temperature details by time intervals.
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Generator Exhaust Gas Summary
This section shows a chart of the exhaust gas temperature data.

Generator Exhaust Gas Details
This section shows summarized exhaust gas temperature details by time intervals.



Generator Electrical Details
This section shows summarized electrical details by time intervals.

Generator Engine Details
This section shows engine parameter details, such as battery voltage and oil pressure readings.
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Generator Performance
To configure Generator Performance:

1. Obtain and install a license for the Generator Performancemodule.

2. Set up the installed ION meters, including ATS and generator frameworks. See "ION power
meter configuration" on page 222 for details.

NOTE: Transfer Switches and Automatic Transfer Switches (ATS) does not apply to data
centers. Even though ATS appears in the configuration tool and reports, you can ignore all
references to ATS when configuring a data center facility.

3. Set up the installed non-ION meters, including digital and analog outputs. See "Non-ION
powermeter configuration" on page 242 for details.

4. Set up reporting entities in the configuration tool. See "Generator Performance Configuration
Tool" on page 71. If your system includes the "Emergency Power Supply System (EPSS)" on
page 34, see "Generator Performance Configuration Tool with EPSS Test Module" on page 36.

5. Configure and run the Generator Performance reports.

Generator Performance Configuration Tool
NOTE: If your installation includes the Emergency Power Supply System (EPSS), see
"Generator Performance Configuration Tool with EPSS Test Module" on page 36.

Use theGenerator Performance Configuration Tool to configure the generators and other equipment
to report the data and status of the power system.

After your system is configured using the Generator Performance Configuration Tool, you can use
the following generator-related reports:

l Generator Activity Report

l Generator Battery Health Report

l Generator Capacity Report (available for PowerMonitoring Expert 8.2 – Healthcare Edition
only)

l Equipment Capacity Report (available for PowerMonitoring Expert 8.2 – Healthcare Edition
only)

l EPSS Test Report (requires a license for the EPSS Module)

Prerequisites
l Before opening the configuration tool, make sure the sources—which represent metering
devices—are added inManagement Console and they are communicating. See "ION power
meter configuration" on page 222 and "Non-ION powermeter configuration" on page 242 for
details.
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Starting the Generator Performance Configuration Tool
To start the Generator Performance Configuration Tool, open the PowerMonitoring Expert folder on
the desktop and double-click the Generator Performance Configuration Tool shortcut.

TheGenerator Performance Configuration Tool window contains these tabs: Groups, Generators,
Transfer Switches, Equipment, andRun History. On these tabs, you create the entities and
groups for equipment in the system. You also view data for prior test runs. The tabs contain a grid
area and an editor area, as shown next. The grid area is initially empty but it will be populated with
entries that you create through the editor area. Use the editor area to define the settings for new
items, or to update the settings for an item that you select in the grid area.

When you first use the configuration tool, you need to define generators and equipment on the
applicable tabs. After you do this, define the device groups on theGroups tab.

NOTE: To use the reports, youmust define the device groups on theGroups tab.

Use the following tabs to configure the tool:

l Groups tab - "Define groups" on page 76

l Generators tab - "Define generators" on page 72

l Transfer Switches tab - Define, describe, and configure the transfer switches.

l Equipment tab - "Define equipment" on page 75

l Run History tab - "Run History" on page 79

Use the following common controls for the tabs:

l Help - Click this to view online help for the tab.

l New - Creates a new entry in the grid.

l Delete - Deletes the selected entry from the grid.

l Revert - Returns amodified record to its original values, if OK orApply have not been clicked.

l OK - Saves all changes and exits the configuration tool.

l Cancel - Exits the tool without saving changes.

l Apply - Saves all changes and leaves the tool open.

TheModified column in the grid area shows the status of the row data:

+ (plus) - a new entry.

* (asterisk) - a modified entry.

! (exclamationmark) - entry needs more information before it can be saved.

Define generators
Use theGenerators tab to create or update entities representing the generators in the power supply
system. Complete this tab if you need to produce reports for generators.



You can perform the following actions on this tab:

l Click New to define the properties of the generators in the system. See "Creating generator
properties" on page 73.

l Click Clone to define a new generator that is like an existing generator. The system copies
many details of the existing device into the new entry. You can then enter the unique details of
the new device. If you need to define several devices that are similar, this feature can help you
define them quickly. See "Cloning generator properties" on page 74.

l Click Delete to remove records from the system.

l Click Revert (before you click Apply orOK) if youmake changes to a record and want to revert
to your initial settings.

Creating generator properties
TheEdit Generator area on the tab is used to create a generator entry and to define specific values
for it.

1. On theGenerator tab, click New.

2. Complete the following fields to define a generator.

l Name - Enter a unique name to identify the generator.

l Description (Optional) - You can add specific information about the generator, such as
make andmodel.

l Electrical Data

l Source - Select a source name. The source represents the device that records the elec-
trical data from the generator.
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l Prime Nameplate Rating - Enter themaximum power load for the generator. Refer to
the generator's nameplate for this value.

l Unit - Select the unit of measurement for the power load.

l Battery Waveform (Optional) - Use this area to if you want to configure and generate the
Battery Health Report. To enable the report, check the box and complete these fields:

l Source - Select a source name that is performing the waveform capture. This option is
available for ION 7550 and ION 7650meters.

l Measurement - Select themeasurement recording the battery waveform. For a typical
configuration, this is the V4 waveform.

NOTE: Specific frameworks for the battery voltage waveform must also be
configured. See "Generator Battery Health" on page 85 for details.

l Status Measurements - These fields are not required.

3. Click Apply to save the changes and remain on the tab.

4. Repeat these steps to define other generators.

5. If you are defining several similar generators, use theClone button. See "Cloning generator
properties" on page 74.

Cloning generator properties
You can define several similar generators by cloning the properties of an existing generator entity
and then using those properties as the baseline for multiple generators.

To clone a generator:

1. On theGenerators tab, select the generator you want to use as the baseline for another gen-
erator.

2. Click Clone to create a new generator based on a selected entity. Many fields are copied from
the selected generator. The fields which are not copied have an information icon to indicate
where you need to enter data, as follows:

l Name - Enter a unique name to identify the generator.

l Electrical Data -Source - Select a source name from the dropdown list. The source rep-
resents the device that records the electrical data from the generator.

l Status Measurements -Source - Select a source name. The source represents themeter-
ing device that records the status of a generator.

For information about other generator properties, see "Creating generator properties" on page
73.

3. Click Apply to save the new generator entity.



Define equipment
Use theEquipment tab to create a logical device with a sourcemeasurement and rating. You can
add these logical devices to device groups for reporting. Complete this tab if you need to produce
reports for equipment capacity.

You can perform the following actions on this tab:

l Click New to enter new record for a device. See "Creating equipment sources" on page 76 for
instructions to define the devices.

l Click Clone to copy an existing record andmakeminor changes. The system copies many
details of the existing device into the new entry. You can then enter the unique details of the
new device. If you need to define several devices that are similar, this feature can help you
define them quickly.

l Click Delete to remove records from the system.

l Click Revert (before you click Apply orOK) if youmake changes to a record and want to revert
to your initial settings.
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Creating equipment sources
Use theEquipment tab tomanage the equipment load sources andmeasurements defined in the
system.

1. Click New to create a record.

2. Complete these fields:

l Name - Enter a unique name to identify the record.

l Description - Enter additional information about the device. Optional.

l Source - Select the load source for the device.

l Measurement - Select themeasurement for the device.

l Rating - Enter themaximum rated load for the device.

l Unit - Enter the unit of themeasurement.

3. Click Apply to save the record and remain on the tab.

4. Repeat these steps to enter additional equipment.

Define groups
A performance group is a combination of generators and other equipment for reporting. TheGroups
tabmust be completed before you can configure and produce any reports.



You can perform the following actions on this tab:

l Click New to create a new group for generating reports. A group can contain any device that
has been configured on the other tabs. See "Creating groups" on page 77 for instructions to
define the groups.

l Click Delete to remove records from the system.

l Click Revert (before you click Apply orOK) if youmake changes to a record and want to revert
to your initial settings.

l Click Edit Priority Levels to create or modify response times for devices and equipment. See
"Editing EPSS group priority levels" on page 53 for instructions.

l Click theEdit Load Sources to associate a group with the electrical loads that the group of
generators must carry in a power outage. See "Configuring group load sources" on page 79 for
instructions.

Creating groups
TheGroups tab displays the device groups defined in the system. The generators and other
equipment must be defined on their respective tabs before you can add them to a group.

To create a group:

1. Click New to create a group.

2. Complete the following to define the values for a group:

l Name - Enter a unique name to identify the group.

l Generators - Select the generators to include in the group.

l Equipment - Select the equipment to include in the group.

TheSelect All andSelect None options let you work easily with large numbers of sources by
selecting all check boxes or clearing all check boxes at the same time.

3. Click Apply to save the group and remain on the tab.

4. Repeat these steps to create other groups.

Editing group priority levels
The following reports use priority levels:

l "Generator Capacity Report" on page 99 – Priority level values are required to accurately dis-
play the colors indicated in the priority levels.

l "EPSS Test Report" on page 62 – Priority level values are required for the ATSs in the system
to PASS or FAIL an ATS based on the required transfer time of the priority level.

Default priority levels are setup as default.

TheEdit Priority Levels editor is used to select at least one priority level that you want to apply to
the equipment groups. The default priority level names and transfer times are:

l Critical - 10 sec

l Equipment - 30 sec
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l Life Safety - 10 sec

You can change any of these names and transfer times and add new priority levels as necessary.

To edit group priority levels:

1. Click Edit Priority Levels. ThePriority Levels screen appears.

2. Click New to add a priority level.

3. Complete the following to define priority levels:

l Name - Enter a unique name to identify the priority level.

l Required Transfer Time (Seconds) - Enter the transfer time in seconds. This time indic-
ates themaximum acceptable time it takes the equipment to move from the Test state to
theEmergency state.

l Color - Click the color box to select a color for the priority level. This color appears on the
Generator Capacity Report summary page, where the generator loads are compared. "Gen-
erator Capacity Report example" on page 101 for an illustration.

4. Click OK to save the priority level and return to theGroups tab.



Configuring group load sources
On theEdit Load Sources screen, you can associate an equipment group with the various
electrical loads that the equipment must supply during a power outage.

Define the priority levels for the system before you configure load sources. See "Editing group
priority levels" on page 77 for instructions.

To configure group load sources:

1. Click Edit Load Sources. TheSelect Load Sources screen appears.

2. Click New to add a load source.

3. Complete these fields:

l Source - Select themeasurement source.

l Measurement - Select themeasurement to monitor.

l Priority Level - Select the priority level to assign to the load source.

4. Click OK to save the new load source and return to theGroups tab.

NOTE: You can use theClone button to associate an equipment group with several sources
where the load is logged against the samemeasurement. The cloned group contains the same
measurement and priority level as the original.

Run History
Use theRun History tab to view ormodify run activities that represent the Test, Load Shedding,
and Power Outage activities that have occurred in the system. The history indicates when
components of the power system have become active, such as when a generator was running. The
runs stored in history can be used as input for reports and dashboards.

Because the system stores the history of these activities, you can generate useful reports about the
equipment operation. The reports can identify when the system was active, why the system was
active, and what devices were active.
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The first time the history records are generated on theRun History tab, the systemmay take a long
time depending on the amount of history present in the system. When changes occur in the
equipment configuration, the run history must be generated again.

For example, if you remove a generator from a group, the run history for that group needs to be
rebuilt because that generator may have been the reason for the detection of a run. Now that the
generator is not part of the group, the system needs to build the run history again to have accurate
data.

You can perform the following actions on this tab:

l Click Detection Options to modify the criteria of a run event that will cause it to appear on this
tab. See "Modifying run detection options" on page 80.

l Click Refresh Run History to update the tab with the latest run events that have occurred in
the system.

l Click Delete Run History to remove all run event records from the tab.

l Modify the name and run reason for a run event. See "Modifying run details" on page 81.

Modifying run detection options
The run detection options can be defined to help guard against bad data in the system. To record
actual run activities, you can set the parameters so the system only records runs that fall within the
criteria.

Theminimum run length value is present to prevent false positives, whichmay occur during
commissioning when the states of the generators are changing quickly and seemingly at random.
This may be due to signals being recorded that do not reflect actual generator activity.



You can set themaximum run length to eliminate "hanging" runs. A hanging run occurs when the
stop signal for a generator is not recorded properly. As a result, every week during the test it records
a running signal but there is no way for the system to know when it stops. If the system does not
see a stop signal, it sets the end of the run to be the start of the run plus themaximum run duration.
Therefore, you cannot determine how long the generator was actually running.

To define the run criteria for the system to store runs in history:

1. Click Detection Options. TheRun Detection Options screen appears.

2. Change the values in theminimum andmaximum fields.

3. Click OK to save the changes and return to theRun History tab.

4. Click Refresh to update the tab with the run events that match the new detection criteria.

Modifying run details
The system defines run data, such as name, start time, end time, reason, and active sources
automatically. You can change the name of the run event and the reason for the run.

l The default run name is the start date of the run, such as June 12 2015. If a group has mul-
tiple runs on the same date, the subsequent runs have the same date with the run number
appended, such as June 12 2015 Run 2 and June 12 2015 Run 3.

l The system automatically detects the reason for the run. If the detected reason is incorrect, you
can change the reason. For example, the reason appears as Test, but the run is actually Load
Shedding.

Other details about the run event cannot bemodified directly. If the sources for a run are not correct,
you can exclude or include specific sources when generating a report based on this run.

1. Click the run record you want to modify. The run details appear below the grid.

2. In theName field, change the suggested run name as necessary.

3. In theReason list, select the correct reason for the run.

4. Click OK to save the changes for the run.

Generator Activity Report
TheGenerator Activity Report shows the test run hours and other test run data for each generator
in the selected group.
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WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the devices and software.
• Do not rely solely on system reports to determine if the system is functioning correctly or
meeting all applicable standards and requirements.

• Use system reports as a supplement to proper workplace practices or equipment
maintenance, not as a substitute.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Generator Activity Report prerequisites
Before you can generate a Generator Activity Report youmust define the following tabs and fields in
the Generator Performance Configuration Tool (or Generator Performance Configuration Tool with
EPSS Test Module):

Generators Tab
l Name - The generator entity needs a name.

l Electrical Data - Specify the requiredmeasurement source, nameplate rating, and unit of meas-
urement.

l Status Measurements - The source of the status measurement and the start, run, and stop val-
ues must be selected. Configure themeters that provide thesemeasurements.

l Evaluation Method - “Load” is default, but this may be changed to accommodate customer
requirements.

For instructions on the above settings see either of these sections:

l For Generator Performance Configuration Tool, see "Define generators" on page 72.

l For Generator Performance Configuration Tool with EPSS Test Module, see "Define
EPSS generators" on page 38.

Configuring the Generator Activity Report
Use the Reports module inWeb Applications to configure and generate the Generator Activity
Report.

NOTE: Emergency Power Supply System (EPSS) is a North American term used in the
healthcare segment. "EPSS Group" refers to the "Groups" defined in the Generator Performance
Configuration Utility.

1. Complete the fields to define the report:

l Title - Enter a name for the report.

l EPSS Group - Select the group for which the report is intended. When you select a group in
the list, the field to the right shows the devices included in the group.



l Exclude Sources - Click this to define the sources to exclude from the report.

a. In theSources Included area, select sources to exclude and then click > to move those
sources to theSources Excluded area.

b. Tomove all sources into theSources Excluded area, click >>.

c. Click OK to save the sources and return to the report template. The devices in the group
will appear in theSources section of the generated report. Excluded devices will appear
as grayed-out entries.

l Reporting Period - Select the date range for the data you want to include. This can be a
fixed number of prior days, such as Last 7 Days, or a fixed date range. The initial setting is
Last 7 Days. In the US, select at least 30 days of load data recorded at 15minute inter-
vals to satisfy regulations. Also, select the type of timestamp to use in the report, either
Server Local Time or UTC (Universal Time).

l Threshold (Hours) - Enter themaximum number of hours the generators should run in non-
emergency use. Enter a value that is in compliance with local authority requirements. For
example, in the US, the EPA requires that generators can run nomore than 100 hours in
non-emergency use.

l Include Activity Details - Click Yes to include the generator details in the report. Click No
to exclude this section.

l Include Data Warnings - Click Yes to include data warnings in the report. If there are none,
the section is not included. Click No to exclude this section.

2. Click Generate Report to produce the report.

Generator Activity Report example

Summary Page
The first page of the report shows the title, company name, group, a bar graph representing the test
run hours on each generator, and a table of test run data for each generator.
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Details Page
The details page shows a pie chart of the type of hours for each generator and the total run time
table.



Generator Battery Health
TheGenerator Battery Health system contains several components that provide the customer with
information about the generator battery bank. Specifically, themonitor shows the customer the
starting voltage signature, which indicates the battery bank’s voltage drop and recovery during and
after starting the generator.
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The following tasks must be completed to set up the Generator Battery Health system:

l Install and configure the ION7550 / ION7650meter to the battery bank to bemonitored. Refer to
thePowerLogic ION7550 / ION7650 Installation Guide andPowerLogic ION7550 / ION7650
User Guide for more information. Obtain the latest version of these documents from
www.schneider-electric.com.
Note the following:

l Digital signal from the Crank relay connected to the digital input of the ION7550/ ION7650
meter. This is the signal that triggers the oneshot timer to start recording waveform

l V1 - V3 voltage inputs must have PTs to isolate the ground from the system beingmonitored
and the battery.

l Connect V4 to the positive side of the battery. Input impedance of V4 terminal is 5Mohm
(phase - Vref). For themost up to date specification, contact the local representative.

l Connect Vref to battery ground.

l Fusingmust be installed according to themeter installation instructions.

l Perform visual inspection of connections to help ensure there is physical separation between
the system connected to V1, V2 and V3, and the battery connected to V4.

l For other wiring options with PTs, see thePowerLogic ION7550 / ION7650 Installation
Guide.

DANGER
EQUIPMENT ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

Treat the battery circuit as energized to the category of the installation.

Failure to follow these instructions will result in death or serious injury.

Refer to the following diagram as an example for connections to themeter.



l Configure the Battery Health Framework to capture the battery voltage signature or waveform
and deploy the framework to themeter. See the next section for instructions.

l In the Generator Performance Configuration Tool, check the Battery Waveforms option for the
generator to be included in the customer's Battery Health report. See "Creating generator prop-
erties" on page 73 or "Creating EPSS generators" on page 38 for instructions.

l Configure the Generator Battery Health Report to display the graph of the voltage signature.
The customer can use the report to help understand the battery bank condition. The report
can display multiple generators for the same starting date or a single generator onmultiple
starting dates. See "Configuring the Battery Health Report" on page 94.

This section provides instructions for configuring the framework to capture the voltage signature.

Configure the Battery Health Framework
The Battery Health Framework is designed to capture and record a generator’s battery voltage
signature at start up. This voltage signature provides some indication of the health of the generator’s
battery bank. A typical waveform capture of the voltage drop when starting is shown next:
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Note the following items about this example:

l This capture shows approximately 4 to 5 seconds' worth of data, accomplished via 3 waveform
recorders in series configured at a resolution of 16x96.

l The voltage does not immediately recover to its original value (~26 v) but it begins to ramp up.

l There is about 0.5 seconds of data before the voltage drops to approximately 20 V.

Two options in the framework are possible to capture the waveform, based on how the crank relay
signal is triggered - pulse or KYZ.

Example Framework
The following figure shows the typical modules for the framework.

The types of module used are:

l Data Acquisition

l Digital Input

l Convert

l OneShot Timer

l Waveform Recorder

See the following descriptions for the way eachmodule works in this framework.

Refer to ION Reference for details on how eachmodule operates and for settingmodule
parameters.



Data Acquisition – Data Acqn 1

The V4 signal from themeter goes to the Data Acquisitionmodule.

Digital Input – G1 Crank Relay

This module accepts the Cranking Relay signal from the field. When the signal goes high, the logic
to record the battery voltage triggers.

The Input mode can be set to Pulse or KYZ, as explained next.

Pulse Input Mode
When the Crank Relay signal goes high, a pulse is generated on the Trigger output register, labeled
"G1Crank Relay." The setup registers for the Digital Input module are shown next.

Note that the Input Mode value is Pulse. The Trigger output can now be fed into the first Waveform
Recorder along with V4 from the Data Acquisitionmodule.
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KYZ Input Mode
If you are using the sameDigital Input to handle the Generator Start signal (EPSS_Start) it is
probably set to KYZmode.

Input Mode KYZmeans that a pulse is generated on the Trigger output register when the Crank
Relay signal goes high AND when it goes low. The Convert module andOne Shot Timermodule
(explained later) prevent triggering the downstream logic twice.

The Crank Relay Module is setup like this:

Note that the Input Mode value is KYZ.

Convert
The signal from the Digital Input module cannot be fed directly into the One Shot Timer. The Convert
module converts the digital signal to analog for the One Shot Timer.

One-Shot Timer
To prevent triggering the downstream logic twice, send the state (EPSS_Start) from the Convert
module into the One Shot Timer:



Send the output register into the first Waveform Recorder G1 Battery 1.

First Waveform Recorder – G1 Battery 1
The Data Acquisitionmodule andG2Crank Relay module are the inputs to the first Waveform
Recorder, labeled “G1 Battery 1.”

These are the setup registers for themodule:

Note the following about the setup registers:

l Depthmust be non-zero – 100 is a good number.

l RecordMode should be Circular.

l Format should 16x96. This means 16 samples per cycle and 96 cycles, so at 60 Hz this results
in approximately 1.6 seconds' worth of data.

l Record Delay Cycles is set to 95 to allow the “window of observation” to move so that only
post-event data is captured. Refer to ION Reference for more details.

Second and Third Waveform Recorders
The secondWaveform Recorder - G1 Battery 2 - is cascaded with the first to capture another 1.6
seconds of the battery voltage signature. Do this by using the Record Complete output register on
G1 Battery 1 as a flag to trigger G1 Battery 2 to start recording.
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The thirdWaveform Recorder - G1 Battery 3 - is cascaded with the second recorder to capture the
final 1.6 seconds of the battery voltage signature. As above, use the Record Complete output
register on G1 Battery 2 as a flag to trigger G1 Battery 3 to start recording.

The Setup Registers should be the same as first waveform recorder with different labels.

Battery Health Waveform Capture results
After the framework is complete, in Vista you should see the voltage signature that looks like the
following example image:

After you obtain this type of result, you can configure the generator in the Generator Performance
Configuration Tool and define the Battery Health Report in the PowerMonitoring Expert 8.2 –
Healthcare Edition or the PowerMonitoring Expert 8.2 – Data Center EditionWeb Applications
Reports feature. Refer to these sections for instructions on these tasks.

l "Creating generator properties" on page 73 if the system does not include EPSS.

l "Creating EPSS generators" on page 38, if the system includes EPSS.

l "Configuring the Battery Health Report" on page 94.



Generator Battery Health Report
TheGenerator Battery Health Report shows an image of the generator battery voltage when the
generator starts.

The waveform image includes a reference waveform that shows the initial voltage signature when
the batteries were first installed and tested. The reference waveform helps compare the current
battery condition to their initial condition.

Research has indicated that when a battery begins to fatigue, the waveform for the voltage during
start-up changes. The voltage waveform can be captured and stored in the system for ongoing
analysis.

By capturing the voltage waveform when the batteries are in a known good condition, subsequent
waveforms can be compared to it to identify changes. In the Generator Battery Health report, you
can compare waveform images to see the changes over time. Adverse changes in the waveform
indicate a degradation of battery condition.

WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the devices and software.
• Do not rely solely on system reports to determine if the system is functioning correctly or
meeting all applicable standards and requirements.

• Use system reports as a supplement to proper workplace practices or equipment
maintenance, not as a substitute.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Prerequisites
In the Generator Performance Configuration Tool (with or without EPSS), define the following tabs
and fields to generate the report:

Generators Tab
l Name - The generator entity needs a name.

l Electrical Data - Themeasurement source, nameplate rating, and unit of measurement are
required.

l Status Measurements - The source of the status measurement and the start, run, and stop val-
ues must be selected. Configure themeters that provide thesemeasurements.

l Evaluation Method - “Load” is default, but this may be changed to accommodate customer
requirements.

l Battery Waveforms - Select the source and themeasurement. Configure themeters that
provide thesemeasurements. Also, configure the frameworks as described in "Generator Bat-
tery Health" on page 85.
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For instructions on completing this tab, see the following:

l "Creating generator properties" on page 73 if the system does not include EPSS.

l "Creating EPSS generators" on page 38, if the system includes EPSS.

After these required items are defined, the report can be configured and generated, as described
next.

Configuring the Battery Health Report
Use the Reports module inWeb Applications to configure and generate the Battery Health Report.

NOTE: Emergency Power Supply System (EPSS) is a North American term used in the
healthcare segment. "EPSS Group" refers to the "Groups" defined in the Generator Performance
Configuration Utility.

1. Complete the fields to define the report:

l Title - Enter a name for the report.

l Select EPSS (or Generator) Group - Select the generator group for which the report is
intended. The list shows the groups that include generators that can record the battery
voltage waveform via ION 7550 / ION 7650meter. See "Creating generator properties" on
page 73 for more details about selecting the battery waveform selection for a generator.
When you select a group in the list, the field to the right shows the devices included in the
group.

l Exclude Sources - Click this to define the sources to exclude from the report.

a. In theSources Included area, select sources to exclude and then click > to move those
sources to theSources Excluded area.



b. Tomove all sources into theSources Excluded area, click >>.

c. Click OK to save the sources and return to the report template. The devices in the group
will appear in theSources section of the generated report. Excluded devices will appear
as grayed-out entries.

l Select Generator Starts - Select the option to specify the start records. If you click Select
Reference Starts, you can choose the specific start records by generator and date. For
example, you can use this option to compare yesterday's Gen 1 start voltage signature to
the Gen 1 start voltage signature from six months prior.

l Include Data Warnings - Click Yes to include the data warnings in the report. If there are
no data warnings, the section is not included in the report. Click No to exclude this section.

l Cumulative Degradation Threshold - Enter the value that represents themaximum total
voltage difference between the reference waveform and the evaluated waveforms. For
example, if the waveform is off by 1.0 on each point from the reference, the total degradation
is 10. If the threshold value is 8, then the degradation exceeds the threshold.

2. Click Generate Report to produce the report.

Battery Health Report example
In this example, the starting voltage waveform (blue) is very similar to the reference waveform (red).
The drop to 20 VDC is the point at which the generator started. After the start, battery voltage rises
to normal state of charge after the start.
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Generator Battery Health Export
TheGenerator Battery Health Export report is based on the same data as the graphic-based
report. The export version provides the raw data in CSV file format. The export file can be imported
by other systems, such as Energy Operation.

Configuring the Generator Battery Health Export
Use theWeb Application Reports feature to configure and produce theGenerator Battery Health
Export file.

1. In the Reports Library, expand either theGenerator Performance orHealthcare Reports
folder and click Generator Battery Health Export. The report template appears.



2. Complete the fields to define the report.

l Title - Enter a name for the export file.

l Select EPSS Group - Select the generator group for which the report is intended. The list
shows the groups that include generators that can record the battery voltage waveform via
ION 7650meter. For more details about selecting the battery waveform selection for a gen-
erator, see either:

l For Generator Performance Configuration Tool, see "Creating generator properties" on
page 73.

l For Generator Performance Configuration Tool with EPSS Test Module, see "Creating
EPSS generators" on page 38.

l When you select a group in the list, the field to the right shows the devices included in the
group.
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l Exclude Sources - Click this to define the sources to exclude from the report.

a. In theSources Included area, select sources to exclude and then click > to move those
sources to theSources Excluded area.

b. Tomove all sources into theSources Excluded area, click >>.

c. Click OK to save the sources and return to the report template. The devices in the group
will appear in theSources section of the generated report. Excluded devices will appear
as grayed-out entries.

l Select Generator Starts - Select the option to specify the start records. If you click Select
Reference Starts, you can choose the specific start records by generator and date. For
example, you can use this option to compare yesterday's Gen 1 start voltage signature to
the Gen 1 start voltage signature from six months prior.



l Cumulative Degradation Threshold - Enter the value that represents themaximum total
voltage difference between the reference waveform and the evaluated waveforms. For
example, if the waveform is off by 1.0 on each point from the reference, the total degradation
is 10. If the threshold value is 8, then the degradation exceeds the threshold.

3. Click Generate Report to produce the report.

Battery Health Export example

Generator Capacity Report
TheGenerator Capacity Report helps verify the generators can adequately support the loads
required during an emergency. The report compares the loads the generators and equipment must
carry with the available generator capacity.
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WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the devices and software.
• Do not rely solely on system reports to determine if the system is functioning correctly or
meeting all applicable standards and requirements.

• Use system reports as a supplement to proper workplace practices or equipment
maintenance, not as a substitute.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Generator Capacity Report prerequisites
In the Generator Performance Configuration Tool, define the following tabs and fields to generate
the report:

Before you can generate a Generator Capacity Report youmust define the following tabs and fields
in the Generator Performance Configuration Tool (or Generator Performance Configuration Tool with
EPSS Test Module):

Generators Tab
l Name - The generator entity needs a name.

l Electrical Data - Specify the requiredmeasurement source, nameplate rating, and unit of meas-
urement.

l Status Measurements - The source of the status measurement and the start, run, and stop val-
ues must be selected. Configure themeters that provide thesemeasurements.

l Evaluation Method - “Load” is default, but this may be changed to accommodate customer
requirements.

For instructions on the above settings see either of these sections:

l For Generator Performance Configuration Tool, see "Define generators" on page 72.

l For Generator Performance Configuration Tool with EPSS Test Module, see "Define
EPSS generators" on page 38.

Equipment Tab
l Complete all fields on the Equipment tab (except Description). Generators can be added in this
tab to include them in the report. See either of these sections for instructions on theEquipment
tab.

For instructions on the above settings see either of these sections:

l For Generator Performance Configuration Tool, see "Creating equipment sources" on page 76.

l For Generator Performance Configuration Tool with EPSS Test Module, see "Creating
EPSS equipment sources" on page 52.



Groups Tab
l Add the load sources indicatingmeasurement and priority levels to the EPSS group in the Edit
Load Sources screen. If load sources are not added, the report will return empty pages and
state "No Data Available." See either of these sections for instructions on theGroups tab.

For instructions on the above settings see either of these sections:

l For Generator Performance Configuration Tool, see "Creating equipment sources" on page 76.

l For Generator Performance Configuration Tool with EPSS Test Module, see "Creating
EPSS equipment sources" on page 52.

Configuring the Generator Capacity Report
Use the Reports module inWeb Applications to configure and generate the Generator Capacity
Report.

For more information on generating andmanaging reports, see the "Reports" section of theWeb
Applications help file.

Generator Capacity Report example

Summary Page
The first page of the report shows a chart of the loads on each generator compared to the total
capacity rating. The colors for the bars are defined for the load priority levels. See "Editing
EPSS group priority levels" on page 53 for instructions on how to define the priority levels.
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Details Page
The following image shows the details for the capacity of the selected generators:



Generator Load Summary Report
TheGenerator Load Summary Report provides a summary graph of electrical data during a
generator run. The report includes a load curve, minimum-maximum-average load summary, and
other electrical details.

NOTE: This report is only included with the system if EPSS is not installed.

WARNING
INACCURATE REPORT RESULTS

• Do not incorrectly configure the devices and software.
• Do not rely solely on system reports to determine if the system is functioning correctly or
meeting all applicable standards and requirements.

• Use system reports as a supplement to proper workplace practices or equipment
maintenance, not as a substitute.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Generator Load Summary Report prerequisites
Before you can generate a Generator Load Summary Report youmust define the following tabs and
fields in the Generator Performance Configuration Tool:

Generators Tab
l Name - The generator entity needs a name.

l Electrical Data - Specify the requiredmeasurement source, nameplate rating, and unit of meas-
urement.
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l Status Measurements - The source of the status measurement and the start, run, and stop val-
ues must be selected. Configure themeters that provide thesemeasurements.

l Evaluation Method - “Load” is default, but this may be changed to accommodate customer
requirements.

See "Define generators" on page 72 for instructions on the above settings.

Configuring the Generator Load Summary Report
Use the Reports module inWeb Applications to configure and generate the Generator Load
Summary Report.

For more information on generating andmanaging reports, see the "Reports" section of theWeb
Applications help file.

NOTE: Emergency Power Supply System (EPSS) is a North American term used in the
healthcare segment. "EPSS Group" refers to the "Groups" defined in the Generator Performance
Configuration Utility.



Generator Load Summary Report example
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Generator Test Report
TheGenerator Test Report shows the run details and overall status for generators and transfer
switches in the group. For example, the report shows the transfer time of the lead ATS and indicates
whether the transfer time passes or does not pass the test requirements.

Use the Reports module inWeb Applications to configure and generate the Generator Test Report.

For more information on generating andmanaging reports, see the "Reports" section of theWeb
Applications help file.

Report Prerequisites
In the Generator Performance Configuration Tool, define the following tabs and fields to generate
the report.



Generators Tab
l Name - Enter a name for the generator entity.

l Electrical Data - Enter themeasurement source, nameplate rating, and unit of measurement.

l Status Measurements - Enter the source of the status measurement and the start, run, and
stop values. Configure themeters that provide thesemeasurements.

l Evaluation Method - “Load” is default, but you can change this to accommodate customer
requirements.

See "Define generators" on page 72 for instructions on the above settings.

Groups Tab
l Name - Enter a name for the group entity.

l Select at least one entity from theGenerators, Transfer Switches, orEquipment lists. The
group can contain entities from each list combined.

See "Define groups" on page 76 for instructions.

After these required items are defined, the report can be configured and generated, as described
next.
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Power Capacity
Power Capacity let youmanage and report on generator and UPS systems, and report on branch
circuits within a data center facility.

Power Capacity includes the following configuration tools:

l "Generator Power Configuration Utility" on page 109

l "UPS Power Configuration Utility" on page 118

Power Capacity includes the following reports:

l "Branch Circuit Power Report" on page 108

l "Generator Power Report" on page 117

l "UPS Power Report" on page 125

Branch Circuit Power Report
The Branch Circuit Power Report is used by data center facility operators to generate a report that
describes the average andmaximum loading for branch circuits within the data center facility, as
well as the percentage load compared to the breaker size. This section describes the procedures
involved in creating a report, how the reports are used, examples of the generated report, and the
managing and saving of the report.

NOTE: This report requires a license to be used. Contact your Schneider Electric representative
for more information.

The Branch Circuit Power Report is used for:

l Proactive capacity management

l Incident investigation

l Customer expansion planning

l Service Level Agreement (SLA)management

NOTE: For the Branch Circuit Power Report to provide accurate information, devices must be
installed, configured, and communicating correctly, youmust use and correctly configure the
Circuit > Rack > Customer hierarchy, and theManaged Circuits feature run each time a
device configuration change is made. If any of these tasks are not performed correctly, your
reports will provide inaccurate information. See "Switching to the Customer Circuit hierarchy
template" section in thePowerMonitoring Expert 8.2 – Data Center Edition Commissioning
Guide for more information.

Branch Circuit Power Report example
The Branch Circuit Power Report data depends on the selections youmake while configuring the
report and the contents of the PowerMonitoring Expert or Data Center database.



Generator Power Configuration Utility
TheGenerator Power Configuration Utility lets you create, edit, andmanage one or more generator
systems that will be used for reporting on the power capacity of those systems.

TheGenerator Power Configuration Utility window consists of a single panel that contains a grid
area and an editor area. The grid area is empty initially but will be populated with entries you create
through the editor area. Use the editor area to define the settings for new items, or to update the
settings for an item that you select in the grid area.

The generator system is the logical system configuration that will be used for reporting power
capacity.

This configuration utility allows you to create, edit, andmanage one or more generator systems that
will be used for reporting on the power capacity of those systems.

For information on generator redundancy types, see "Generator system redundancy types" on page
291.

Generator Power configuration restrictions
TheGenerator Power configuration tool enforces certain rules when creating a generator system,
group, or generator:

l Generator System

l Namemust be unique.

l One ormore systems are allowed.

l Generator Groups

l Namemust be unique.

l At least one groupmust be present in each system.

l All groups are connected to the same load.
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l For N, N+1, and N+2 system types:

l Only one group is allowed.

l Each generator in the groupmust have the same nameplate rating (kVA) value.

l Each generator in the groupmust have the same derated nameplate rating (kW) value.

l For 2N, 2(N+1) and 2(N+2) system types:

l Up to three groups are allowed.

l All groups must have the same number of generators.

l All generators in the groups must have the same nameplate rating (kVA) value.

l All generators in the groups must have the same derated nameplate rating (kW) value.

l Generators

l Namemust be unique.

l At least one generator must be present in each group.

l A maximum of 12 generators is allowed in each group.

Starting the Generator Power Configuration Utility
To start the Generator Power Configuration Utility, either:

l Double-click theGenerator Power Configuration Utility icon located in the Power Mon-
itoring Expert DC Ed folder on the desktop,

or

l Click Start > All Programs > Schneider Electric > Power Monitoring Expert DC Ed > Gen-
erator Power Configuration Utility.

Defining generator systems
A generator system is a logical system configuration that is used for reporting power capacity.

The following image is an example of the Generator Power Configuration Utility with a sample
generator system selected.



Control Description

Help Opens the help for the utility.

New Createsa new entry in the grid.

Delete Deletes the selected entry from the grid.

OK Savesall changesand exits the utility.

Cancel Exits the utilitywithout saving changes.

Apply Savesall changesand leaves the utility open.

Grid Area Columns Description

Modified Displaysa status symbol for the record.

+ (plus) A new entry.

* (asterisk) An existing entry hasbeenmodified.

! (exclamationmark) The entry is incorrect.

System Displays the system name.

Type Displays theGenerator system type (N, 2N, N+2, etc.)

Description Displaysa description of the system
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To define a generator system:

1. Click New. The Edit System: New System area appears below the grid.

2. Click anywhere in the editor area. The Properties screen appears.

3. Complete the details for the generator system:

a. Generator System Name:Enter a name for the generator system. Each generator system
must have a unique name.

b. Description:Enter a description for the generator system. This field is optional.



c. Redundancy Type:Select the redundancy type for the generator system. The different
redundancy types are explained in "Generator system redundancy types" on page 291.

d. Groups:Shows the number of generator groups contained in the generator system. Click
Add to add groups to the generator system. Click Remove to delete groups.

e. Generators Per Group:Shows the number of generators in each generator group in the
system. Click Add to add generators to the group. Click Remove to delete generators.
This property is only available when the system redundancy type is 2N, 2(N+1) or 2(N+2).
To define the number of generators for a system with redundancy type N, N+1 or N+2, use
the generator group properties. See "Defining generator groups" on page 113 for more
information.

4. Click Done to save the generator system.

Once complete, you can configure the other components of the system:

"Defining generator groups" on page 113

"Defining generators" on page 115

"Defining generator loads" on page 115

"Defining utilities" on page 116

Defining generator groups
A generator group represents a logical grouping of generators. The system contains at least one
group and can contain multiple groups. Depending on the system type, the group properties may be
different, as shown below. See "Generator Power configuration restrictions" on page 109 for more
information.
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To define a generator group:

1. Click on the group object border. The Properties screen appears.

2. Complete the details for the generator group:

a. Generator Group Name:Enter a name for the group.
Each generator groupmust have a unique name.

b. Description:Enter a description for the group. This field is optional.

c. Generators Per Group:Click Add to increase the number of generators in the group.
Click Remove to decrease the number. This property is available only for system redund-
ancy types N, N+1 or N+2.

3. Click Done to save the generator group.



Defining generators
A generator represents an actual generator device in the data center. A group contains at least one
generator and can contain multiple generators. For some system types, each groupmust contain
the same number of generators. See "Generator Power configuration restrictions" on page 109 for
more information.

To define a generator:

1. Click on the generator object border. The selected generator will be highlighted in blue and the
Properties screen appears.

2. Complete the details for the generator:

a. Generator Name:Enter the name for the generator.
This namemust be unique for each generator in the system.

b. Description:Enter a description for the generator. This field is optional.

c. Nameplate Rating (kVA):Enter themaximum output power (kVA) of the generator. This
valuemust be greater than zero.

d. Derated Nameplate Rating (kW):Enter themaximum power capacity (kW) that the gen-
erator is expected to support. This valuemust be equal or less than the nameplate rating
value, and greater than zero.

3. Click Done to save the generator.

Defining generator loads
A generator load represents the logical load attached to a generator group. Each generator system
must have only one load.
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To define a generator load:

1. Click the generator load element in the system diagram. The Properties screen appears.

2. Complete the details for the generator load:

a. Load Name:Enter a name for the load.

b. Description:Enter a description for the load. This field is optional.

c. Data Source:Select one or moremeter sources where load data is logged for this load.

d. Additional Utilities:Click Add to increase the number of utility objects for the load. Click
Remove to decrease the number of utility objects.

3. Click Done to save the generator load.

Defining utilities
A utility represents the logical utility provider that feeds a load under normal operation. This logical
utility has no functional purpose in the calculations for power redundancy. It is used to provide a
more complete diagram representation for the generator system. A systemmay have one or two
utilities represented in the diagram.



To define a utility:

1. Click the utility element in the diagram. The Properties screen appears.

2. Complete the details for the utility:

a. Utility Name:Enter a name for the utility.

b. Description:Enter a description for the utility. This field is optional.

3. Click Done to save the utility.

Once the configuration of the generators, loads, and utilities are complete, click Apply to save, or
click OK to save the configuration and exit the utility.

Generator Power Report
TheGenerator Power Report provides information regarding the generator backup power system
and its ability to handle a utility power outage while still complying with the intended redundancy
design. The report is generated after a representation of your backup generator system is created
and configured using the Generator Power Configuration Utility.

NOTE: This report requires a license to be used. Contact your Schneider Electric representative
for more information.

TheGenerator Power Report data depends on the selections youmake while configuring the report
and the contents of the PowerMonitoring Expert database. See "Generator Power Capacity Report
measurements" on page 117 for more details on the Generator Power Report data.

For more information on generating andmanaging reports, see the "Reports" section of theWeb
Applications help file.

Generator Power Capacity Report measurements
TheGenerator Power Report uses a priority table to determine whichmeasurement to use for
querying power data for a load.

The table is stored in the PowerMonitoring Expert database, and consists of a list of measurement
IDs with a priority value for eachmeasurement. When the report is querying for data, it iterates
through themeasurement list according to the priority and queries the database for load data. Once
data is found, it is returned in the report.

By default, the table GEN_CapacityMeasurement holds four knownmeasurements:
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UPS Power Configuration Utility
The Uninterruptible Power Supply (UPS) Power Configuration Utility lets you create, edit, and
manage one or more UPS systems that will be used for reporting on the power capacity of those
systems. The UPS Power Configuration Utility window contains a grid area and an editor area. The
grid area is initially empty but is populated with entries you create. The editor area displays the
configuration diagrams and allows you to define andmodify the configurations.

The UPS system consists of UPS groups, modules, and loads. The configuration utility lets you
organize the components of the system graphically and define properties for each component.

For information on UPS redundancy types, see "UPS system redundancy types" on page 295.

UPS Power configuration restrictions
The UPS Power Configuration Utility enforces certain rules when you create UPS systems, groups,
andmodules:

l UPS System

l Namemust be unique.

l One ormore systems are allowed.

l UPS Groups

l Namemust be unique.

l At least one groupmust be present in each system.

l A maximum of three groups are allowed in each system.

l For N, N+1, and N+2 system types:

l Each group in the systemmay have a different number of UPS modules.

l Each UPS module in the groupmust have the same nameplate rating (kVA) value.

l Each UPS module in the groupmust have the same derated nameplate rating (kW) value



l Each group is connected to one load only. No other group can be connected to the same
load.

See the "UPS Power Configuration Utility" on page 118 for more information.

l For 2N, 2(N+1) and 2(N+2) system types:

l All groups must have the same number of UPS modules.

l All UPS modules in the groups must have the same nameplate rating (kVA) value.

l All UPS modules in the groups must have the same derated nameplate rating (kW) value.

l Depending on the number of groups present in the system, a loadmay be shared by two
groups.

See the "UPS Power Configuration Utility" on page 118 for more information.

l UPS Modules

l Namemust be unique.

l At least onemodulemust be present in each group.

l A maximum of 12modules is allowed in each group.

Starting the UPS Power Configuration Utility
To start the UPS Power Configuration Utility:

l Double-click theUPS Power Configuration Utility icon in the Power Monitoring Expert DC
Ed folder located on the desktop,

or

l Click Start > All Programs > Schneider Electric > StruxureWare Power Monitoring
Expert DC Ed > UPS Power Configuration Utility.

Defining UPS systems
A UPS system is a logical system configuration that is used for reporting power capacity.

The following image is an example of the UPS Power Configuration Utility with a sample generator
system selected.
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Control Description

Help Opens the help for the utility.

New Createsa new entry in the grid.

Delete Deletes the selected entry from the grid.

OK Savesall changesand exits the utility.

Cancel Exits the utilitywithout saving changes.

Apply Savesall changesand leaves the utility open.

Grid Area Columns Description

Modified Displaysa status symbol for the record.

+ (plus) A new entry.

* (asterisk) An existing entry hasbeenmodified.

! (exclamationmark) The entry is incorrect.

System Displays the system name.

Type Displays the UPS system type (N, 2N, N+2, etc.)

Description Displaysa description of the system



To define a UPS system:

1. Click New. The Edit System: New System area appears below the grid.

2. Click anywhere in the editor area. The Properties screen appears.

3. Complete the details for the UPS system:

a. System Name: Enter a name for the UPS system. Each UPS systemmust have a unique
name.

b. Description: Enter a description for the UPS system. This field is optional.
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c. Redundancy Type: Select the redundancy type for the UPS system. The different redund-
ancy types are explained in "UPS system redundancy types" on page 295.

d. Groups: Shows the number of UPS groups contained in the UPS system. Click Add to
add groups to the UPS system. Click Remove to delete groups.

e. Modules Per Group: Shows the number of UPS modules in each group in the system.
Click Add to add UPS modules to the group. Click Remove to delete modules.
This property is only available when the system redundancy type is 2N, 2(N+1) or 2(N+2).
To define the number of modules for a system with redundancy type N, N+1 or N+2, use
the UPS group properties. See "Defining UPS loads" on page 124 for more information.

4. Click Done to save the UPS system.

Now you can configure the other components of the system:

"Defining UPS groups" on page 122

"Defining UPS modules" on page 123

"Defining UPS loads" on page 124

Defining UPS groups
A UPS group represents a logical grouping of UPS modules. The UPS system contains at least one
UPS group and can contain multiple UPS groups. Depending on the UPS system type, the
UPS group properties may be different, as shown below. See "UPS Power configuration
restrictions" on page 118 for more information.



To define a UPS group:

1. Click on the group object border. The Properties screen appears.

2. Complete the details for the UPS group:

a. Group Name:Enter a name for the group. Each UPS groupmust have a unique name.

b. Description:Enter a description for the group. This field is optional.

c. Modules Per Group:Click Add to increase the number of UPS modules in the group.
Click Remove to decrease the number. This property is available only for system redund-
ancy types N, N+1 or N+2.

3. Click Done to save the UPS group.

Defining UPS modules
A UPS module represents an actual UPS device in the data center. A UPS group contains at least
one UPS module and can contain multiple UPS modules. For someUPS system types, each
UPS groupmust contain the same number of UPS modules. See "UPS Power configuration
restrictions" on page 118 for more information.
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To define a UPS module:

1. Click on themodule object border. The selectedmodule will be highlighted in blue and the Prop-
erties screen appears.

2. Complete the details for the UPS module:

a. UPS Module Name:Enter the name for themodule. This namemust be unique for each
UPS module in the system.

b. Description:Enter a description for themodule. This field is optional.

c. Data Source:Select themeter source in PowerMonitoring Expert where load data is
logged for the UPS module. The sourcemust be unique for each UPS module.

d. Nameplate Rating (kVA):Enter themaximum output power (kVA) of the UPS module.
This valuemust be greater than zero.

e. Derated Nameplate Rating (kW):Enter themaximum power capacity (kW) that the UPS
module is expected to support. This valuemust be equal or less than the nameplate rating
value, and greater than zero.

3. Click Done to save the UPS module.

Defining UPS loads
A UPS load represents the logical load attached to a UPS group. This logical load has no functional
purpose in the calculations for power redundancy. The UPS load is used only to provide amore
complete diagram representation for the UPS system.



To define a UPS load:

1. Click the UPS load element in the system diagram. The Properties screen appears.

2. Complete the details for the UPS load:

a. Load Name:Enter a name for the load.

b. Description:Enter a description for the load. This field is optional.

3. Click Done to save the UPS load.

UPS Power Report
The UPS Power Report data depends on the selections youmake while configuring the report and
the contents of the PowerMonitoring Expert database. See "UPS Power Report Capacity
measurements" on page 125 for more details on report data.

NOTE: This report requires a license to be used. Contact your Schneider Electric representative
for more information.

For more information on generating andmanaging reports, see the "Reports" section of theWeb
Applications help file.

UPS Power Report Capacity measurements
The UPS Power Report uses a priority table to determine whichmeasurement to use for querying
power data for a UPS module.

The table is stored in the PowerMonitoring Expert database, and consists of a list of measurement
IDs with a priority value for eachmeasurement. When the report is querying for data, it iterates
through themeasurement list according to the priority and queries the database for load data. Once
data is found, it is returned in the report.

By default, the table GEN_CapacityMeasurement holds four knownmeasurements:
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Power Efficiency
Power Efficiency helps youmanage and report onmonitoring devices that make up the power loss
system, and report on branch Power Usage Effectiveness (PUE) and average power consumed for
the IT equipment running in a data center facility.

Power Efficiency includes the following configuration tool:

l "Power Losses Configuration Utility" on page 127

Power Efficiency includes the following reports:

l "Power Losses Report" on page 131

l "Power Usage Effectiveness (PUE) Summary Report" on page 132

Power Losses Configuration Utility
The Power Losses Configuration Utility allows you to create, edit, andmanage the different logical
sources, such as transformers or UPS modules monitoring devices that make up the power losses
system. It is this system that is used for reporting on its losses.

The Power Losses Configuration Utility window consists of two tabbed panes labeled
Transformers andUPS Modules. Each pane contains a grid area and an editor area. The grid area
is empty initially but is populated with entries you create using the editor area. Use the editor area to
define the settings for new items, or to update the settings for an item that you select in the grid
area.

Before you can generate a Power Losses Report, you need to define a power losses system using
the Power Losses Configuration Utility.

The following image is an example of the Power Losses Configuration Utility.
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Control Description

Help Opens the help for the utility.

New Createsa new entry in the grid.

Delete Deletes the selected entry from the grid.

OK Savesall changesand exits the utility.

Cancel Exits the utilitywithout saving changes.

Apply Savesall changesand leaves the utility open.

Grid Area Columns Description

Modified Displaysa status symbol for the record.

+ (plus) A new entry.

* (asterisk) An existing entry hasbeenmodified.

! (exclamationmark) The entry is in error.

Power Losses configuration restrictions
The Power Losses Configuration Utility enforces certain rules when you create a power losses
system:

l All Devices

l Namemust be unique.

l A meter sourcemust be assigned only once to a device.

l Transformers

l Zero, one, or more low voltage transformers may be present in the power losses system.

l Zero, one, or moremedium voltage transformers may be present in the power losses sys-
tem.

l UPS Modules

l Zero, one, or more UPS modules may be present in the power losses system.

Define the Power Losses components
To start the Power Losses Configuration Utility, either:

l Double-click thePower Losses Configuration Utility icon located in the Power Monitoring
Expert DC Ed folder,

or

l Click Start > All Programs > Schneider Electric > StruxureWare Power Monitoring
Expert DC Ed > Power Losses Configuration Utility.

Select the appropriate tab to define the following power losses components:

"Defining transformers for Power Losses" on page 129

"Defining UPS modules for Power Losses" on page 130



Defining transformers for Power Losses
To define a transformer used in your power losses system:

1. Select the Transformers tab.

2. Click New. The editable fields are enabled.

3. Define the transformer:

a. Name:Enter a unique name for the transformer.

b. Description: (Optional) Enter a description for the transformer. For example: make, model.

c. Input Side Meter Source:Select a source name from the drop-down list. The source rep-
resents the PowerMonitoring Expert device that records the electrical data from the input
side of the transformer. "Power Losses Report measurements" on page 131 for more
information.

d. Output Side Meter Source:Select a source name from the dropdown list. The source rep-
resents the PowerMonitoring Expert device that records the electrical data from the output
side of the transformer. "Power Losses Report measurements" on page 131 for more
information.

e. Low Voltage/Medium Voltage:Select Low Voltage or Medium Voltage from the drop-
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down list to indicate the transformer voltage rating type.

4. Click OK to save the transformer.

Defining UPS modules for Power Losses
To define a UPS module used in your power losses system:

1. Click theUPS Modules tab.

2. Click New. The editable fields are enabled.

3. Define the UPS module:

a. Name:Enter a unique name for the UPS module.

b. Description: (Optional) Enter a description for the UPS module. For example: make,
model.

c. Input Side Meter Source:Select a source name from the drop-down list. The source rep-
resents the PowerMonitoring Expert device that records the electrical data from the input
side of the UPS module. "Power Losses Report measurements" on page 131 for more
information.

d. Output Side Meter Source:Select a source name from the drop-down list. The source rep-
resents the PowerMonitoring Expert device that records the electrical data from the output
side of the UPS module. "Power Losses Report measurements" on page 131 for more



information.

4. Click OK to save the UPS module.

Power Losses Report
The Power Losses Report provides the breakdown of the cost of various losses throughout a Data
Center's power system and to lets you analyze and quantify the cost of inefficiencies due to
transformers (MV and LV) and UPS modules.

For more information on generating andmanaging reports, see the "Reports" section of theWeb
Applications help file.

Power Losses Report measurements
The Power Losses Report uses a priority table to determine whichmeasurement to use for querying
energy and power data for the different devices defined in the power losses system.

The table is stored in the PowerMonitoring Expert database, and consists of a list of measurement
IDs with a priority value for eachmeasurement. When the report is querying for data, it iterates
through themeasurement list according to the priority and queries the database for the specific type
of data. Once data is found, it is returned in the report.

The report also looks for different types of logical measurements, cataloged in a separate
Measurements table.

By default, the table PSL_PSLMeasurementCategory holds two knownmeasurements:

By default, the table PSL_PSLMeasurementPriorityMapping holds the following information:
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Devices that providePowermeasurements:

Devices that provideEnergy measurements:

Devices that provideCurrent Phase Averagemeasurements:

Power Usage Effectiveness (PUE) Summary Report
The Power Usage Effectiveness (PUE) Summary Report displays PUE and average power
consumed for a data center facility, along with average power consumed for the IT equipment
running in the facility. Additionally, two graphical trends are displayed in a dashboard that
corresponds to the facility PUE values and to the energy consumption of the facility.

NOTE: The PUE Report does not require the data center VIP to be configured. See the "VIP"
sectionPowerMonitoring Expert 8.2 – Data Center Edition Commissioning Guide. However, the
framework does provide an example of the aggregation of power for the data center and the IT
Load, and the resulting calculation of interval energies that are required for the report to run.

This section provides an overview of the PUE Summary Report and includes:



l Definitions of some of the terms associated with PUE

l PUE Summary Report prerequisites

l Calculations used to generate the PUE Summary Report.

Terms and Definitions
l PUE – Power Usage Effectiveness, defined as a ratio between the total power consumed by a
data center facility and the power consumed by the IT equipment that runs in the facility. For
example, a PUE value of 2.0 indicates that for every watt of IT equipment power consumed, an
additional watt is consumed to operate the facility that houses the equipment (e.g. equipment
cooling, power distribution to the equipment).

l Total Data Center Power – Represents all the power consumed by the data center facility at
one point in time. This value should represent an instantaneous power consumption value.

l Total Data Center Energy – Represents all the energy used by the data center facility for a
given time interval. This value typically represents a 15-minute energy usage value.

l Total IT Equipment Power – Represents all the power consumed by the IT equipment used in
a data center facility at one point in time. This value should represent an instantaneous power
consumption value

l Total IT Equipment Energy – Represents all the energy used by the IT equipment in the data
center facility for a given time interval. This value typically represents a 15-minute energy
usage value.

l Support – Represents the overhead amount of energy or power required to operate the data
center, which does not account for IT equipment power consumption. This value represents the
data center power distribution losses, as well as the power consumed to cool down the data
center facility.

Prerequisites
Before a PUE Summary Report can be successfully generated, the following prerequisites must be
met:

l PowerMonitoring Expert 8.2 – Healthcare Edition is installed and operational.

l The proper licensing is obtained for this module.

l Reporter is installed and functional.

l The PowerMonitoring Expert database contains Total Data Center Power and Total Data
Center Energy data, as well as Total IT Equipment Power and Total IT Equipment Energy, as
defined in the previous section.

l The PUE Summary Report Pack is installed and operational.

l IT Equipment Power Measurement:Click Select Measurement to choose themeasurement
for instantaneous power consumption for all the IT equipment used.
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NOTE: Confirm that the Data Center source and the IT Equipment source entries are
correct before generating a report. If these entries are not correct, the generated report can
contain inaccurate information.

PUE Summary Report Example
The sections and content contained in the PUE Summary Report depend on the selections made in
the PUE Summary Report template and the contents of the PowerMonitoring Expert database. See
the following sample report.

PUE Summary Report Calculations
In this sample, all time periods are based on July 25, 2013.

24 Hours 7 Days 30 Days Last 12 Months
From July 24 12:00AM
until
July 25 12:00AM

From July 18 12:00AM
until
July 25 12:00AM

From June 25 12:00AM
until
July 25 12:00AM

From July 25, 2012
12:00AM until
July 25, 2013 12:00AM

The values in the table below are calculated as follows:

PUE – The ratio between the data center and IT equipment energy measurement values. This value
is calculated for each of the required time periods by the following formula:



PUE =
Sum of Data Center Energy
Sum of IT Equipment Energy

IT Equipment – The average of the IT equipment powermeasurement values for each of the time
periods.

Data Center – The average of the data center powermeasurement values for each of the time
periods.

The values displayed in the charts below are calculated as follows:

PUE Trend – The weekly PUE values are calculated by the following formula where N represents a
week of the year:

PUE week N =
Sum [ Data Center Energy ] week N
Sum [ IT Equipment Energy ] week N

Energy Trend – The weekly energy values for IT equipment and support are calculated by the
following formulas where N represents a week of the year:

IT Equipment Energy week N = Sum [ IT Equipment Energy ] week N

Support Energy week N = Sum [ Data Center Energy] week N - Sum [ IT
Equipment Energy ] week N
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Power Quality Advisor
Power Quality Advisor is an optional softwaremodule of PowerMonitoring Expert (PME) software.
It presents complex power quality information in a simpler form.

SeeStruxureWare PowerMonitoring Expert Power Quality Advisor – Design Guide for more
information on the PQAdvisor features.



Configure the Monitoring Devices
The PQAdvisor can perform an analysis only whenmonitoring devices (powermeters, circuit
breakers) have been properly configured to capture power quality events and disturbances. This
section describes the following:

l "Enable power quality event detection" on page 137.

l "Enable power quality disturbance logging" on page 138.

l "Enabling time synchronization" on page 140.

SeeStruxureWare PowerMonitoring Expert Power Quality Advisor – Design Guide for more
information on power quality events and disturbances.

Enable power quality event detection
See "PQAdvisor - Supportedmeters" on page 304 for supported devices.

Enabling power quality event detection on the supportedmeters involves:

l Enabling Sag/Swell detection

l Enabling Transient detection

Disturbance direction detection (DDD) is enabled by default if supported.

NOTE: DDD, available on select meters, is used to determine if the events are undetermined,
internal, or external to the system. Without DDD, all events will show as undetermined in the PQ
Advisor features.

You can do this by usingmeter configuration tools (such as ION Setup), or by configuring themeter
directly. Refer to themeter documentation for more information.

In addition, you can configure ION meters (such as, ION7650, PM8000, etc.), in PME Vista.
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After the power quality events are detected by themeter, they are classified by PME Power Quality
Event Classificationmethod and stored in PME database as:

l Interruptions

l Voltage Sag

l Voltage Swell

l Transient Voltage

l Over voltage

l Under voltage

SeeStruxureWare PowerMonitoring Expert – Design Guide for more information on PME Power
Quality Event Classification.

Enable power quality disturbance logging
PQAdvisor consumes the periodical data logs for:

l Voltage Unbalance

l Current Unbalance

l Voltage Harmonics

l Current Harmonics

l Frequency Variation

l Flicker

The supportedmeters are listed in "PQ Advisor - Supportedmeters" on page 304. They are
categorized as:

l Logged by Default – The supportedmeasurements are logged by the default. For these
meters, no additional configuration is required. However, for brownfield installations, caremust
be taken to see if the configuration has beenmodified.

l Not Logged by Default – Themeter measures the value but does not log it. You need to
enable logging on thesemeters.

Choose the measurement to log
The supportedmeasurements and their corresponding register labels are listed in "PQ Advisor -
Supportedmeasurements" on page 305.

For example, for Voltage Unbalance, youmay find both of the supported registers Voltage
Unbalance L-LWorst and Voltage Unbalance L-N Worst available in a non-ION device. Choose the
one which is required by your local standards.

Or, for Voltage Harmonics, youmay find all the 8 supported registers available in a non-ION device.
If per-phase analysis is important to the customer on this device, choose the 3 per-phase
measurements based on your system and standards. If per-phase analysis is not important
(because of the load, design, or other reasons), choose only onemeasurement; either THD Voltage
L-L or THD Voltage L-N, which are the averages of the per-phase values.



NOTE: For each disturbance category, choose only the appropriate/necessary measurements
from the supported list to log. Do NOT log all of them; doing so can cause unwanted database
growth and performance issues.

Enable the logging
To enable the logging for devices categorized as “Not Logged by Default”:

l Supportedmeasurements are logged by default for most ION meters, so configuration is not
required. For somemodels, where the supportedmeasurements are not logged by default, you
can configure logging by using PME Designer.

l For non-ION meters, you can use PME Modbus Device Importer to configure logging:

NOTE: For non-ION devices, PQ Advisor only supports the logged instantaneous values. Do
NOT log the calculated values (Mean, High, or Low). For Harmonics and Unbalance
measurements, the recommended logging Interval is 3600 seconds.

SeeStruxureWare PowerMonitoring Expert – User Guide for more information on using Designer
andModbus Device Importer.

l For the non-ION meters, especially PM800 (except PM810 without PME810LOG), CM3000,
and CM4000, configure the on-board logging usingmeter configuration tools.

NOTE: The PM800 Series devices are supported, except the PM810 without PM810LOG.

Flicker
Flicker is only available when the supportedmeter has a PQ framework with EN50160 evaluation
enabled. Refer to themeter documentation for more information.

Once enabled, the flicker measurements are logged in 10-minute intervals by default. There is no
need to change the logging interval.

Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide Power QualityAdvisor

© 2017Schneider Electric. All RightsReserved. Page 139 of 308



Power QualityAdvisor Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide

Page 140 of 308 © 2017 Schneider Electric. All RightsReserved.

Enabling time synchronization
Time synchronization is crucial for:

l Event clustering (the same event seen by different devices is only counted once).

l Correctly associating the process impact alarms with power quality events.

The standard synchronization between the PowerMonitoring Expert server and devices is adequate
for enabling PQAdvisor features.

l ForModbus devices, time synchronization throughModbus is activated by default.

l For all ION protocol devices (e.g. ION7650, PM8000, etc.), the application engineer needs to
enable this feature.

NOTE: High accuracy of time synchronization (such as IRIG-B, etc.), can be used to address
user requirements, but it is not required for PQ Advisor.

To enable PowerMonitoring Expert time synchronization on an ION device:

1. Connect to the device using ION Setup. On the Timezone tab forClock, change entry for the
CL1 Time Sync Source toETHERNET - ION. You can also do this on themeter front panel.

2. In Management Console:

a. For an Ethernet device, set the Time Synch Ethernet Enabled toYes in theEthernet
Device Configuration.



b. For a serial device, set the Time Synch ION Enabled toYes in theEthernet Gateway
Site Configuration.
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Power Quality Advisor Configuration Overview
The Power Quality (PQ) Advisor module features are controlled by its feature license. Refer to
PowerMonitoring Expert 7.2 & 8 Licensing Guide on how to activate a license.

Once the PQAdvisor module is licensed, the following features do not require specific configuration
to work:

l Power Quality Rating Gadgets

l PQRating Gadget

l PQRating TrendGadget

l Power Quality Events Detail Gadgets

l Power Quality Events BreakdownGadget

l Power Quality Events Impact Gadget

l Power Quality Events Location Gadget

The features listed below require additional configuration to work, which will be described in the
following sections:

l PQ Advisor Diagrams

l PQ Indicator Diagrams1

l Standardized Equipment Diagrams

l Power Quality Impact Gadgets and Report

l Power Quality Impact Gadget

l Power Quality Impact TrendGadget

l Power Quality Impact Report

l Power Factor Impact Gadgets

l Power Factor Impact Gadget

l Power Factor Impact TrendGadget

l Power Quality Events Detail Gadgets2

1 The PQ Indicator Diagrams are pre-configured with default settings. They work when you paste a
simple framework in the PQAdvisor VIP.

2 The Power Quality Analysis Report needs additional configuration only when the power factor
section is enabled.



Configure Global Parameters
Youmay need to change the global parameters, depending on the requirement of the customer’s
facility.

Configure the Nominal Frequency
The default nominal frequency is 60Hz.

To edit the default nominal frequency:

1. In SQL Server Management Studio, locate the dbo.vCFG_ConfigItems view in the ION_Net-
work database, and right-click to select "Edit Top 200 Rows".

2. Find the Frequency Nominal row.

3. Set the Value to the appropriate local nominal frequency.
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Configure PQ Advisor diagrams
The following sections describe how to configure the PQAdvisor diagrams:

l "Configure Power Quality Indicator Diagrams" on page 144

l "Configure the Standardized Equipment Diagrams" on page 147

l "(Optional) Create a PQAdvisor tab in theWeb Applications" on page 170

Configure Power Quality Indicator Diagrams
The Power Quality (PQ) Indicator Diagrams introduce simple green-yellow-red indicators for the
most common power quality problems.

The PQ Indicator Diagrams are pre-configured with default settings. Complete the following steps to
enable the functionality:

l "Paste the PQAdvisor Framework" on page 144

l "Open the Power Quality Indicator Diagrams" on page 145

Paste the PQ Advisor Framework
The VIP Frameworks included with the PQAdvisor installation get data from the PQAdvisorWeb
Service to display values and drive the status objects in the PQAdvisor Indicator Vista Diagrams.

NOTE:
l The VIP.PQADVISOR ION Servicemust be running to proceed with the steps below. (The
service is configured to start automatically.)

l Installing the PQAdvisor framework onto an ION VIP Service other than VIP.PQADVISOR
is not recommended.

l Installing the PQAdvisor framework onto an ION VIP Service that has existingmodules
that have been put in by a user is not recommended.

1. Open PowerMonitoring Expert Designer.

2. Click File > Open.



3. Click the ‘VIP.PQADVISOR’ node and click OK.

4. Select theEdit > Paste from frameworkmenu item.

5. Navigate to the folder containing the PQAdvisor Framework file: {root install folder-

}\config\fmwk\PQ_Advisor

6. Click the file PQAdvisor_v1.0.0.0.0.fwn and click Open.

NOTE: Use themost current version of the fwn file available.

7. In the Paste Summary dialog:

a. Ignore items with a red check mark, as these are coremodules that cannot have two
instances in the same VIP. The existingmodules will work with the new framework being
pasted.

b. In theSource column, select the first list entry with a green check mark, press and hold the
Shift key, and then click the green check mark icon in the check box on the final entry. This
action applies the lock paste selection to all entries.

NOTICE
UNINTENDED DEVICE OPERATION

• Do not use the lock paste option to overwrite existing destinationmodules.
• Only use the lock paste option if you are an advanced user familiar with ION
architecture.

Failure to follow these instructions can result in operational differences in
required modules.

c. In a new PowerMonitoring Expert installation, nomodules should be overwritten. In an
existing PowerMonitoring Expert installation, theremay be conflicts and the framework
pastemay try to overwrite existingmodule; if this occurs double click the check box again
so that it returns to just a check mark, and note themodule that created a conflict.

8. Press OK when pasting is complete.

The PQAdvisor framework is visible in Designer.

9. Click Save to complete the process.

Open the Power Quality Indicator Diagrams
The PQ Indicator Diagrams are located in:
{root install folder}\config\diagrams\ud\PQ_Advisor
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The diagrams start to function once the framework is pasted in the PQAdvisor VIP. You can link
them to the existing Vista diagrams or use them separately.

NOTE: When a Power Quality Indicator has no supported device to feed it the required data, it
should be disabled by following the procedures in the section "Disable unused Power Quality
Indicators" on page 195.

Alternative symbols can be used to provide a colorblind friendly view. They are located in the folder:

{root install folder}\config\diagrams\images\ PQ_
Advisor\Indicators\Alternate\

Set the Query Server – Distributed system only
When using distributed PME systems, set the query server node for the following landing page
diagrams:

l PQAdvisor_LandingPage_24h_V1.0.0.0.0.dgm

l PQAdvisor_LandingPage_7d_V1.0.0.0.0.dgm



l PQAdvisor_LandingPage_30d_V1.0.0.0.0.dgm

l PQAdvisor_LandingPage_12m_V1.0.0.0.0.dgm

Configure the Standardized Equipment Diagrams
The following sections describe how to set up and configure the Standardized Equipment Pages.
Skip this section if corrective equipment does not exist in the system.

l Configure the Framework for the Equipment Diagrams

l Configure the Equipment Diagram Detail Pages

l Configure the Equipment Diagram Group Pages

l Configure the Equipment Diagram Landing Pages

Unlike the PQAdvisor Indicator diagrams, the Equipment diagrams are not auto-functional pages,
but rather templates that you use during commissioning to provide the user with equipment status
displays with the same user experience and focus on simplification as the PQAdvisor Indicator
pages.

The equipment diagram elements are:

l Equipment Diagram Landing Pages

l Equipment Diagram Grouping Pages

l Equipment Diagram Detail Pages

Equipment Diagram Landing Pages

The Corrective Equipment Status portion of the Power Quality Advisor page is a landing page.

The Equipment page is also a landing page.
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Equipment Diagram Grouping Pages

When you select an element of the Equipment landing page (e.g. Capacitor Banks), the grouping
page opens. A summary entry for each device (e.g. Capacitor Bank) in the system could be
configured here.

Equipment Diagram Detail Pages

When you select an element on the Equipment Grouping Page, the equipment diagram detail page
for that device opens.



The following supported devices currently have template pages available:

l Capacitor Banks: VarPlus Logic VL6 and VL12

l Active Harmonic Filters (AHF): Accusine PCS+/PFV+

l Uninterruptible Power Supplies (UPS): Galaxy 5000 and 5500

All Equipment Diagrams are installed in the following location:
{root install folder}\config\diagrams\ud\Equipment

Configuration Workflow

The order of commissioning is the opposite of user workflow. Set up the Detail Pages first, and then
create the buttons for each Detail Page on theGroup Pages. The Landing Pages (both Equipment
and PQAdvisor Indicator), require no commissioning other than optional customization if required.
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Configure the Framework for the Equipment Diagrams
Configure the Equipment Pages of the VIP framework to display aggregated warning/alarm
indicators found on the PQAdvisor Indicator Landing Pages and on the Equipment Landing and
Group Pages.

NOTE: The VIP.PQADVISOR servicemust be set up and running with the Equipment Status
Indicator Framework configured to commission the Equipment Diagrams.

The PQAdvisor Framework contains some template OR Logic modules and simple instructions on
configuring the VIP to work with the Equipment Pages:

1. Open the VIP.PQADVISOR framework in Designer.

2. Open theEquipment grouping folder.

The Equipment folder contains the following:

Summary Section:



Capacitor Bank section:

Active Harmonic Filters section:

The UPS section:
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Configure device count
1. Right-click themodule labeledDEVICE COUNTS to open the ION Module Setup dialog.

2. Double-click any of the ‘Formula’ Setup Registers to modify their value. The value entered rep-
resents the number of devices of corresponding type listed directly to the right in the Output
Registers list.

3. Repeat Step 2 until there is a device count number for each of the listed devices.

Configure equipment status
1. Set up the capacitor bank by duplicating the templatemodule labeledCap Bank Group Item:

TEMPLATE (or by creating a new AND/OR module).



2. Right-click the new module andmake the followingmodifications:

a. Set themode of operation to OR.

b. Enter the name of the capacitor bank device in theCustom Label field.

3. Link the input of the new module to a device alarm status output by performing the following
steps:

a. Click the ION button on the toolbar to open the Create Link dialog.

b. Click the desired device, Alarms underManagers, Low Current Alarm underModules,
and Low Current Alarm underOutput Registers.
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c. Click OK.

d. The cursor appears with a circle; click the input of themodule and select NEW Source.

4. Repeat Step 3 until each of the capacitor bank’s desired alarm status is connected to themod-
ule.

By doing this, the output of themodule outputs a ‘1’ (High) state if any of the connected alarm
states are activated.

5. Link the output of the new module to the input of themodule labeledCap Bank Landing
Page.



6. Repeat Steps 1-5 for each capacitor bank in the system.

7. Remove the link between the output of the templatemodule and the input of the Landing Page
module:

a. Right-click the input of the Landing Pagemodule.

b. In the resulting window select the appropriate input.

c. Click Unlink.

8. Repeat Steps 1-7 for the Active Harmonic Filter and UPS device frameworks until each
desired corrective equipment device in the system is connected.

9. Save themodified framework.

NOTE: The outputs of themodules configured for the individual devices drive the Equipment
Group Page indicators, and the outputs of the Landing Pagemodules drive the Landing Page
Indicators on both the Equipment Pages and PQAdvisor Indicator pages.

Configure the Equipment Diagram Detail Pages
Each individual piece of equipment in the system can have its own detail page. These diagrams
connect directly to the devices and do not have any interaction with the PQAdvisor VIP service.
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To set up any of the detail pages using the provided template diagrams:

1. InWindows Explorer, open the folder location that contains the DetailPage template for one of
the Equipment (UPS, Capacitor bank or Harmonic filter).

2. Highlight the template that will be used and copy it by pressingCtrl+C and paste it using
Ctrl+V.

3. When the file is pasted, it is enabled for editing. Choose a new name for the diagram file; prefer-
ably one that is easily associated with the device of interest.

NOTE: Take care not to overwrite the original template file by ensuring that the new file has
a new and distinct file name.

4. Open the PME Vista application and ensure that the toolbox is enabled.

5. Open the new file that was created in step 3 by selecting File > Open and navigating to the
containing folder in the dialog.

6. When the diagram opens, right-click anywhere on the background, and select Properties on
themenu.



7. In the subsequent dialog, select theNode tab.

8. On theNode tab, select Custom and then click Select to open the Select Node dialog.

9. Select the node name of the equipment for which the diagram was created, and click OK.

10. Click OK on the properties dialog, and click Save in Vista.
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Provided the correct device was selected as the parent node of the page (that is, that the
devicemapping is correct), all the fields and indicators on the page should populate and be
ready for use.

Verify that the device selected is the correct type for the template being used, and that the
device is configured correctly.

Once the page has been linked to the node, there are a few manual steps that should be
completed to customize the page:

11. Customize the page as per the graphic above:

a. Update the page header to include the unique name of the device.

b. Change the picture of the device from the sample image to a custom image, such as a
standard image or an actual picture of the device.

c. Update the devicemodel name to bemore specific.

12. As a final step, click the folder icon in the Overview section to view the default diagram of the
device. Verify that the correct default diagram appears, and that the values and status shown
match what appears on the detail page.

13. Repeat all steps for other equipment.

Configure the Equipment Diagram Group Pages
Group Pages display multiple devices of a particular type from a single location.



This is made possible by creating and customizing "Buttons" that consist of grouping, numeric, text,
and status objects arranged to represent a clickable overview of a single device.

Group Pages set up and scaling
Before the Group Page for a particular device type can be populated, the logical organization of the
device groupingmust be reviewed, andmultiple Group Pages need to be created if necessary.

If there are less than eight devices of the Group Page type, then proceed to the "Group Page
Buttons set up and Detail Page association" on page 165. If there aremore than eight, createmore
Group Page diagrams. These new pages will be linked as tabs from themain device typeGroup
Page.

Device scaling
The first step is to determine how many diagrams will be required by counting the number of devices
of the type in question. A single Group Page diagram has eight Button positions, so there will need
to be aGroup Page diagram for each eight devices and portion thereof. For example, if the system
contains ten capacitor banks (each with its ownDetail Page diagram), then there will need to be two
Group Page diagrams; one page with eight buttons, one page with two.

Alternately, a different organizational scheme can be incorporated by creating aGroup Page for
each logical grouping of devices. For example, a separate Group Page can be created for each
production line in a facility, thus allowing the user to conveniently check the active harmonic filters
that are present for a production line that is experiencing problems.

Another option is to create Group Pages for different buildings or areas within a facility.

Ultimately, it is up to the deploying Application Engineer to determine the solution whichmakes the
most sense for the user's application.
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Group scaling
EachGroup Page has space for six tabs, therefore, if there aremore than six Group Pages required
for a single device type, they need to be arranged into sub-types on the Landing page level. For
example, if there were twelve Group Pages for active harmonic filters, they need to be split into two
logical categories and treated separately on the Landing Page level.

For this set up guide, assume that there are only six or less Group Pages required in the steps
outlined below.

Group Page logical set up
With the number of Group Pages required in mind, complete the following preliminary setup steps:

Set up the Group Page files

1. InWindows Explorer, open the folder location that contains the Group Pages.

2. Highlight the template that will be used. Copy it by pressingCtrl+C and paste it usingCtrl+V.

3. When the file is pasted, the file name opens for editing.

Choose a new name for the diagram file; preferably one that reflects how theGroup Pages will
be organized.

Note that the original file (the one that contains the word "All" or "Pg1" in the filename) will be
themain Group Page that is linked to/from the Equipment landing page. For example, if one
were creating an active harmonic filter Group Page for each floor of a facility the filenames
would be as follows:

a. Equipment_GroupPage__AHFAll_V1.0.0.0.0.dgm (default filename for the first floor)

b. Equipment_GroupPage_ AHF_Floor2_V1.0.0.0.0.dgm

c. Equipment_GroupPage__AHF_Floor3_V1.0.0.0.0.dgm

And so on.

NOTE: Use themost current version of the dgm file available.

4. Press Enter to save the file name.

5. Repeat steps 2-3 until you create all required files.



Set up tabs in the First Group Page

1. Open PME Vista and ensure that the Toolbox is enabled.

2. Open the first logical Group Page file that is to be set up by selecting File > Open from the
menu bar and navigating to the containing folder in the dialog.

3. Select the tab text (the green text Default Group in new installations) and press Ctrl+C to
copy it.

4. Press Ctrl+V to paste up to six text boxes - one for eachGroup Page.

5. Arrange the text boxes evenly along the tab line in up to five additional "tab" positions.

6. Change the text color for each of the pasted text boxes (but not the original) to black:

a. Right-click the text box to open the Text Box Configuration dialog.

b. Click the Text tab.

c. Select Custom and click the Font button to open the Font dialog.

d. Select Black from the Color dropdownmenu and click OK.

e. Click OK on the configuration dialog to complete the change.
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7. Place a new Grouping Object over top of each new text box.

8. Change the shape of each new grouping object by left-clicking the object and dragging the
black tabs that appear.

The objects will be what the user will click to navigate to other tabs; they should therefore
cover the text underneath, and should not overlap.

9. Make each new grouping object link to the Group Page diagram referenced by the text under-
neath it.

a. Right-click the grouping to open theGrouping Object Configuration dialog.

b. Select theAction tab.



c. Select Open User Diagram and click theBrowse button to open the Choose sub-diagram
dialog.

10. Make each new grouping object appear transparent to show the text underneath it.

a. Right-click the grouping to open the configuration dialog.

b. Select theDisplay tab.

c. Select None.

d. Click OK in the configuration dialog to complete the change.

11. Hold down the left mouse button and draw amarquee around the entire tab (text box and group-
ing) objects.

12. Press Ctrl+C to copy the objects.

13. Save and close the diagram.
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Set up tabs in subsequent Group Pages

1. Open the next Group Page diagram by selecting File > Open from themenu bar and nav-
igating to the containing folder in the dialog.

2. Delete any existing text box objects in the tab area by selecting them and pressingDelete.

3. Press Ctrl+V to paste the tab objects from the previous Group Page diagram.

4. Change the color of the text in the text box that represents the first Group Page to black (see
"Setting up Tabs in the First Group Page', Step 6).

5. Add a new grouping object over top of the text that represents the first Group Page, modify it to
be transparent, and link it to the first Group Page diagram file (see "Setting up Tabs in the First
Group Page', steps 8-10).

6. Delete the grouping object in the tab area that links to the current Group Page by selecting it
and pressingDelete.

7. Change the color of the text in the text box that represents the current Group Page to green.

8. Change the background image of the diagram to one that has highlighting on the correct portion
of the tab area:

a. Right-click any unpopulated space on the diagram area and select Properties on the
menu.

b. Select the Image tab in the Configuration dialog.

c. Select Custom Image and click Browse.

d. In the resulting, navigate to the following location: …\con-
fig\diagrams\images\Equipment_Diagrams\Backgrounds

">

e. Select the correct background image.

Each Equipment diagram background image included in this installation is the same,
except for the position of a green highlight in the tab area. The filename of the background
image indicates where the green highlight is located. For example, "PQEquip_Lvl1BG_
Pos2_V1.0.0.0.0.bmp" has a highlight in the second position from the left, indicated by the
"Pos2" text in the filename. Double-click the file to complete the selection.

NOTE: Use themost current version of the bmp file available.

f. Click to complete the change and to close the configuration dialog.



9. Repeat steps 1-8 until all Group Pages have the required tabs.

Group Page Buttons set up and Detail Page association
The following steps outline how to set up aGroup page with custom buttons for each device that
has an associated Detail Page:

1. Open Vista and ensure the Toolbox is enabled.

2. Open theGroup Page file that is to be set up by selecting File > Open from themenu bar and
navigating to the containing folder in the dialog.

3. Hold down the left mouse button and draw amarquee around the template button in the top left
position of the page space, selecting all objects contained within.
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4. Press Ctrl+C to copy the button items.

5. Press Ctrl+V to paste up to seven additional buttons (for a total of eight on the page); one for
each device with a Detail Page.

6. Link an indicator (status) object to its corresponding ION module in the PQAdvisor Equipment
VIP Framework:

a. Right-click the indicator (status) object.

b. Navigate to the correct module output by selecting the following in the Create Link dialog:

i. Node: VIP.PQADVISOR.

ii. Managers: And/OR Modules.

iii. Modules: the AND/OR module that was set up for the corresponding device in the



Equipment Status Indicator Framework step.

iv. Output registers: (module designator) Result.

7. Repeat step 6 for each indicator object on the page.

8. Link the numeric objects within the button to the corresponding outputs on the device.

a. Right-click the numeric object.

b. Navigate to the correct module output by selecting the following in the 'Create Link' dialog;
start by selecting the device in the 'Node' section and navigating to the desired numeric out-
put.

9. Repeat step 8 for each numeric object on the page.

10. Link the button background to the appropriate Detail Page:

a. Right-click the button (grouping object) area where there is no other object (such as
numeric or indicator).

b. Select theAction tab on the configuration dialog.

c. Select Open User Diagram and click Browse.

d. In the resulting window, navigate to the Detail diagram file.

e. Click OK on the configuration dialog to complete the change.
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11. Repeat step 10 for each button (Grouping Object) on the page.

12. Repeat this process for each (corrective) device type in the system.

TheGroup Page should now be configured.

13. Repeat this process for any other Group Page diagrams in the system.

Group Button measurement linking
Themeasurements displayed on theGroup Page buttons are linked to the devicemeasurements by
navigating to the appropriate measurement in the numeric object configuration window. To help the
deploying Application Engineer, these links are listed in more detail below along with the ION
Handle:

See the section called “How toModify Indicators” in the Appendix called “How toModify Power
Quality Advisor Vista Diagrams” for instructions on how to link to ION Handles.

VarPlus Logic Capacitor Bank Button Measurement Display

Button Label Measurement Label in Device ION Handle
Power Factor - Target Target Cos Phi 01 0x8502E01
Power Factor - MeasuredPower Factor Total 0x8803701

Accusine PCS+ Active Harmonic Filter Button Measurement Display

Button Label Measurement Label in Device ION Handle
Total Load Current - A Load Current A Total 0x8100001
Total Load Current - B Load Current B Total 0x8100002
Total Load Current - C Load Current C Total 0x8100003
Load Harmonic - A Load Harmonics Current A 0x810001B
Load Harmonic - B Load Harmonics Current B 0x810001C
Load Harmonic - C Load Harmonics Current C 0x810001D

Galaxy 5500 UPS Button Measurement Display

Button Label Manager Module Output Register ION Handle



TimeRemainingDiagnostics2 Backup Time Battery TimeRemaining 0xb300002
Battery Voltage Voltages Voltage Battery DC Voltage 0xc000018
Loading Power Factors Power FactorTotal Output Percent Load0xb200001

Configure the Equipment Diagram Landing Pages
Configuring Landing Pages is the last step in setting up the Equipment Page.

The indicators (Status Objects) on the Landing Pages are linked to the output of the respective
Equipment Landing Page ION Module in the Equipment Status Indicator Framework of the
VIP.PQADVISOR service.

The Equipment Counts (Numeric Objects) are linked to the 'DEVICE COUNTS' ION Arithmetic
Module in the Equipment Status Indicator Framework. The number of devices of each category
within the system needs to be entered into the Setup Registers of themodule.

Link the button background to the appropriate Group Page:

1. Right-click the button (grouping object) area anywhere that there is no other object (such as
numeric or indicator).

2. Select theAction tab on the Configuration dialog.

3. Select Open User Diagram and click Browse.

4. In the resulting window, navigate to the Group diagram file.

5. Click OK on the Configuration dialog to complete the change.

6. Save the diagram.

Customizationmight be needed under the following circumstances:

l There aremore than six Group Pages (i.e. more than 48 devices) for a particular device.

l The customer's application demands multiple Landing Pages with custom groups of device
types. An example of this is pre-configured on default Landing Page; there is a tab for all
devices and a tab for corrective devices only.
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When customization is required, follow the steps in this section for adding additional pages/tabs and
additional buttons. Note that the background images used for the Group Pages are the same as
those used in the Landing Pages.

(Optional) Create a PQ Advisor tab in the Web Applications
An optional step is to create a tab in theWeb Applications interface to view the PQAdvisor Vista
diagrams:

To do this:

1. Navigate to the following file: {root install folder-

}\Applications\ApplicationFramework\Framework.xml

2. Copy the file and save it as a backup.

3. Right click the file and select Edit.

4. Scroll to the place in the file with the following lines:

</Application>  </Applications>

5. Between the two lines shown in step 3 above, copy and paste the following XML code snippet:

<Application id="3a0163ba-c26d-4b79-a846-9e62961ddced" name="Advisor"

requiredPrivilege="WebReach.AccessApplication" buttonContents=""

description="PQAdvisorVistaDiagram_Description" displayName="PQ ADVISOR"

resourcesClassName="UI.ApplicationFramework.Resx.ApplicationFrameworkResources,

ApplicationFramework, Version=1.0.0.0" securityLevel="0">

<ApplicationSpecificPanelButtons></ApplicationSpecificPanelButtons>

<Libraries>

<Library className="LibraryPanelItem3" />

</Libraries>

<OptionsButtonControls></OptionsButtonControls>

<SetupControls>

<SetupItem SetupControlId="b29ceb39-4cd8-4077-9c7c-4c6287ac5b64" />

<SetupItem SetupControlId="2600efb2-955a-4fef-9895-c8e716325656" />

<SetupItem SetupControlId="63c71c83-3d88-4d2f-a6eb-db9a1b0f3989" />

</SetupControls>

<Settings>

<Setting name="Url">/ion/default.aspx?dgm=x-pml:/diagrams/ud/PQ_Advisor/PQAdvisor_

LandingPage_7d_V1.0.0.0.0.dgm</Setting>     

</Settings>

</Application>

NOTE: After you paste the snippet into the Framework file, remove any line wrapping
breaks in <Setting name="Url">...</Setting> (so that it occupies a single line of
code only.) Also, use themost current version of the DGM file available.

6. Save the file.

7. If theWeb Application interface is open, reload the page.



8. Verify that the new selection appears and that the PQAdvisor indicator diagrams are loaded
when it is selected.

NOTE: The System Technical Note titledHow Can I Modify the StruxureWare Power
Monitoring Expert WebUser Interface and AddWebContent
(https://exchangecommunity.schneider-electric.com/message/67646#67646), contains more
details onmodifying theWeb Applications User Interface.
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Configure Power Quality Impact Gadgets and Report
The Power Quality Impact Gadgets and Reports associate PQ events with process impact alarms
within a given process / production line, and applies a flat rate cost estimate to the duration of the
process impact alarm.

The following sections describe the configuration steps tomake the Power Quality Impact Gadgets
work:

l "Acquire process impact signals" on page 172

l "Set up process impact alarms" on page 173

l "Set up Power Quality Groups" on page 174

Acquire process impact signals
A process impact alarm is designed to be created on:

l An electrical value (e.g. current, voltage, power, etc.) from a power device. In this way PME
detects the process impact independently (for example, based on a current drop).

l A process impact signal from another system or equipment. The process impact signals can
be:

l Hard wired signals from the process. The signal can be from the process PLC, motor VSD,
etc. It can be hard wired to a digital input or an analog input of themeter whichmonitors the
corresponding load (requires AI/DI capability on themeter). The signal can also be hard wired
to a dedicated PLC, which can then be connected into PME as aModbus device.

l OPC tags from the process. PowerMonitoring Expert (working as OPC client) acquires the
process impact signals from process SCADA system (working as OPC server) via OPC.

NOTE: If signals frommultiple processes are connected to a single device (for example,
process A and process B signals on a PLC, powermeter or OPC connection), then logical
devices must be defined to represent each process to be used in the power quality group
definition.

To acquire the process impact signals (if PowerMonitoring Expert is not detecting the process
impact independently), the following tasks may be required to accomplish the work:

l Usingmeter I/Os

l Using third-party Modbus device in PowerMonitoring Expert

l Using PowerMonitoring Expert as anOPC client

l Using PowerMonitoring Expert Logical Device

See PowerMonitoring Expert documentation for more information.



Set up process impact alarms
Once the process impact signals are connected into the PME system, or PME is set up to detect
the process impact independently, process impact alarms need to be set up.

To set up process impact alarms:

1. LaunchAlarm Configuration fromManagement Console, or from theAlarm tab in the web
interface.

2. Select Add Alarm Rule.

3. In theUser Defined section. Select Analog Measurement if the alarm is based on an analog
value. Select Digital Measurement if the alarm is based on a digital value.

4. Select theMeasurement that will be used to determine a process impact event (e.g. Current
Avg if using the current drops to signify the process impact, orEquipment State if the pro-
cess impact signal is mapped to this measurement for the Logical Device created for the pro-
cess)

5. In theAlarm Type field, enterProcess Impact Alarm.

NOTE: The string “Process Impact Alarm” is the only flag that the Power Quality Impact
report and gadgets looks for.

6. Configure the thresholds for when the alarm will go ON and when the alarm will go OFF.
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7. Configure thePickup Delay andDropout Delay:
The alarm will go ON if the threshold has been exceeded for longer, in seconds, than the
“Pickup Delay” value.

The alarm will go OFF if the value is below the threshold for longer, in seconds, than the
“Dropout Delay” value.

8. Configure thePriority. Use a number less than 64 to prevent the alarm from appearing in the
PME Alarm Viewer.

9. Set thePolling Interval. The recommendation is 5 seconds.

10. Select theSource for the alarm rule. If a Logical Devices is created to represents a process,
select the logical device.

11. Give the Alarm rule a name.

12. Click Finish.

Set up Power Quality Groups
The Power Quality Groups are defined per process (for example, a production line), so that only the
power quality events captured by themeter which relate to the particular process are considered in
the impact analysis.



Power Quality Groups must be defined or the Power Quality Impact gadgets and Report will not
function.

The incomermeters defined in the Power Quality Groups are also used for the Power Factor section
of the Power Quality Analysis Report.

Power Quality Group definition
Power Quality Group are defined in the PowerQualityGroups.csv file which is located under
the folder:
{root install folder}\Applications\PowerQuality\

The format of the comma delimited file is as follows:
<Power Quality Group Name>,<Incomer Meter>,<Feeder Meter>,<Load

Meter>,<Rate>
Where:

l Power Quality Group Name – The name for the group (target process). It is used for selecting
the group in Power Quality Impact gadgets and report.

l Incomer meter – Themeter monitors the incomer. It typically has the PQ event detection cap-
ability. The event it captures will be used in the analysis.

l Feeder Meter – Themeter between the incomermeter and the loadmeter (could bemultiple).
The PQ events it captures can potentially impact the process at its downstream. If a feeder
meter does not support PQ event detection, then there is no need to include it in the definition.
See the examples in next section.

l Load Meter – Contains the Process Impact Alarms. The Power Quality Impact Gadgets and
Report will not work if the loadmeters are not defined for the Power Quality Groups. It can be a
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logical device if the Process Impact Alarm is defined on a logical device. See "Set up process
impact alarms" on page 173 for more information. The loadmeter typically doesn’t have PQ
event detection capability.

l Rate – The flat hourly rate for the cost impact calculation

NOTE:
l The file structure only allows one incomermeter, one feeder meter, and one loadmeter per
row. If, for a category, more than onemeter needs to be included, define them inmultiple
lines with the same group name.

l The file structure allows one rate per group; define it only in the first row of the group.

l The PQ events captured by themeters in a Power Quality Group will be clustered before
associating with the Process Impact Alarms, so that the same event seen by different
meters are counted only once.

l Only the PQ events captured by the incomermeter and feeder meter are considered in the
analysis. If the loadmeter supports PQ event detection, and you want to include the events
it detects into the analysis, you need to define it as a feeder meter as well. See the
examples in next section.

l The incomermeters defined are also used by the Power Factor section of the Power Quality
Analysis Report to determine the incomermeters in the system. See the examples in next
section.

Edit PowerQualityGroup.csv
NOTE: Before editing the PowerQualityGroups.csv file, make sure you understand the
relationship between the powermetering system and the process of the customer’s facility.

To edit the PowerQualityGroups.csv file:

1. Identify theSystem Name of a device, go toManagement Console, select System Name in
the Column Selector to addSystem Name to the display:

NOTE: Only the device system names are acceptable.

2. Edit the file in Excel, Notepad or other text editor. For each Power Quality Group:

a. In column B, list all related incomermeters that can detect PQ events for the group. Use
multiple rows if there is more than one incomermeter.



b. In columnC, list all related feeder meters that can detect PQ events for the group. Usemul-
tiple rows if there is more than one feeder meter.

c. In columnD, list all related loadmeters on which the Process Impact Alarms are con-
figured for the group. Usemultiple rows if there is more than one loadmeter.

d. Repeat the group name in column A for each row.

e. Specify the rate in column E for only the first row for the group.

3. Repeat step 2 for each Power Quality Group.

4. Save the file and keep the format as .csv.

NOTE:
l The list separators for the .csv are “,” for most regions, and “;” for several European
countries. The list separators will be detected from the culture settings and used by the
import/export exe.

l The rate under culture settings, other than English (en-XX), needs to be enclosed in double
quotes. For example, for Spain (es-ES), if the rate 123.456.789,0 is represented, it is input
as "123.456.789,0".

Example 1:

Take themetering layout in the following image as an example, the definition contains the following:

Example 2:

In amore complicated example:

The file contains the following:
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Example 3:

As explained in the previous section, in addition to Example 2, if the feeder meters do not have PQ
event detection capability, there is no need to define them. (There is no effect if they are defined.)

Example 4:

As explained in the previous section, in addition to Example 3, if the Process Impact Alarm for the
“Process A” is defined only under “Load.meter2”, then “Load.meter2” is the only meter that needs to
be defined for the “Process A”. (There is no effect if other loadmeters are included.)

Example 5:

As explained in the previous section, in addition to Example 4, if the “Load.meter3” can detect
sag/swell, and you want the event it captures to be included the analysis, you need to duplicate it as
a feeder meter:

Example 6:

The incomermeters defined in the Power Quality Groups are also used for the Power Factor section
of the Power Quality Analysis Report.

If the customer does not require the Power Quality Impact feature, and only wants to enable the
Power Factor section of the Power Quality Analysis Report, the file can be created as:



Import / Export Power Quality Group Definition
The tool PQGroupConfig.exe is used to import / export the Power Quality Group definition in the
PowerQualityGroups.csv file. It is located in {root install
folder}\Applications\bin

Import Power Group Quality definition
To import the definition, run the command line:
PQGroupConfig.exe import "<filepath>\<filename>"

If you are using the default file name and path, copy the following command line:

PQGroupConfig.exe import "C:\Program Files (x86)\Schneider
Electric\Power Monitoring
Expert\Applications\PowerQuality\PowerQualityGroups.csv"

Export Power Group Quality definition
To export the definition, run the command line:
PQGroupConfig.exe export "<filepath>\<filename>"

If you are using the default file name and path, copy the following command line:

PQGroupConfig.exe export "C:\Program Files (x86)\Schneider
Electric\Power Monitoring
Expert\Applications\PowerQuality\PowerQualityGroups.csv"
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Configure Power Factor Impact Gadgets
The Power Factor Impact Gadgets provide a clear visual indication of the impact of poor power
factor on your energy bill.

NOTE:
l The Power Factor Impact Gadgets only work for billing periods that start on the first day of
themonth. Billing periods that do not start on the 1st (for example, the 20th) are not
supported.

l The Viewing Period for the Power Factor Impact Gadget should be set to This Month or
Last Month. The gadget does not show meaningful information if you set the Viewing
Period to another value.

l The Aggregation Period for the Power Factor Impact TrendGadget should be set toBy
Month. The gadget does not show meaningful information if you set the Aggregation Period
to another value.

The calculated surcharge is based on the rate file defined for the PME Rate Engine. Creating or
modifying the rate files requires knowledge of the PME Rate Engine. To learn about the PME Rate
Engine, refer to PME BillingModule Toolkit.

The following sections describe the Power Factor Impact Gadgets configuration steps:

l "Set up the Power Factor Impact rate file" on page 180

l "Set up the incomermeters in the hierarchy" on page 181

Set up the Power Factor Impact rate file
There are four sample rate files based on different calculationmethods that are generally used by
utilities for power factor rate penalties:

l Power Factor Impact - Active Energy Billing with PF Adjustment

Option 1.xml

l Power Factor Impact - Active Energy Billing with PF Adjustment

Option 2.xml

l Power Factor Impact - Apparent Energy Billing.xml

l Power Factor Impact - Reactive Energy Billing.xml

The rate file Power Factor Impact Rate.xml is active by default. It includes the same
calculation as the first sample file. See "Power Factor Rate File Calculation" on page 303 for the
calculations of the sample rate files.

The files are located under the folder:
{root install folder}\config\reports\billing report\ratelibrary
To set up the Power Factor Impact rate file:

1. Consult with the customer to see how the power factor penalties are calculated by the utility
provider, including the power factor target under which penalty will be charged.

2. Choose the sample file in which the power factor penalty calculation is the closest to cus-
tomer’s utility contract.

https://exchangecommunity.schneider-electric.com/docs/DOC-8707


3. Copy the selected rate file to the file name "Power Factor Impact Rate.xml"

4. Modify the file to have the same power factor penalty calculation with customer’s utility con-
tract. To learn how tomodify the rate files, please refer to thePME BillingModule Toolkit as
mentioned above.

5. Set the target to be shown in the gadgets.

a. Find PF target value by searching for "<Name>PF_target</Name>"

b. Modify the value for the Formula accordingly.

6. Save the file.

Set up the incomer meters in the hierarchy
The PME rate engine only works with a hierarchy node. Therefore, you need to add themeters
which are subjected to the penalty to a hierarchy. You can do this with the default hierarchy, a
custom hierarchy, or virtual meters.

The gadgets only work on a single node. If more than one physical meter needs to be defined (e.g.
dual incomer from same utility), add themeters to a single node in the hierarchy, or addmeters to a
single virtual meter.

For example, to add the dual incomermeters as a virtual meter:

1. LaunchHierarchy Manager fromManagement Console or navigate to http://<Server-
Name>/hierarchymanager in a web browser.

2. Click theVirtual Meter tab and click Add.

3. Choose a name for the virtual meter, for exampleMain_Incomers.

4. Click Add and select ameter to add to the Virtual Meter. Repeat until all the you add all the
meters that incur PF penalties.
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Once the hierarchy node is defined, it can be selected in the Power Factor Impact Gadgets.
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Configure Power Quality Analysis Report
The Power Quality Analysis Report does not need configuration to work, unless you want to include
output for the Power Factor section in the report.

The Power Factor section reports the power factor information for the incomermeters in the system.
The report retrieves the incomermeter definition from the Power Quality Group definition. See for
more information on how to define the incomermeters.

Alternatively, the Power Factor section can be toggled off when generating the report.



Set up Power Quality Advisor dashboards and reports
This section describes best practices when using Power Quality Advisor dashboards and reports.

Set up Power Quality Advisor dashboards
Power Quality Advisor gadgets are grouped into two groups in PowerMonitoring Expert
Dashboards:

l Power Quality Overview

l Power Quality Impact

l Power Quality Impact Trend

l Power Factor Impact

l Power Factor Impact Trend

l Power Quality Rating

l Power Quality Rating Trend

l Power Quality Details

l Power Quality Events Breakdown

l Power Quality Events Impact

l Power Quality Events Location

Set up Power Quality Overview Dashboards
The following image is an example of a Power Quality Overview dashboard.

Gadget viewing period
When displaying each gadget with its trending gadget, the aggregation period of each bar in the
trending gadget shouldmatch the viewing period of the non-trending gadget. Otherwise, they are not
comparable.

For example, if the non-trending gadget is set to bemonthly,
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the corresponding trending gadget should be set to a time range of Last 12 Months, and an
aggregation of By Month.

NOTE: Specifically for the Power Factor Impact Gadgets:
l The Viewing Period for the Power Factor Impact Gadget should be set to This Month or
Last Month. The gadget does not show meaningful information if you set the Viewing
Period to another value.

l The Aggregation Period for the Power Factor Impact TrendGadget should be set toBy
Month. The gadget does not show meaningful information if you set the Aggregation Period
to another value.

Set up Power Quality Detail Dashboards
The following image is an example of the Power Quality Detail dashboard. (Three regular Trend
charts for Power Factor, Harmonics, and Unbalance are combined in this dashboard.)



Generate Power Quality Advisor Reports
The following PQAdvisor Reports are available:

l Power Quality Analysis Report

l Power Quality Impact Report

NOTE: When you generate the Power Quality Advisor reports, a reporting period longer than 12
months is not supported. Usemultiple yearly reports instead.
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Fine-tune Power Quality Advisor
Fine-tuning Power Quality Advisor is very important during commissioning to obtain useful power
quality views. It depends heavily on customer requirements, power system design, powermeters
used in the system, and the power quality condition of the customer’s facility.

This section describes the following fine-tuning procedures:

l "Change device inclusion and exclusion for the analysis" on page 188

l "Change Power Quality Indicator thresholds" on page 191

l "Disable unused Power Quality Indicators" on page 195

Change device inclusion and exclusion for the analysis
You can include or exclude certain meters for power quality assessment by PQAdvisor. For
example, this capability is useful when you want to include only meters which are critical, or to
exclude sparemeters, etc. Also, for performance reasons, it is important to exclude unnecessary
meters.

You can include or exclude the following Power Quality Event types:

l Interruptions

l Voltage Sags

l Voltage Swells

l Transient Voltage

l Over Voltage

l Under Voltage

And you include or exclude the following Power Quality Disturbance types:

l Voltage Unbalance

l Current Unbalance

l Voltage Harmonics

l Current Harmonics

l Frequency Variation

l Flicker

Each PQ event or disturbance has an inclusion list and an exclusion list, and the following logic
applies to both lists:

1. The inclusion list is processed first:

a. If the inclusion list is empty, assume that ALL sources in the system are included. This
means all sources in the sources table.

b. If the inclusion list is not empty, use only sources that exist in the inclusion list. If a source
in the inclusion list does not exist in the sources table, do not add it to the list.



2. The exclusion list is processed last:

a. From the source list obtained in step 1, remove any source that appears in the exclusion
list.

The following features in the PQAdvisor module which are affected by the inclusion and exclusion
lists:

l PQ Indicator Diagrams

l PQRating Gadget

l PQRating TrendGadget

l Power Quality Events BreakdownGadget

l Power Quality Events Impact Gadget

l Power Quality Events Location Gadget

l Power Quality Analysis Report – for all sections except the Power Factor section

NOTE: These lists do not define:
l Devices considered by the Power Quality Impact Gadgets and Report.

l Devices considered by the Power Factor Impact Gadgets.

l Devices considered for the Power Factor section of the Power Quality Analysis Report.

See the configuration sections of the above features for details.

To edit the inclusion and exclusion lists:

1. Identify theSystem Name of the target device. Go toManagement Console, show System
Name column using the Column Selector:

2. Go to SQL Server Management Studio, locate the dbo.vCFG_ConfigItems view in the ION_
Network database, and right-click and select "Edit Top 200 Rows".
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The following variables are the inclusion and exclusion lists:



3. In theValue fields, enter the comma delimited list of the devices, for example:
PQ.B1,PQ.B2,Main.BackupGenerator

4. To apply the changes immediately in the PQ Indicator Diagrams, go to the PQAdvisor Setup
page in Vista:

Click Initialize/Update Indicators.

5. To apply the changes immediately in the Power Quality Rating Gadgets, force the gadgets to
clear their cache by “editing” the gadget, and clickingSave (no changes are required).

To exclude all sources for a given category, put a string in the inclusion and exclusion list. For
example: “disabled”.

Change Power Quality Indicator thresholds
The Power Quality Indicator threshold for each indicator is displayed on the information page. (Click
the “i” icon.)
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The thresholds are used to determine the Power Quality Rating by using a color (green, orange, red)
for each Power Quality indicator. Also, only the samples which exceed the threshold are shown in
the Detail Report of the PQ Indicator diagrams.

The count thresholds specified here are used to determine the colors for a year. They get divided by
365 for Last 24 Hours, by 52 for Last 7 Days, and so on. The calculation is as follows:

Round Up ((Yearly Service Limit) x (Number of Days / 365) )

For example, for 30 days, where the yearly limit for orange is 5 and the yearly limit for red is 15:

Orange limit: (5 * (30/365)) = 0.41 which rounds up to 1.

Red limit: (15 * (30/365)) = 1.23 which rounds up to 2.

NOTE: The orange limits are >=, but the red limits are

To change the thresholds:

1. In SQL Server Management Studio, in the ION_Network database locate the dbo.vCFG_Con-
figItems view.

2. Right-click the dbo.vCFG_ConfigItems view and select Edit Top 200 Rows.
The following items are the indicator thresholds:



The count thresholds specified here are used to determine the colors for a year. They get
divided by 365 for Last 24 Hours, by 52 for Last 7 Days, and so on. The calculation is as
follows:

Round Up ((Yearly Service Limit) x (Number of Days / 365) )

For example, for 30 days, where the yearly limit for orange is 5 and the yearly limit for red is 15:

Orange limit: (5 * (30/365)) = 0.41 which rounds up to 1.

Red limit: (15 * (30/365)) = 1.23 which rounds up to 2.

NOTE: The orange limits are >=, but the red limits are >.

3. Change the threshold item value as needed.

4. For the PQ Indicator Diagrams to display the updated limit information, go to the PQAdvisor
Setting page in Vista:
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Click Import Indicator Limit Information.

Change Power Quality Indicator weight factors
When setting up a baseline for the Power Quality Rating of the system, adjust theWeight Factor to
meet customer requirements, or to reflect the actual condition of the system. For example, increase
the weight for the indicator that is important to the customer, or decrease the weight for the indicator
that is not important.

NOTE: If a certain indicator is not available in the system, for example, nometer in the system
canmonitor transient, set its weight to 0.

The formula used to calculate the Power Quality Rating is:

Where:

l PQ.Indicators.Value is a number indicating each Power Quality Indicator status, Green = 2 ;
Yellow= 1 ; Red = 0

l PQ.Indicators.MaxValue = 2 for each individual indicator.

l Weight Factor is an adjustable value (default=1) for assigning a different weight to each indi-
vidual indicator depending on customer requirements.

To change a weight factor:

1. In SQL Server Management Studio, in the ION_Network database locate the dbo.vCFG_Con-
figItems view.



2. Right-click the dbo.vCFG_ConfigItems view and select Edit Top 200 Rows.
The following items are the weight factors:

3. Change the weight item value as needed.

4. To apply the changes immediately in the Power Quality Rating Gadgets, force the gadgets to
clear their cache by “editing” the gadget, and then click Save (no changes are required).

Disable unused Power Quality Indicators
When a Power Quality Indicator has no supported device to feed it the required data, disable it by
using the procedures in the following sections. See "PQAdvisor - Supportedmeters" on page 304
for meter support information.

Disable Flicker, Frequency, Harmonics or Unbalance Indicators
Use the following procedure to disable the Flicker, Frequency, Harmonics, and Unbalance
indicators. Flicker is used specifically in this example, but the procedure is the same for the other
items.

You can also use the following procedure to disable Overvoltage and Undervoltage. However, note
that it will disable both simultaneously. If only one needs to be disabled, use the procedure in the
next section.

1. To prevent PQAdvisor from requesting Flicker values, add a string “disabled” to the Flick-
erInclusionList & FlickerExclusionList (no double quotes needed). See "Change device inclu-
sion and exclusion for the analysis" on page 188 for detail steps.

2. To prevent the PQAdvisor indicator diagrams from displaying status:

a. Edit the PQADVISOR VIP in Designer.

b. Open the Flicker folder.
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c. Add a new Ext Bool Module.

d. Link the switch output register of the new module to the Enable input register on the 4 XML
import modules used for Flicker.

i. Right click on the newly created Ext Bool Module

ii. Change theModule Label and the switch Output Register Label to “Flicker Enable”

iii. Select the outputs for the Flicker Enablemodule and select “Flicker Enable”

iv. Select the input of the 24hr Flicker Count Import XMLmodule and select “Flicker
Enable”



v. Repeat the previous step for the following:

7d Flicker Count Import XMLmodule

30d Flicker Count Import XMLmodule

1y Flicker Count Import XMLmodule

vi. The result will look like this:

3. Save the VIP and close Designer.

Since the Ext Boolean has a default value of “false”, the Flicker Count Import modules are
disabled upon saving the VIP.

4. Check the PQAdvisor Indicator Diagram.

The Flicker icon should be grey.

The details should be blank:
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Disable Sag, Swell, Interruptions, Transient, or Unbalance
Indicators
Use the following procedure to disable the Sag, Swell, Interruptions, and Transient indicators, if the
devices being used in the installation do not support them. Transients are used specifically in this
example, but the procedure is the same for the other items.

You can also use the following procedure to disable either Overvoltage or Undervoltage, if only one
needs to be disabled. If both need to be disabled simultaneously, then use the procedure in the
previous section.

1. To PQAdvisor from requesting Transient values, add the string “disabled” (without the quotes)
to the TransientInclusionList and TransientExclusionList. See "Change device inclusion and
exclusion for the analysis" on page 188 for detailed steps.

2. To prevent the PQAdvisor indicator diagrams from displaying Transient status:

a. Edit the PQADVISOR VIP in Designer.

b. Open the Sag, Swell Transient, Interruption folder.



c. Right click on the 12m Event Ind Extrapmodule.

d. Double click on Formula 7 and add “S5 + “ to the beginning of the string. This will cause the
output of the equation to be NA because S5 is unassigned and therefore equivalent to NA.
If transients need to be added back to the system (e.g. a new meter which supports tran-
sients is purchased for the site), then it is easy to remove the string “S5 +” from the setup
register string

e. Repeat step d for Formula 8

f. Repeat steps c, d, and e for:

24h Event Ind Extrapmodule
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7d Event Ind Extrapmodule

30d Event Ind Extrapmodule

3. Save the VIP and close Designer.

4. Check the PQAdvisor Indicator Diagram. The Transient Voltage icon should be grey.

The DETAILS page should display zeros:



Uninterruptible Power Supply (UPS) Performance
The UPS PerformanceModule is an optional module that helps to reduce the risk of UPS battery
failure betweenmaintenance periods andmeasures UPS remaining time to reinforce patient safety.

Uninterruptible Power Supply (UPS) Auto Test
The Uninterruptible Power Supply (UPS) Auto Test solution provides a Vista diagram tomonitor the
MGE5500 series UPS in PowerMonitoring Expert.

NOTE: The UPS Auto Test solution is supported only for theMGE5500 UPS.

Adding UPS devices to Management Console
1. Log in to theManagement Console.

2. In Management Console, click Devices and add each new UPS device.

Configuring UPS groups
To configure UPS groups using the UPS Configuration Tool:

1. Open the UPS Configuration Tool.

2. In the UPS Configuration Tool, click New and add each new UPS that you added in theMan-
agement Console.

3. (Optional) Change the value for theDisplay Name that appears in the Vista diagram if you
want.

NOTE: This Display Name appears only in the Vista diagram and does not impact the
name that you use in theManagement Console.
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4. After adding all new UPS devices, click theGroups tab.

5. Click New to create new groups for the UPS devices.

6. After you finish adding all UPSs and associated groups, click Apply.



Generating a Vista diagram
To generate a Vista diagram:

1. In the UPS Configuration Tool, click Generate Vista Diagrams.

TheVista Diagram Generation dialog appears.
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NOTE: TheOutput Path shows where the Vista diagram DGM file is saved after clicking
Generate Vista Diagrams. The file name or location can bemodified from the default
value if desired.

2. Click Include Custom Logo and then navigate to and select the file to include a custom logo
in your diagrams. Otherwise, a Schneider Electric logo appears.

3. UnderOptions, drag the indicator to define the width and dimensions of Vista diagrams you
generate.

4. Click Generate Vista Diagrams to generate the DGM files, then click Close.

Pasting UPS framework in VIP
To paste a UPS framework in VIP:

1. Open the Designer tool and open the VIP.<server_name>.node.

2. Drag aGrouping Object and open it. Make sure that the toolbox is available (Options > Show
toolbox).

3. Go to ...\config\fmwk\UPS\ and select Edit > Paste to paste the framework. Depending
on the number of UPSs and groups, youmay need to set up the framework. The default tem-
plate assumes the user has two groups with five UPSs in each group.

The following example shows an instance where the user has three groups with a different
UPS in each group:



4. Connect the inputs of each AND/OR module (UPS) to the critical operation and battery usage
status.

5. Repeat this step for each UPS in the group and for all UPSs in the other groups.
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6. Save the framework after you finishmodifying the framework based on your UPS system.

Setting up Vista Diagram status
1. Browse to ...\config\diagrams\ud\UPS\UpsGroups.dgm.

2. Link the status object from the framework that you pasted in VIP in the previous steps.

3. Repeat step 2 for all other groups. Your UPS Monitoring system is now setup.

NOTE: Any UPS in the groups that require attention show a red indicator.

Running a report
After you finish configuring all UPSs, you can run a report by selecting a group.

Uninterruptible Power Supply (UPS) Auto Test Report
TheUPS Auto Test Report shows the test solution and provides a Vista diagram tomonitor the
MGE5500 series UPS.

For more information on generating andmanaging reports, see the "Reports" section of theWeb
Applications help file.



Uninterruptible Power Supply (UPS) Battery Health
Report

TheUPS Battery Health Report is designed to show information related to the health of the battery
for a UPS device. The UPS devices intended for use with this report are UPS devices that do not
have an auto-test capability.

Supported Devices
The only devices supported by UPS Battery Health are as follows:

l ION7550 / ION7650

The UPS Battery Health system contains several components that provide the customer with
information about the generator battery bank. Specifically, themonitor shows the customer the
starting voltage signature when the UPS comes online, which indicates the battery bank’s voltage
drop and recovery at that time.

The following tasks must be completed to set up the UPS Battery Health system:

l Install and configure the ION 7550 / ION7650meter to the battery bank to bemonitored. Refer
to thePowerLogic ION7550 / ION7650 Installation Guide andPowerLogic ION7550 / ION7650
User Guide for more information. Obtain the latest version of these documents from
www.schneider-electric.com.
Note the following:

l V1 - V3 voltage inputs must have PTs to isolate the ground from the system beingmonitored
and the battery.

l Connect V4 to the positive side of the battery. Input impedance of V4 terminal is 5Mohm
(phase - Vref). For themost up to date specification, contact the local representative.

l Connect Vref to battery ground.

l Fusingmust be installed according to themeter installation instructions.

l Perform visual inspection of connections to ensure there is physical separation between the
system connected to V1, V2 and V3, and the battery connected to V4.

l For other wiring options with PTs, see thePowerLogic ION7650 Installation Guide.

DANGER
EQUIPMENT ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

Treat the battery circuit as energized to the category of the installation.

Failure to follow these instructions will result in death or serious injury.

Refer to the following diagram as an example for connections to themeter.
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l Configure the UPS Battery Health Framework to capture the battery voltage signature or wave-
form and deploy the framework to themeter. See the next section for instructions.

l Configure the UPS Battery Health Report to display the graph of the voltage signature. The cus-
tomer can use the report to help understand the battery bank condition.

This section provides instructions for configuring the framework to capture the voltage signature.

Configuring the UPS Battery Health Framework
The UPS Battery Health Framework is designed to capture and record a UPS’s battery voltage
signature at start up. This voltage signature provides some indication of the health of the UPS’s
battery bank. A typical waveform capture of the voltage drop when the UPS comes online is shown
below:



Note the following items about this example:

l This capture shows about 4 - 5 seconds' worth of data, accomplished via one (1) waveform
recorder configured at a resolution of 512 x 4.

l The voltage does not immediately recover to its original value but it begins to ramp up.

l There is about 0.5 seconds of data before the voltage drop to approximately 20 V.

Two options in the framework are possible to capture the waveform, based on how the crank relay
signal is triggered - pulse or KYZ.

Example Framework
The types of module used are:

l Data Acquisition

l Digital Input

l Convert

l OneShot Timer

l Waveform Recorder

See the following descriptions for the way eachmodule works in this framework.

Refer to ION Reference for details on how eachmodule operates and for settingmodule
parameters.

Data Acquisition – Data Acqn 1

The V4 signal from themeter goes to the Data Acquisitionmodule.

One-Shot Timer
To prevent triggering the downstream logic twice, send the state from the Convert module into the
One Shot Timer:

Send the output register into the first Waveform Recorder G1 Battery 1.

First Waveform Recorder – G1 Battery 1
The Data Acquisitionmodule is the input to the first Waveform Recorder, labeled “G1 Battery 1.”
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These are the setup registers for themodule:

Note the following about the setup registers:

l Depthmust be non-zero – 100 hundred is a good number.

l RecordMode should be Circular.

l Format should 16x96. This means 16 samples per cycle and 96 cycles, so at 60 Hz this results
in approximately 1.6 seconds' worth of data.

l Record Delay Cycles is set to 95 to allow the “window of observation” to move so that only
post-event data is captured. Refer to ION Reference for more details.

Configure and generate the UPS Battery Health Report
Use the Reports module inWeb Applications to configure and produce the UPS Battery Health
Report.

For more information on generating andmanaging reports, see the "Reports" section of theWeb
Applications help file.



UPS Battery Health Report example
In this example, the starting voltage waveform (blue) is similar to the reference waveform (red). The
drop to near 51 volts DC is the point at which the generator started. After the start, battery voltage
rises to normal state of charge.

The first section shows a summary table of the reference and comparison waveforms. It shows the
timestamp for the waveform that corresponds to the recorder timestamp of the waveform, and if the
drop or recovery are found.

The next section shows a chart that shows the reference and comparison waveforms in a stacked
view. If a voltage drop is found in both waveforms, then those waveforms are time aligned based on
their voltage drop minimum values. If a drop is not found in both waveforms, then those
waveforms are time aligned based on their absolute minimum values.

The chart shows a gray band around the Analysis Section that represents the section of the
waveform where the voltage drop and recovery voltage samples are found.

This section shows a chart with details of the waveform analysis. Following the analysis table, a
chart shows a stacked view of the reference and comparison waveform voltage drops. The chart
also shows a red horizontal band that represents the area that is under the voltage threshold.
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Telvent Weather Data Import Service
The Telvent Weather Data Import Service allows you to import current weather data from the
Telvent weather source you specify into PowerMonitoring Expert in order to forecast weather
conditions and to correlate weather-related conditions to energy consumption. The Telvent Weather
Data Import Service device driver can import real-time and historical data into PowerMonitoring
Expert.

NOTE: The Telvent Weather Data Import Service requires an active Telvent subscription
account.

Configuring the data import service
To use the Telvent Weather Data Import Service, youmust first configure it using theModbus
Service Configuration Tool and theManagement Console.

Run the Modbus Service Configuration Tool
1. InWindows > Explorer, navigate to the system\bin folder and then double-click Mod-

busServiceConfigurationTool.exe to run it. TheModbus Service Configuration Tool dia-
log appears.

2. Click Add. TheAdd Service Window dialog appears.

3. From theAvailable Services dropdown list, select Telvent Weather Service.

4. ForUnit ID, enter "1" and then click Configure. The Telvent Weather Service Con-
figuration dialog appears.
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5. Complete the fields as follows:

l Telvent User Name field: Enter your Telvent subscription user name.

l Telvent Password field: Enter your Telvent subscription password.

l For location, choose and complete the fields for one of the following:

l GPS Location: Enter values for Latitude and Longitude.

l Station ID: Enter a specific Weather Station ID.

l Postal Address: Enter a postal address (ZIP or postal code).

l From the dropdown lists, select the unit measurements you want. ForDegree Day, enter
what the Telvent weather service provides as units.

6. Click OK. Telvent Weather Service now appears in the list underService Name in theMod-
bus Service Configuration Tool dialog and begins collecting data immediately.

7. Click OK, and then click Yes to restart theModbus Software Gateway Service.



Configure the Management Console
1. From the desktop, navigate to the ...\Power Monitoring Expert folder and double-click Man-

agement Console, enter your user name and password, and click OK. TheManagement
Console dialog appears.

2. In the left pane, click Sites.

3. Right-click on the dialog and chooseNew > Ethernet Gateway Site.

TheEthernet Gateway Site Configuration dialog appears.
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4. Complete the fields as follows:

l Name field: Enter a name for the site, such as SoftwareGatewayService.

l TCP/IP Address field: Enter the local IP address or the server namewhere PowerMon-
itoring Expert is installed.

l TCP/IP Port field: Enter port 502.

5. Click OK.

6. In the left pane, click Devices.

7. Right-click on the dialog and chooseNew > Serial Device on Ethernet Gateway Site.

TheSerial Device Configuration dialog appears.



8. Complete the fields as follows:

l Group field: Select a group for the device, such as MAIN.

l Name field: Enter a name for the device, such as Telvent.

l Device Type field: Select Telvent Weather Service.

l Unit ID field: Enter "1".

l Site field: Select Software Gateway Service.

l Enabled field: ChooseYes.

l Description field: Enter a description of the device if you want.

9. Click OK. The new device now appears in the list of devices. The Telvent Weather Data
Import Service is now configured.

Verifying the service is active
After configuring the Telvent Weather Data Import Service, you can verify that the service is active
in Vista.

1. Select the site you configured, such as SoftwareGatewayService.

2. From the desktop, navigate to the ...\Power Monitoring Expert folder and double-click Vista.

3. Log in with your username and password, and then click OK. TheVista dialog appears.

4. Choose File > New to create a new diagram.

5. Drag a Numberic Object from the toolbar onto the diagram.
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6. Right-click on the object and then click the Link tab.

7. Select Custom and click Edit Link.

8. In theCreate Link dialog, select the device you configured, suchWeather.Telvent, and click
OK.

9. Make selections forManagers,Modules, andOutput Registers, and then click OK.

10. Open the Vista diagram and verify that the service is logging observedmeasurements.

NOTE: All observedmeasurements are logged and all observedmeasurements are read in
real time. Hourly observedmeasurements are logged every half-hour, and all daily
observedmeasurements are logged every 12 hours.



AccuSine® Power Correction System (PCS) device
The AccuSine Power Correction System device is used to help reducemaintenance and wear on an
electrical system and to improve Power Quality. Adding a AccuSine Power Correction System
device to your PowerMonitoring Expert system allows youmonitor and correct the harmonics of the
power for your buildings.

Configuring the AccuSine PCS device
To use the AccuSine Power Correction System, youmust first configure it using theManagement
Console.

To configure the AccuSine PCS device:

1. Navigate to and double-click Management Console. TheManagement Console dialog
appears.

2. In the left pane, click Devices.

3. Right-click on the dialog and chooseNew > Ethernet Device.

TheEthernet Device Configuration dialog appears.
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4. Complete the fields as follows:

l Group field: Select a group for the device, such as Correction.

l Name field: Enter a name for the device, such as AccuSine.

l Device Type field: Select AccuSine_PCS.

l TCP/IP Address field: Enter your server IP Address.

l Computer field: Enter the name of your server.

l Enabled field: Select Yes.

l Description field: Enter a description of the device if you want.

5. Click OK. The new device now appears in the list of devices. The AccuSine Power Correction
System is now configured.

Verifying the device is active
After the AccuSine Power Correction System is configured, verify that the device is active.

1. InVista, generate the network diagram.

2. Open the network diagram.

3. Click on each tab to verify that harmonic measurement data appears in each.

NOTE: Allow a few moments for measurement data to appear and refresh on the tabs.



4. After you verify that themonitoring and correction is active, close the diagram.
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Reference

ION power meter configuration
This section describes how to complete the following tasks:

l Add ION powermeters to the PowerMonitoring Expert 8.2 solution.

l Deploy a custom framework on an ION powermeter using the Designer application of Power
Monitoring Expert 8.2 solution.

l Configure the framework with site-specific information.

Experience using ION Setup, Designer, and other software is necessary to configure ION power
meters. Successful completion of these tasks ensures that:

l The operational states on the Active Transfer Switches (ATS) and generators are associated
with the digital inputs on the ION powermeters, and that the digital inputs are appropriately
labeled and logged in the ION_Data database.

NOTE: ATS do not need to be configured for the Generator Performance softwaremodule,
only for EPSS.

l The engine data for the generators is associated with the analog inputs on the ION power
meters, and that the analog inputs are appropriately labeled and logged in the ION_Data data-
base.

l The electrical details for the generators are logged and saved in the ION_Data database.

WARNING
UNINTENDED OPERATION

• Do not use ION meters for critical control or protection applications where human or
equipment safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Refer to the ION Reference for more information on ION module operation.

Supported ION power meters
All PowerMonitoring Expert solutions can use the following ION powermeters:

l PM8000, ION7550 and ION7650 for ATSs only, generators only, or for generators and ATSs
combined

l ION7550 RTU for ATSs only



Related Information

For information about adding ION powermeters to PowerMonitoring Expert, see theManagement
Console online help or the PowerMonitoring Expert 8.2 Help.

For details about configuring Analog or Digital Input modules, refer to ION Reference.

Maintenance and backups
As a good practice, always save a backup of the final framework that is pasted onto themeter. Use
Designer to create a copy of the framework from themeter. Save the framework to a location from
where the framework can be pasted back to themeter if necessary.

NOTE: Be sure to save a backup of themeter's framework before deploying and configuring the
EPSS frameworks.

If a meter needs to be replaced, use the backup copy of the ION meter framework for the new ION
meter. For all other installation and configuration steps, youmust follow the original commissioning
steps as described in the following sections.

Refer to existing PowerMonitoring Expert 8.2 documentation for instructions to backupmeter
frameworks.

Prerequisites
The following items must be completed before attempting to configure ION powermeters to record
data from generators, automatic transfer switches (ATS) and other equipment.

l The PowerMonitoring Expert solutionmust be installed and operational.

l All ION powermeters must be installed and communicating.

l ION powermeters selected tomonitor each ATS devicemust have the following available
data recorders and inputs:

l One available data recorder

l At least three available digital inputs (site specific)

l ION powermeters selected tomonitor each generator devicemust have the following avail-
able data recorders and inputs:

l Three available digital inputs (site specific)

l Two available data recorders

l See "Additional Information about Digital and Analog Inputs" on page 224 for more information.

l Each ATS should be physically wired to the appropriate ION powermeters so that the following
status signals are represented:

l Normal

l Emergency

l Test

l Power Outage (optional)
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l Each generator should be physically wired to the appropriate ION powermeters so that the fol-
lowing status signals are represented:

l Start (optional)

l Emergency Power Source Available (optional)

l Run

l Stop

l The following generator electrical datamust bemetered and available for each generator:

l Vln a

l Vln b

l Vln c

l Vln avg

l Vll ab

l Vll bc

l Vll ca

l VII avg

l I a

l I b

l I c

l I avg

l kW tot

l kVA tot

l PF sign tot

l Freq

Additional Information about Digital and Analog Inputs
Digital Inputs
Meters used tomonitor generators and other equipment must have enough available digital inputs to
handle the incoming status signals. The number of required digital inputs depends on how many
signals are available and whether they are single state or dual state signals.

Example of single state signals, where signalA represents GEN Running

l When signalA = 1, GEN Running is TRUE

l When signalA = 0, GEN Running is FALSE

Example of dual state signals, where signalA represents GEN Running andGEN Stopped

l When signalA = 1, GEN Running is TRUE

l When signalA = 0, GEN Stopped is TRUE

Analog Inputs
Meters used tomonitor generators must have available analog inputs to handle the incoming
generator-specific analog data. The number of required analog inputs depends on how many
measurements are being recorded. For example, analog data can include the following:

l Exhaust Gas Temperature left and right

l Engine Coolant Temperature in and out.

l Engine Oil Pressure

NOTE: Generator analog signals can be obtained through the analog inputs or via Modbus
Master from the engine controller. Refer to thePowerLogic ION7550/7650 User Guide for more
information.



Adding ION devices
Follow these steps to add ION powermeters to your system configuration.

NOTE: Complete these steps to prevent any unwanted database actions whenmodifying the
meter framework.

1. Stop the Log Inserter Service, as follows:

a. Open theWindows Services panel by clicking:

Start > Administrative Tools > Services

The path toServicesmay vary depending on theWindows operating system being used.

b. Right-click ION Log Inserter Service and select Stop.

2. Open theManagement Console.

3. Use the Device window inManagement Console to add each ION meter.

The Device window includes Group andName fields. Group is the name under which you
want to associate the device you are adding. Name identifies themeter that you are adding.
Themeter name should include a reference to identify which ATS or generator is connected to
themeter.

When ameter is added, it appears in the list of devices in group.name format. For example,
if you named the group EPSS, and identified themeter as ATS1, the name in the device list is
EPSS.ATS1. Similarly, if you used the same group to add ameter identified as GEN1, the
name in the device list is EPSS.GEN1. See theStruxureWare PowerMonitoring Expert 8.2
User Guide or online help for information about adding ameter.

After the powermeter is added, configure the appropriate frameworks as described in "ATS
frameworks for EPSS deployment" on page 225 and "Generator frameworks deployment" on page
235.

ATS frameworks for EPSS deployment
UseDesigner to copy and paste the ATS framework to your ION meter. Repeat this process for
every powermeter in your system that records ATS data for EPSS purposes.

Pasting ATS frameworks
Before you deploy ATS frameworks, you need to be aware of the implications of free pasting and
lock pastingmodules.

Use free pasting to paste a new module with a different name if a module with the same name
already exists. This helps to ensure that existingmodules and their functionality are not replaced.

Use lock pasting to overwrite an existingmodule and its functionality with a new module, while
retaining themodule name. However, you need to understand what themodules are currently being
used for before you lock paste themodules. A lock paste replaces the functionality of those
modules.

l If a powermeter already uses all modules of a certain type that are a necessary part of the
framework, then a lock paste operation is required.
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l If all available digital or analog input modules are in use, a lock paste of the analog or digital
input modules is required to help ensure that the parameter settings are updated

Copying the ATS framework to the ION power meter
UseDesigner to copy and paste the ATS framework to the powermeter. Repeat this process for
every powermeter in the system that records ATS data for the EPSS.

To copy the ATS framework and paste it to the powermeter.

1. InManagement Console click Tools > System > Designer. The Designer login window
appears.

2. Enter the login credentials with administrator or supervisor access and click OK.

3. Click File > Open, select the powermeter that has the ATS connected to it, and then click OK
to open themeter’s framework.

4. Navigate toAdvanced Setup and double-click the Frameworks folder to open it.



5. Make sure that the Toolbox is open. Select Options > Show Toolbox if it is not open.

6. Select Edit > Paste from framework. ThePaste from frameworkwindow appears, from
which you paste the framework to the Frameworks – ION Advanced Configuration folder.

7. Navigate to C:\Program Files (x86)\Schneider Electric\Power Monitoring

Expert for Healthcare\config\fmwk\EPSS, select the EPSS ATS framework .fwn
file, and click Open.
For example, in the following image the EPSS ATS framework file is EPSS ATS.fwn.

8. Press SHIFT and left-click to lock paste all Digital Input modules listed in thePaste Summary
dialog, and free paste all of the remainingmodules.

NOTE: The lock paste overwrites amodule if it already exists on themeter. For more
information, see "ATS frameworks for EPSS deployment" on page 225.
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9. Do not selectMaintain external inputs.

10. Press OK to paste the EPSS ATS framework.



Configuring ATS frameworks
After the ATS framework has been pasted, configure the ATS framework with site-specific data.

To configure the ATS frameworks:

1. Double-click the framework folderEPSS ATS to open its node diagram.

The nodes of the ATS framework, as shown next, support the three single state status signals:
Normal, Emergency, and Test. These status signals are received by their respective digital
input modules ATS1Normal, ATS1 Emergency, and ATS1 Test.

The names of the digital input modules are examples to identify how the label the components
in the framework. You can rename them tomatch the system being deployed. For example,
ATS1 could be just ATS. The remaining steps use these label names to illustrate the updates
made to the framework.

2. Right-click a Digital Input module to access its registers. The ION Module Setup screen
appears.
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The following image shows the registers for the digital input module ATS1Normal. The ATS
controller hardware that this module interfaces with governs how Input Mode, Polarity, and
Debounce should be configured.

3. To update a register, select the register and click Modify. TheModify Registers screen
appears.

4. Change the values to the site-specific sources and quantities. Click OK to return to the node
diagram. For example:

5. The Setup Register Input Mode is set to KYZ, which forces a pulse output on both leading and
trailing edges of the signal. This causes the data recorder to record the state on each transition
of the signal.

6. TheOutput Register label EPSS_Norm is the name associated with the signal received by the
digital input module ATS1Normal. Themaximum number of characters for the label is 15.
Examples of Output Register labels for digital input modules ATS1 Emergency and ATS1 Test
are EPSS_Emerg and EPSS_Test, respectively.

Make sure that Output Register labels are consistently labeled across the entire system. For
example, if you plan to represent the ATS Normal state as EPSS_Norm, then you need to use
the same label for all ATSs.

For systems that use a single meter to record EPSS status measurements for multiple
EPSS devices, the Output Register naming convention for digital input modules must be
modified from quantity to quantity@source.

For example, change EPSS_Test to EPSS_Test@ATSxx where xx uniquely identifies the
ATS device.

The quantity@source format allows the data it represents to be uniquely identified.



NOTE: The quantities remain the same (EPSS_Test, EPSS_Emerg, EPSS_Norm) but the
source name is now unique (ATSxx). If this change is not made, data for all ATSs or
generators recorded on themeter cannot be uniquely identified.

7. Right-click the Data Recorder module to access its setup registers.

8. Set theDepth setup register to at least a value of 100 to help ensure that data is recorded.

9. Select Use Custom Label and add a label that clearly identifies the data recorder within the
framework.

10. When you have completed all necessary site-specific modifications, click File > Send &
Save from the node diagram to write your changes to the ION meter.

Refer to the ION Reference for more information about configuring setup registers.

11. Restart the Log Inserter Service after you configure the framework.

You can configure the EPSS ATS framework to remotely switch the ATS into test mode, as
described next.

NOTE: (Optional) If you have a power outage signal, feed it into the abovemodule with the
EPSS Normal Emergency and Test.

Configuring remote ATS test for ION7550/7650 power meters
Switching an ATS to test mode remotely is done by linking a control object in a Vista diagram to a
digital output on the ION7550/7650meter that is connected to the ATS controller.

Refer toStruxureWare PowerMonitoring Expert 8.2 User Guide for more instructions on working
with Vista diagram control objects.

For details about configuringmodules, refer to ION Reference.
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NOTE: The EPSS or ATS framework must be deployed to themeter and configured before you
can set up the framework for ATS remote switching. For instructions, refer to "ATS frameworks
for EPSS deployment" on page 225.

Configuring the digital output
To configure the digital output for the ION7550/7650 powermeter:

1. Open Designer and login as a supervisor.

2. Connect to themeter.

3. In themeter framework, open the EPSS ATS folder.

4. From the Toolbox drag and drop an External Booleanmodule into the EPSS folder.

5. Locate the Digital Output folder and drag in a Digital Output module.

You can also use CTRL-SHIFT left click to drag in a shortcut to the Digital Output module.

The folder should resemble the following example:

6. Configure the External Boolean Setup Registers as shown next:

7. Connect the ATSTestSwitch output to the Source input of the Digital Output module, as
shown next.



8. Configure the Digital Output module as shown next:

Note the following details for themodule setup:

l Polarity - Set this to "Non-Inverting"

l Pulse Width - Set this to "0"

l Port - Set this to the physical port on themeter that is connected to the ATS. In this case,
DO1.

l Use Custom Label - Enter a name easy to recognize, such as "ATSTestOutput."

9. Click theSend and Save icon.

Configure the Vista diagram for themeter, as described next.

Configuring the Vista diagram
Follow these steps for the ION7550/7650 powermeter. Make sure Designer is closed before linking
any objects in Vista.

1. Login to Vista as a supervisor and open a new diagram.

2. From the Toolbox, drag a Control object onto the diagram.
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3. Right-click on the Control object. The Control Object Configuration screen appears.

4. Use a custom label, such as "ATSTestSwitch."

5. Configure the link to the External Booleanmodule's Switch output register, as shown next.

6. Click OK.

7. Right-click the ATSTestSwitch object. The Control Object Configuration screen appears.



8. On theAction tab, set the Level to Operate field to "Controller" as shown next.

9. Click OK.

10. Close the Toolbox.

11. Restart the ION Log Inserter Service after you configure the framework.

Now you can control the ATS by clicking the switch.

Generator frameworks deployment
UseDesigner to copy and paste the generator framework to the powermeter. Repeat this process
for every powermeter in the system that records generator data. The generator framework is
designed to capture generator status changes when they occur, and then to log generator-specific
field data when the generator is active.

This framework is a template that should be adjusted tomeet the requirements of your site. GEN
Start or GEN Run can be used to initiate logging, and the frequency can be adjusted in the periodic
timer.

l The status signals for status events GEN Start, GEN Run, andGEN Stop are recorded in the
Gen State Log whenever any one of them changes state.
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l The logic is designed to record analog and general electrical data when the generator is running.
The data is logged at oneminute intervals.

l The external BooleanGen Log Enmust be linked to a control object in a Vista diagram and
enabled before any data is logged. This allows users to notify the system that they are running a
test and to log data accordingly.

Pasting Generator Frameworks
Before you deploy generator frameworks, you need to be aware of the implications of free pasting
and lock pastingmodules.

Use free pasting to paste a new module with a different name if a module with the same name
already exists. This helps to ensure that existingmodules and their functionality are not replaced.

Use lock pasting to overwrite an existingmodule and its functionality with a new module, while
retaining themodule name. However, you need to understand what themodules are currently being
used for before you lock paste themodules. A lock paste replaces the functionality of those
modules.

l If a powermeter already uses all modules of a certain type that are a necessary part of the
framework, then a lock paste operation is required.

l If all available digital or analog input modules are in use, a lock paste of the analog or digital
input modules is required to help ensure that the parameter settings are updated

Copying the generator framework to ION power meters
UseDesigner to copy the generator framework to the powermeter. Repeat this process for every
powermeter in the system that records generator data.

1. InManagement Console click Tools > System > Designer. The Designer login window
appears.

2. Enter the login credentials with administrator or supervisor access and click OK.

3. Click File > Open, select the powermeter that has the generator connected to it, and then
click OK to open themeter’s framework.



4. Once themeter’s framework is open, navigate toAdvanced Setup and double-click the
Frameworks folder to open it.

5. Ensure that the Toolbox is open. Select Options > Show Toolbox, to open the Toolbox.

6. Select Edit > Paste from framework to open thePaste from frameworkwindow, from
which you paste the generator framework to the Frameworks – SPM Advanced Con-
figuration folder.
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7. Navigate to ...\product install location\config\fmwk\EPSS, select the gen-
erator framework .fwn file, and click Open.
For example, in the following image the generator framework file is EPSS GEN.fwn.

8. Press Shift and left-click to lock paste all Analog Input and Digital Input modules listed in the
Paste Summary dialog, and free paste all of the remainingmodules.

NOTE: The lock paste overwrites amodule if it already exists on themeter. For additional
information see "ATS frameworks for EPSS deployment" on page 225.



9. Do not selectMaintain external inputs.

10. Click OK to paste the generator framework.

Configuring the generator framework
Configure the generator framework with site-specific data. Refer to the ION Reference for more
information about configuring setup registers.

1. After the generator framework has been pasted, double-click the folderEPSS GEN to open its
node diagram.
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The nodes of the generator framework shown below support the three single state status
signals: GEN Start, GEN Run, andGEN Stop. These status signals are received by their
respective digital input modules GEN Start, GEN Run, andGEN Stop.

The names of the digital input modules are simply placeholders that are used as examples to
identify how the components in the framework should be labeled. You can rename them to
match the system being deployed. For example, GEN could beGEN1. The remaining
descriptions in this section use these example labels to illustrate the updates made to the
framework.

The framework also supports three analog signals. In the following image, these are Ex Gas L
(exhaust gas left), Ex Gas R (exhaust gas right), and Coolant T (coolant temperature), and
these signals are received by their respective analog input modules: Ex Gas L, Ex Gas R, and
Coolant T. Thesemodules are examples only and they can bemodified to any other
parameters that need to bemonitored and recorded.

A. Analog Input Modules

B. Digital Input Modules

2. Right-click a Digital Input module to access its setup registers. The following image shows the
registers for the digital input module GEN Start. The generator controller hardware that this



module interfaces with governs how it needs to be configured.

3. To update a register, select the register and click Modify. TheModify Registers screen
appears.

4. Change the values to the site-specific sources and quantities, and click OK to return to the
node diagram. For example:

l The Setup Register Input Mode is set to KYZ, which forces a pulse output on both leading
and trailing edges of the signal. This causes the data recorder to record the state on each
transition of the signal.

l TheOutput Register label EPSS_Start is the name associated with the signal received by
the digital input module GEN Start. Themaximum number of characters for the label is 15.
Examples of Output Register labels for digital input modules GEN Run andGEN Stop are
EPSS_Run and EPSS_Stop, respectively.

Make sure that Output Register labels are consistent across the entire system. For
example, if you plan to represent the GEN Start state as EPSS_Start, or the GEN Normal
state as EPSS_Norm, then you need to use the same label for all generators.

For systems that use a single meter to record EPSS status measurements for multiple
EPSS devices, the Output Register naming convention for digital input modules must be
modified from quantity to quantity@source.

For example, change EPSS_Test to EPSS_Test@GENxx where xx uniquely identifies the
generator device.

The quantity@source format allows the data it represents to be uniquely identified.

NOTE: The quantities remain the same (EPSS_Test, EPSS_Emerg, EPSS_Norm) but
the source name is now unique (GENxx). If this change is not made, data for all
generators recorded on themeter cannot be uniquely identified.
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5. Right-click an Analog Input module to access its registers. Shown below are the registers for
the analog input module Ex Gas L. The generator controller hardware that this module inter-
faces with governs how it needs to be configured.

l TheOutput Register label ExGasL is the name associated with the signal received by the
analog input module Ex Gas L. Themaximum number of characters for the label is 15.
Examples of Output Register labels for analog input modules Ex Gas R and Coolant T are
ExGasR and CoolTemp, respectively.

l Output Register labels should be consistent across the entire system. For example, if you
plan to represent Exhaust Gas Left as ExGasL then you need to use the same label for all
generators.

6. When you have completed all necessary site-specific modifications, click File > Send &
Save from the node diagram to write your changes to the powermeter.

7. Restart the ION Log Inserter Service after configuring the generator frameworks.

Non-ION power meter configuration
This section provides information about configuring non-ION powermeters for the PowerMonitoring
Expert 8.2 solution.



WARNING
UNINTENDED OPERATION

• Do not use the powermeters for critical control or protection applications where human or
equipment safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Refer to your meter's technical documentation for more information on its operation.

Supported non-ION power meters
PowerMonitoring Expert solutions can use the following non-ION powermeters for the EPSS:

l PM800 series powermeters. Refer to "PM800 series meter configuration" on page 244.

l PowerLogic Circuit Monitor Series 3000 and 4000 PowerMeters. Refer to "CM3000 and
CM4000 series meter configuration" on page 262.

Supported Sequence of Event Recorders
l SER-2408/SER-3200. Refer to "Adding the SER-2408/SER-3200 toManagement Console" on
page 281.

Prerequisites
The following prerequisites must be completed before attempting to configure a non-ION power
meter to record data from generators and other equipment:

l The PowerMonitoring Expert solution is installed and operational.

l All meters must be installed and communicating.

l The following status signals for each ATS are physically wired to the digital inputs on the appro-
priate meters.

l Normal

l Emergency

l Test

l Power Outage (optional)

l The following status signals for each generator are physically wired to the digital inputs on the
appropriate meters.

l Start (optional)

l Emergency Power Source Available (optional)

l Run

l Stop
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l The following generator electrical data aremetered and available for each generator:

l Currents: A, B, C, N, Avg

l Minimum Apparent Power Total

l Minimum Real Power Total

l Frequency

l Real Power Total

l Apparent Power Total

l Voltages: A-B, B-C, C-A, L-L Avg, A-N, B-N, C-N, L-N Avg

l The following signals for each generator are physically wired to the analog inputs on the appro-
priate meters. The number of analog inputs required depends on how many measurements are
being recorded. For example, analog data can include the following:

l Exhaust Gas Temperature left and right

l Engine Coolant Temperature in and out

l Engine Oil Pressure

PM800 series meter configuration
This chapter describes how to use PowerLogic™ ION Setup to configuremeters. This section does
not explain how to add powermeters to the system or how to use ION Setup.

l For information about addingmeters to the system, refer to theManagement Console online
help or theManagement Console section of theStruxureWare PowerMonitoring Expert 8.2
User Guide.

l For information about ION Setup software, refer to ION SetupOnline Help or thePowerLogic
ION Setup User Guide.

For more information about configuring the PM800 series meters using ION Setup software:

l Additional Device Support in ION Setup in the ION Setup online help

l PowerLogic ION Setup Device Configuration Guide

You can configure the PM800 series meter for switching the ATS into test mode remotely. See
"Configuring Auto-Enable data logs for CM4000 and PM800 series" on page 277 for
instructions.

Adding PM800 series meters to a site using ION Setup
Use ION Setup to add PM850 or PM870meters to the site.

1. In the devices area, right-click and select Insert Item. TheNew Network Item screen
appears.



2. SelectMeter and click OK. TheNew Device screen appears.

3. Select theGeneral tab

4. In the Type list, select PowerLogic PM800 Series Power Meter.

5. Select theDisplay tab. In the Template Options box, select the type of meter you are adding.

6. Click OK to add themeter.

7. In the Network Viewer (left pane), click themeter icon. The setup screens appear in the Con-
tent Viewer (right pane).

The following image shows a partial list of the setup screens. Use the I/O Setup, Onboard
Alarms/Events, andData Log setup screens to access the parameters that need to be configured.
The remaining topics in this chapter describe the parameter changes that are required.
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Formore information about adding PM850 or PM870meters to a site in ION Setup, refer to the
following:

l ION Setup online help

l PowerLogic ION Setup Device Configuration Guide, "PM800 series powermeter" section

l PowerLogic ION Setup User Guide, "Adding and Configuring Devices" section

Digital and analog input configuration
This section describes how to configure the digital and analog inputs for the PM800meters. The
instructions assume that you are using separate PM800 series powermeters to record data for
ATSs and generators.

WARNING
UNINTENDED OPERATION

• Do not use themeters for critical control or protection applications where human or equipment
safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Refer to your meter's technical documentation for more information on its operation.

Configuring digital inputs
1. In the Content Viewer, double-click I/O Setup to access the Digital Inputs for themeter.

2. Select the I/O point that you want to configure and click Edit.
The following image shows Digital In A-S1 selected.



3. Update the Label field with a name that ends with the $ character.
The $ character activates the translated device dynamic labeling feature. If the $ character is
not used, the default label is used.

l For an ATS, examples of labels that conform to the naming convention are EPSS_Test$,
EPSS_Emerg$, EPSS_Norm$, and EPSS_Util$.

l For a generator, examples of labels are EPSS_Start$, EPSS_Run$, and EPSS_Stop$.

4. SetMode to Normal, Pulse Weight to a non-zero value, for example 100, and leaveUnits set
as NoUnits.

5. Click OK to update the parameters and to close the dialog.

6. Repeat the steps above for each I/O point that you want to configure.

7. Click Send to save the changes and send the configuration to themeter.

Configuring analog inputs
PM800 series powermeter Analog Inputs are only available when you install the PM8M2222
Input/Output module on themeter.

Refer to thePowerMeter Input/Output Module PM8M2222, PM8M26, PM8M22 InstallationManual
for more information about installing the input/output module. Obtain this installationmanual at
www.powerlogic.com. Select the country, and thenEnergy and Power Quality Meters >
PowerLogic Multifunction Power Meters > PM800 Series > Downloads > Tech Publications.

To configure analog inputs:

1. In the Content Viewer, double-click I/O Setup to access the Analog Inputs for themeter.

2. Select the I/O point that you want to configure and click Edit.
The following image shows Analog In A-AI1 selected.
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3. Click Edit to open the parameter window for the I/O point and update the Label field with a
name that ends with the $ character.

For a generator, examples of labels for analog inputs are Exhaust Gas L$, Exhaust Gas
R$, and Coolant T$.

The following image shows the label updated to Exhaust Gas L$.

4. Click OK to update the parameters and to close the dialog.

5. Repeat the steps above for each I/O point that you want to configure.

6. Click Send to save the changes and send the configuration to themeter.



Onboard alarm and event configuration
For each digital input configured in I/O Setup, you need to configure the alarms to record when the
digital input on an ATS or a generator changes from OFF to ON, and from ON toOFF.

Configuring digital input alarms for ATSs
This section assumes that you configured digital inputs Digital In A-S1 as EPSS_Test$, Digital
In A-S2 as EPSS_Emerg$, andDigital In A-S3 as EPSS_Norm$. Youmust configure an alarm for
the digital input change from OFF to ON and from ON toOFF.

Digital input change from OFF to ON

To configure an alarm when a digital input changes from OFF to ON:

1. In the Content Viewer, double-click Onboard Alarms/Events to open theSetup dialog.

2. Select Digital and click Edit to open theDigital Alarm Setup dialog.

3. Select one of the Digital Input/Output points.

The following figure shows theDigital In A-S1 input selected and its label EPSS_Test$.

4. Select Status Input On from the list to set the alarm when the digital input changes from OFF
to ON.

5. Make sure that Enable is selected.
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6. In the Label field, change the digital alarm name from Digital In A-S1 to Test ON.

7. Set Priority to High(1), and select Data Log 1 as the data log to use. SelectWaveform Cap-
ture if you want to trigger a waveform capture on alarm.

When the status for EPSS_Test$ changes to ON, Data Log 1 records all channels currently
configured on it.

Digital input change from ON to OFF

To configure an alarm when a digital input for EPSS_Test$ changes from ON toOFF:

1. Click Add to add another digital input alarm parameter to the list in the left pane of theDigital
Alarm Setup dialog.

NOTE: If the 12 available digital input alarms have been configured, you need to re-
configure an existing alarm for the ON to OFF status change.

2. Select Status Input Off from the list to set the alarm when the digital input changes from ON
toOFF.

3. Select EPSS_Test$ from the list.



4. Make sure that Enable is selected.

5. In the Label field, change the digital alarm name to Test OFF.

6. Set Priority to High(1), and select Data Log 1 as the data log to use. SelectWaveform Cap-
ture if you want to trigger a waveform capture on alarm.

7. Repeat the steps above to configure alarms for digital input changes from OFF to ON and from
ON toOFF for all applicable I/O points.

The following table summarizes the configuration of the alarms, where the I/O points are
Digital In A-S1, Digital In A-S2, and Digital In A-S3:

Digital Input Label Maps to Alarm Status Alarm Name

EPSS_Test$ Digital In A-S1 Status Input On Test ON

EPSS_Test$ Digital In A-S1 Status Input Off Test OFF

EPSS_Emerg$ Digital In A-S2 Status Input On EmergON

EPSS_Emerg$ Digital In A-S2 Status Input Off EmergOFF

EPSS_Norm$ Digital In A-S3 Status Input On NormalON

EPSS_Norm$ Digital In A-S3 Status Input Off NormalOFF

8. Click OK to close the dialog.

9. Click Send to save the changes and send the configuration to themeter.

Configuring digital input alarms for generators
This section assumes that you configured digital inputs Digital In A-S1 as EPSS_Start$, Digital
In A-S2 as EPSS_Run$, andDigital In A-S3 as EPSS_Stop$. Youmust configure an alarm for
the digital input change from OFF to ON and from ON toOFF.

EPSS_Start$: Digital input change from OFF to ON

To configure an alarm when a digital input changes from OFF to ON:

1. In the Content Viewer, double-click Onboard Alarms/Events to open theSetup dialog.

2. Select Digital and click Edit to open theDigital Alarm Setup dialog.

3. Select one of the Digital Input/Output points.

The following figure shows theDigital In A-S1 input selected and its label EPSS_Start$
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4. Select Status Input On from the list to set the alarm when the digital input changes from OFF
to ON.

5. Make sure that Enable is selected.

6. In the Label field, change the digital alarm name from Digital In A-S1 toStart ON.

7. Set Priority to High(1), and select Data Log 1 as the data log to use. SelectWaveform Cap-
ture if you want to trigger a waveform capture on alarm.

When the status for EPSS_Start$ changes to ON, Data Log 1 records all channels currently
configured on it.

EPSS_Start$: Digital input change from ON to OFF

To configure an alarm when a digital input for EPSS_Start$ changes from ON toOFF:

1. Click Add to add another digital input alarm parameter to the list in the left pane of theDigital
Alarm Setup dialog.



NOTE: If the 12 available digital input alarms have been configured, you need to re-
configure an existing alarm for the ON to OFF status change.

2. Select Status Input Off from the list to set the alarm when the digital input changes from ON
toOFF.

3. Select EPSS_Start$ from the list.

4. Make sure that Enable is selected.

5. In the Label field, change the digital alarm name toStart OFF.

6. Set Priority to High(1), and select Data Log 1 as the data log to use. SelectWaveform Cap-
ture if you want to trigger a waveform capture on alarm.

7. Repeat the steps above to configure alarms for digital input changes from OFF to ON and from
ON toOFF for all applicable I/O points.

The following table summarizes the configuration of the alarms, where the I/O points are
Digital In A-S1, Digital In A-S2, and Digital In A-S3:

Digital Input Label Maps to Alarm Status Alarm Name

EPSS_Start$ Digital In A-S1 Status Input On Start ON

EPSS_Start$ Digital In A-S1 Status Input Off Start OFF

EPSS_Run$ Digital In A-S2 Status Input On RunON

EPSS_Run$ Digital In A-S2 Status Input Off RunOFF

EPSS_Stop$ Digital In A-S3 Status Input On StopON

EPSS_Stop$ Digital In A-S3 Status Input Off StopOFF

8. Click OK to close the dialog.

9. Click Send to save the changes and send the configuration to themeter.
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Define a Digital Alarm for a Single Digital Input

If a single digital input is used to record signals indicating when the generator is running, and when
the generator has stopped, you need to define the digital alarm as follows:

1. In theDigital Alarm Setup dialog, select the Digital Input/Output point that will be used to
record the alarm. For example, if you configuredDigital In A-S1with a label of EPSS_Run$,
select this I/O point.

2. Select Status Input On from the list to set the alarm when the digital input changes from OFF
to ON.

3. Make sure that Enable is selected.

4. In the Label field, change the digital alarm name from Digital In A-S1 toRun ON.

5. Set Priority to High(1), and select Data Log 1 as the data log to use.

EPSS_Run$: Digital input change from ON to OFF

1. Click Add to add another digital input alarm parameter to the list in the left pane of theDigital
Alarm Setup dialog.

2. Select Status Input Off from the list to set the alarm when the digital input changes from ON
toOFF.

3. Select EPSS_Run$ from the list.

4. Make sure that Enable is selected.

5. In the Label field, change the digital alarm name toStop ON.

6. Set Priority to High(1), and select Data Log 1 as the data log to use.

7. Click OK to close the dialog.

8. Click Send to save the changes and send the configuration to themeter.

Because of this alarm configuration where EPSS_Run$ represents both the Running and Stopped
states for the generator, whenRun ON is TRUE, the signal is recorded as "1", and whenStop ON
is TRUE, the signal is recorded as "0".

Data log parameter definition
This section explains how to define data log parameters for the digital inputs, analog inputs, and
load profile data. The instructions assume that you use Data Logs 1 and 2. However, you can use
any Data Log that meets your requirements.

Defining data log parameters for digital inputs
To define the data log parameters for the digital inputs:

1. In the Content Viewer, double-click Data Log #1 to open theSetup dialog for the data log para-
meters.

2. Set Status to Enable and Interval to Only On Event. TheOnly On Event mode appears as 0 in
the Interval field of theSetup dialog.



3. Select Channels, click Edit. The Parameter Selection dialog appears.

4. In theAvailable box, navigate to Inputs/Outputs and select a custom label, such as EPSS_
Emerg$.

5. Select the IO Point xx Digital State, where xx is the number of the I/O point present on the
meter. Click >> to move the parameter to theSelected box.

6. Repeat steps 4 - 5 for all I/O points available for the ATS or generator.

7. In theAvailable box, expandMiscellaneous and select Present MilliSeconds. Click >> to
move it to theSelected column.

NOTE: Add all I/O points for a given ATS or generator to the data log to help ensure that all
states are recorded in the data log when any state changes.

8. Click OK to close the dialog.

9. Click Send to save the changes and send the configuration to themeter.
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Defining data log parameters for analog inputs and load profile data
Configure the system to log the analog inputs and load profile data automatically when the generator
state changes to Running. When the generator state is Running, the alarm status for digital input
EPSS_Run$ is ON.

Using ION Setup, the process to configure automatic logging is:

1. Associate Data Log 2 with the digital input alarm Run ON that you previously defined for
EPSS_Run$.

2. Select the parameters for the Analog Input data to be logged in Data Log 2.

3. Select the parameters for the Load Profile data to be logged in Data Log 2.

4. Set the status of Data Log 2 to Auto-Enable.

These steps assume that you use Data Log 2.

Associate Data Log 2 with the Digital Input Alarm Run ON

1. In the Content Viewer, double-click Onboard Alarms/Events to open theSetup dialog.

2. Select Digital and click Edit to open theDigital Alarm Setup dialog.

3. Select the digital input alarm Run ON that was defined for I/O point EPSS_Run$. You pre-
viously selected Data Log 1 when you configured this digital input alarm for the generator.

4. In theData Logs: group, select 2. Now both 1 and 2 are selected.

5. Click OK to close the dialog.

6. Click Send to save the changes and send the configuration to themeter.



Select Parameters for Analog Input Data to be logged in Data Log 2

1. In the Content Viewer, double-click Data Log #2 to open theSetup dialog for the data log para-
meters.

2. Select Interval and click Edit to open theEnter Logging Interval dialog. Select Continuous
from the list inMode, set Interval to 1minute, and click OK to close the dialog.

3. Select Channels, click Edit. The Parameter Selection dialog appears.

4. In theAvailable box, navigate to Inputs/Outputs and select a custom label, such as
Exhaust Gas L$.

5. UnderAnalog Input, select the IO Point xx Analog Input Value, where xx is the number of
the I/O point present on themeter. Click >> to move the parameter to theSelected box.

6. Repeat steps 4 - 5 for each analog input available for the generator.
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7. Click OK to close the dialog.

8. Click Send to save the changes and send the configuration to themeter.

Select Parameters for Load Profile Data to be logged in Data Log 2

1. In theSetup dialog for Data Log 2, select Channels and click Edit. TheParameter Selection
dialog appears.

2. Expand each of the following categories. Within each category select the parameters indic-
ated. For each parameter click >> to move it to theSelected column:

a. InCurrents, select Current A, Current B, Current C, Current N, and Current Avg.

b. InMinimum Readings, select Min Apparent Power Total, Min Real Power Total.

c. InMiscellaneous, select Frequency.

d. InPowers, select Real Power Total and Apparent Power Total.

e. InVoltages, select Voltage A-B, Voltage B-C, Voltage C-A, Voltage L-L Avg, Voltage A-N,
Voltage B-N, Voltage C-N, and Voltage L-N Avg.

3. Click OK to close the dialog.

4. Click Send to save the changes and send the configuration to themeter.

Set the Status of Data Log 2 to Auto-Enable

Auto-Enable is a special mode that allows logging to be triggered when an alarm occurs. Data is
recorded in the data log at a defined interval if the loggingmode is set toContinuous. Logging stops
when the alarm ends.

1. In theSetup dialog for Data Log 2, select Status and click Edit. TheSelect Status dialog
appears.



2. In the drop-down list, select Auto-Enable and click OK to close the dialog.

3. Click Send to save the changes and send the configuration to themeter.

You can also use Vista to set a Data Log to Auto-Enable. Refer to "Use Vista to set a data log to
Auto-Enable" on page 277 for more information.

Configuring remote ATS test mode for PM800 series meter
Switching an ATS to test mode remotely is done by linking a control object in a Vista diagram to a
digital output on the PM800 series meter that is connected to the ATS controller.

Refer toStruxureWare PowerMonitoring Expert 8.2 User Guide for more instructions on working
with Vista diagram control objects.

For details about configuringmodules, refer to ION Reference.
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Configuring the digital output
Configure the onboard KY output for themeter as follows:

1. In ION Setup for themeter, click I/O Setup. TheGateway Site screen appears.

2. In theParameters box, select Digital Out KY and click Edit.

3. In theMode field, select Normal.
Themode is dependent on the characteristics of the digital input port on the ATS controller.

4. In theControl field, select Externally Controlled.
This allows themeter to accept external commands from an application like Vista.

5. Click OK. TheGateway Site screen appears.

6. Select Send to update themeter.

Configure the Vista Diagram for themeter, as described next.

Configuring the Vista diagram
Follow these steps for the PM800 powermeter. Make sure Designer is closed before linking any
objects in Vista.



In Vista, open a new diagram and complete the setup as follows:

1. Open a new diagram in Vista.

2. Drag a Control object from the Toolbox and link it to KY Energize, as shown next.

3. Right-click the Control object.

4. On theAction tab, set the Level to Operate field to Controller, and click OK.

5. Drag another Control object from the Toolbox and link it to KY DeEnergize.

6. Right-click the Control object.

7. On theAction tab, set the Level to Operate field to Controller, and click OK.

8. Drag a Status object and link it to the Standard KY Digital Output Status, as shown next.
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9. Save the diagram. The following image is an example of the Vista diagram.

You can now use the diagram to control and view the state of the onboard digital output port.

CM3000 and CM4000 series meter configuration
This section describes how to configure CM3000 and CM4000 series meters for the system.

To obtain theCM3000 InstallationManual, CM3000 ReferenceManual, and related instructions, go
to www.powerlogic.com and search for "CM3000 installation."

To obtain instructions for installing and configuring CM4000 series meters, go to
www.powerlogic.com. Select the country, and thenEnergy and Power Quality Meters >
PowerLogic Energy and Power Quality Meters > CM4000 > Downloads > Tech Publications.

l InstallationManual

l ReferenceManual

l Series 4000T ReferenceManual

l I/O Extender and Input/Output Option Card

You can configure the CM4000 series meter for switching the ATS into test mode remotely.
See "Configuring Auto-Enable data logs for CM4000 and PM800 series" on page 277 for
instructions.

Add CM4000 Series Meters to a Site in ION Setup
Complete the following steps to add CM4000 series meters to a site in ION Setup.

1. In the Network Viewer, right-click the workstation icon and select Insert Item > Site. The
New Site dialog appears.

2. Add a name to identify the site, select Ethernet, and click OK. The new site appears in the Net-
work Viewer.

3. In the Network Viewer, right-click the new site name and select Insert Item > Meter. TheNew
Device dialog appears.



4. Complete the following:

Name - Enter a name to identify themeter.

Type - Select Modbus TCP Device from the dropdown list.

IP Address - Enter the IP address for theModbus TCP.

Port - Select 502 from the dropdown list.

Group - Select a group name from the list or enter a name to define a new group.

5. Click theDisplay tab and select the CM4000 (EPSS) template option.

6. Click OK. Themeter is added to the Network Viewer.

7. In the Network Viewer, click themeter icon. The setup screens appear in the Content Viewer.

The following image shows the setup screens. Use the I/O Setup, Onboard Alarms/Events, and
Data Log setup screens to access the parameters that need to be configured. The remaining topics
in this chapter describe the parameter changes that are required.
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Digital and analog input configuration
This section describes how to configure digital and analog inputs to record data on CM4000 series
powermeters for the ATSs and generators.

Configuring digital inputs
In the Content Viewer, double-click I/O Setup to access the Digital Inputs for themeter.

1. Select the I/O point that you want to configure and click Edit.
The following image shows Dig In B-S1 selected.

2. Update the Label field with the name that ends with the $ character.
The $ character activates the translated device dynamic labeling feature. If the $ character is
not used, the default label is used.

l For an ATS, examples of labels that conform to the naming convention are EPSS_Test$,
EPSS_Emerg$, EPSS_Norm$, and EPSS_Util$.

l For a generator, examples of labels are EPSS_Start$, EPSS_Run$, and EPSS_Stop$.

3. SetMode to Normal, Pulse Weight to a non-zero value, for example 100, and leaveUnits set
as NoUnits.

4. Click OK to update the parameters and to close the dialog.



5. Repeat the steps above for each I/O point that you want to configure.

6. Click Send to save the changes and send the configuration to themeter.

Configuring analog inputs
In the Content Viewer, double-click I/O Setup to access the Analog Inputs for themeter.

1. Select the I/O point that you want to configure and click Edit.
The following image shows Alog In C-AI1 selected.

2. Click Edit to open the parameter window for the I/O point and update the Label field with a
name that ends with the $ character.

For a generator, examples of labels for analog inputs are Exhaust Gas L$, Exhaust Gas
R$, and Coolant T$.

The following image shows the label updated to Exhaust Gas L$.
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3. Click OK to update the parameters and to close the dialog.

4. Repeat the steps above for each I/O point that you want to configure.

5. Click Send to save the changes and send the configuration to themeter.

Onboard alarms and events configuration
For each digital input configured in I/O setup, configure the alarms to record when the digital input on
an ATS or a generator changes from OFF to ON, and from ON toOFF.

Configuring digital input alarms for ATSs
This section assumes that you configured digital inputs Dig In B-S1 as EPSS_Test$, Dig In B-S2
as EPSS_Emerg$, andDig In B-S3 as EPSS_Norm$.

Changing digital input from OFF to ON

1. In the Content Viewer, double-click Onboard Alarms/Events to open theSetup dialog.

2. Select Digital and click Edit to open theDigital Alarm Setup dialog.

3. Select one of the Digital Input/Output points.

The following figure shows theDig In B-S1 input selected and its EPSS_Test$ label,
configured in I/O Setup.



4. Select Status Input On from the list to set the alarm when the digital input changes from OFF
to ON.

5. Make sure that Enable is selected.

6. In the Label field, change the digital alarm name from Dig In B-S1 to Test ON.

7. Set Priority to High(1), and select Data Log 2 as the data log to use.
When the status for EPSS_Test$ changes to ON, Data Log 2 records all channels currently
configured on it.
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Changing digital input from ON to OFF

1. Click Add to add another digital input alarm parameter to the list in the left pane of theDigital
Alarm Setup dialog.

NOTE: If all 40 available digital input alarms have been configured already, you need to re-
configure an existing alarm for the ON to OFF status change.

2. Select Status Input Off from the list to set the alarm when the digital input changes from ON
toOFF.

3. Select EPSS_Test$ from the list.

4. Make sure that Enable is selected.

5. In the Label field, change the digital alarm name to Test OFF.

6. Set Priority to High(1), and select Data Log 2 as the data log to use.

7. Repeat the steps above to configure alarms for digital input changes from OFF to ON and from
ON toOFF for all of the applicable I/O points.

The following table summarizes the configuration of the alarms, assuming that the I/O points
are Dig In B-S1, Dig In B-S2, and Dig In B-S3:

Digital Input Label Maps to Alarm Status Alarm Name

EPSS_Test$ Digital In B-S1 Status Input On Test ON

EPSS_Test$ Digital In B-S1 Status Input Off Test OFF

EPSS_Emerg$ Digital In B-S2 Status Input On EmergON



EPSS_Emerg$ Digital In B-S2 Status Input Off EmergOFF

EPSS_Norm$ Digital In B-S3 Status Input On NormalON

EPSS_Norm$ Digital In B-S3 Status Input Off NormalOFF

8. Click OK to close the dialog.

9. Click Send to save the changes and send the configuration to themeter.

Configuring Digital Input Alarms for Generators
This section assumes that you configured digital inputs Dig In B-S1 as EPSS_Start$, Dig In B-
S2 as EPSS_Run$, andDig In B-S3 as EPSS_Stop$.

Digital input change from OFF to ON

1. In the Content Viewer, double-click Onboard Alarms/Events to open theSetup dialog.

2. Select Digital and click Edit to open theDigital Alarm Setup dialog.

3. Select one of the Digital Input/Output points.

The following screenshot shows theDig In B-S1 input selected and its EPSS_Start$ label,
as configured in I/O Setup.

4. Select Status Input On from the list to set the alarm when the digital input changes from OFF
to ON.

5. Make sure that Enable is selected.
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6. In the Label field, change the digital alarm name from Dig In B-S1 toStart ON.

7. Set Priority to High(1), and select Data Log 2 as the data log to use.
When the status for EPSS_Start$ changes to ON, Data Log 2 records all channels currently
configured on it.

Digital input change from ON to OFF

1. Click Add to add another digital input alarm parameter to the list in the left pane of theDigital
Alarm Setup dialog.

NOTE: If all 40 available digital input alarms have been configured already, you need to re-
configure an existing alarm for the ON to OFF status change.



2. Select Status Input Off from the list to set the alarm when the digital input changes from ON
toOFF.

3. Select EPSS_Start$ from the list.

4. Make sure that Enable is selected.

5. In the Label field, change the digital alarm name toStart OFF.

6. Set Priority to High(1), and select Data Log 2 as the data log to use.

7. Repeat the steps above to configure alarms for digital input changes from OFF to ON and from
ON toOFF for all of the applicable I/O points.

The following table summarizes the configuration of the alarms, where the I/O points are Dig In
B-S1, Dig In B-S2, and Dig In B-S3:

Digital Input Label Maps to Alarm Status Alarm Name

EPSS_Start$ Dig In B-S1 Status Input On Start ON

EPSS_Start$ Dig In B-S1 Status Input Off Start OFF

EPSS_Run$ Dig In B-S2 Status Input On RunON

EPSS_Run$ Dig In B-S2 Status Input Off RunOFF

EPSS_Stop$ Dig In B-S3 Status Input On StopON

EPSS_Stop$ Dig In B-S3 Status Input Off StopOFF

8. Click OK to close the dialog.

9. Click Send to save the changes and send the configuration to themeter.

Defining a Digital Alarm for a Single Digital Input

If a single digital input is used to record signals indicating when the generator is running, and also
when the generator has stopped, you need to define the digital alarm as follows:

1. In theDigital Alarm Setup dialog, select the Digital Input/Output point that will be used to
record the alarm. For example, if you configuredDig In B-S1with a label of EPSS_Run$,
select this I/O point.

2. Select Status Input On from the list to set the alarm when the digital input changes from OFF
to ON.

3. Make sure that Enable is selected.

4. In the Label field, change the digital alarm name from Dig In B-S1 toRun ON.

5. Set Priority to High(1), and select Data Log 2 as the data log to use.

EPSS_Run$: Digital Input Change from ON to OFF

1. Click Add to add another digital input alarm parameter to the list in the left pane of theDigital
Alarm Setup dialog.

2. Select Status Input Off from the list to set the alarm when the digital input changes from ON
toOFF.

3. Select EPSS_Run$ from the list.
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4. Make sure that Enable is selected.

5. In the Label field, change the digital alarm name toStop ON.

6. Set Priority to High(1), and select Data Log 2 as the data log to use.

7. Click OK to close the dialog.

8. Click Send to save the changes and send the configuration to themeter.

Because of this alarm configuration where EPSS_Run$ represents both the Running and Stopped
states for the generator, whenRun ON is TRUE, the signal is recorded as "1", and whenStop ON
is TRUE, the signal is recorded as "0".

Configure the Data Log Parameters
This section describes how to define data log parameters for the digital inputs, analog inputs, and
load profile data. The instructions assume that you use Data Logs 2 and 3. However, you can use
any Data Log that meets your requirements.

Define Data Log Parameters for Digital Inputs
Complete the following steps to define the data log parameters for the digital inputs.

1. In the Content Viewer, double-click Data Log #2 to open theSetup dialog for the data log para-
meters.

2. Set Status to Enable and Interval to Only On Event.

3. Select Channels, click Edit. The Parameter Selection screen appears.

4. In theAvailable box, navigate to Inputs/Outputs and select a custom label, such as EPSS_
Emerg$.

5. UnderDigital Input, select the IO Point xx Digital State, where xx is the number of the I/O
point present on themeter. Click >> to move the parameter to theSelected box.



6. Repeat steps 4 - 5 for all I/O points available for the ATS or generator.

7. In theAvailable box, expandMiscellaneous and select Present MilliSeconds. Click >> to
move it to theSelected box.

NOTE: Add all I/O points for a given ATS or generator to the data log to help ensure that all
of the states are recorded in the data log when any state changes.

8. Click OK to close the screen.

9. Click Send to save the changes and send the configuration to themeter.

Define Data Log Parameters for Analog Inputs and Load Profile Data
Configure the system to log the analog inputs and load profile data automatically when the generator
state changes to Running. When the generator state is Running, the alarm status for digital input
EPSS_Run$ is ON.

Using ION Setup, the process to configure automatic logging is:

1. Associate Data Log 3 with the digital input alarm Run ON that you previously defined for
EPSS_Run$.

2. Select the parameters for the Analog Input data to be logged in Data Log 3.

3. Select the parameters for the Load Profile data to be logged in Data Log 3.

4. Set the status of Data Log 3 to Auto-Enable.

These steps assume that you use Data Log 3.

Associate Data Log 3 with the Digital Input Alarm Run ON
1. In the Content Viewer, double-click Onboard Alarms/Events to open theSetup dialog.

2. Select Digital and click Edit to open theDigital Alarm Setup dialog.

3. Select the digital input alarm Run ON that was defined for I/O point EPSS_Run$. You pre-
viously selected Data Log 2 when you configured this digital input alarm for the generator.
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4. In theCapture on Event list, select Data Log 3. Now both Data Logs 2 and 3 are selected.

5. Click OK to close the screen.

6. Click Send to save the changes and send the configuration to themeter.

Select Parameters for Analog Input Data to be logged in Data Log 3
1. In the Content Viewer, double-click Data Log #3 to open theSetup dialog.

2. Select Interval and click Edit to open theEnter Logging Interval dialog.

3. In theMode list, select Continuous. Set Interval to 1minute, and click OK to close the dia-
log.



4. Select Channels, click Edit. The Parameter Selection screen appears.

5. In theAvailable box, navigate to Inputs/Outputs and select a custom label, such as
Exhaust Gas L$.

6. UnderAnalog Input, select the IO Point xx Analog Input Value, where xx is the number of
the I/O point present on themeter. Click >> to move the parameter to theSelected box.

7. Repeat steps 4 - 5 for each analog input available for the generator.

8. Click OK to close the dialog.

9. Click Send to save the changes and send the configuration to themeter.

Select Parameters for Load Profile Data to be logged in Data Log 3
1. In theSetup dialog for Data Log 3, select Channels and click Edit. TheParameter Selection

dialog appears.
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2. Expand each of the following categories. Within each category, select the parameters indic-
ated. For each parameter click >> to move it to theSelected column:

a. InCurrents, select Current A, Current B, Current C, Current N, and Current Avg.

b. InMinimum Readings, select Min Apparent Power Total, Min Real Power Total.

c. InMiscellaneous, select Frequency.

d. InPowers, select Real Power Total and Apparent Power Total.

e. InVoltages, select Voltage A-B, Voltage B-C, Voltage C-A, Voltage L-L Avg, Voltage A-N,
Voltage B-N, Voltage C-N, and Voltage L-N Avg.

3. Click OK to close the dialog.

4. Click Send to save the changes and send the configuration to themeter.

Set the Status of Data Log 3 to Auto-Enable
Auto-Enable is a special mode that allows logging to be triggered when an alarm occurs. Data is
recorded in the data log at a defined interval if the loggingmode is set toContinuous. Logging stops
when the alarm ends.

1. In theSetup dialog for Data Log 3, select Status and click Edit. TheSelect Status dialog
appears.



2. Select Auto-Enable in the dropdown list and click OK.

3. Click Send to save the changes and send the configuration to themeter.

You can also use Vista to set a Data Log to Auto-Enable. See "Configuring Auto-Enable data logs
for CM4000 and PM800 series" on page 277.

Configuring Auto-Enable data logs for CM4000 and PM800 series
This section explains how to use Vista to configure the data logs for PM800 Series Meters and the
CM4000 Series Meters for auto-enable.

Auto-Enable is a special mode that allows logging to be triggered when an alarm occurs. Data is
recorded in the data log at a defined interval if the loggingmode is set toContinuous. Logging stops
when the alarm ends. The following instructions assume that you associated Data Log 2 with the
digital input alarm Run ON to log the analog inputs and load profile data.

For information about using ION Setup to set a Data Log to Auto-Enable, see:

l For PM800 series meters, see "Set the Status of Data Log 2 to Auto-Enable" on page 258.

l For CM4000 series meters, see "Set the Status of Data Log 3 to Auto-Enable" on page 276.

Use Vista to set a data log to Auto-Enable
Complete the following steps to use Vista to set the status of Data Log 2 to Auto-Enable.

1. Open Vista and select File > New to open an empty workspace.

2. Ensure that the Toolbox is open. If not, select Options > Show Toolbox.

3. In the Toolbox, select aControl Object and drag it to the workspace.

4. Right-click the control object. TheControl Object Configuration screen appears.
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5. Click the Link tab. In the Link area, select Custom, and then click Edit Link. TheCreate
Link screen appears.

6. In theNodes list, double-click themeter name. The associatedmodule directories appear in
theManagers list.

7. In theManagers list, double-click Resets and Triggers.

8. In theModules list, double-click Log Auto-Enables.

9. In theOutput Registers list, select Data Log 2 Auto-Enable.

10. Click OK to save the selection and to close the screen.

11. Double-click the control object in the workspace to set Data Log 2 on themeter to Auto-
Enable.

Verify that Data Log 2 has been set to Auto-Enable
You can verify that Data Log 2 has been set to Auto-Enable by adding a numeric object to the
workspace and linking it to a setup register for the Data Log.

1. In Vista, ensure that the Toolbox is open. If not, select Options > Show Toolbox.

2. In the Toolbox, select aNumeric Object and drag it to the workspace.

3. Right-click the numeric object. TheNumeric Object Configuration screen appears.

4. Click the Link tab. In the Link area, select Custom and press theCtrl key while clickingEdit
Link. TheCreate Link screen for Setup Registers.



5. In theNodes list, double-click themeter name. The associatedmodule directories appear in
theManagers list.

6. In theManagers list, double-click Data Recorders.

7. In theModules list, double-click Data Log 2.

8. In theSetup Registers list, select RE2 Enabled.

9. Click OK to save the selection and to close the screen.

When the numeric object displays "Auto," you have confirmation that Data Log 2 has been set
successfully to Auto-Enable by the control object.

Configuring SER-2408/SER-3200
The SER-2408/SER-3200 Sequence of Event Recorders can be used with the software to record
status changes of the ATSs and generator contacts in the onboard data logs.

NOTE: SER3200 are recommended for PowerMonitoring Expert 8.2 – Data Center Edition.

The process to set up the SER-2408/SER-3200 with PowerMonitoring Expert 8.2 – Healthcare
Edition includes these steps:

1. Install hardware and configure device communications and digital inputs.

The SER-2408/SER-3200 can be configured using the integral webserver of the device. Enter
the IP address of the device in the browser to open the setup page. Refer toSER-3200/SER-
2408 Instruction Bulletin: User's Guide for instructions.
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Perform the following steps from theSER-3200/SER-2408 Instruction Bulletin: User's Guide
before proceeding:

2. In your browser, enter your device IP address and press Enter. Log in using your Login ID and
password.

3. Click SETUP, and then click Time. Set the time/clock correctly for your location.

4. Click SETUP, and then click Inputs. Configure all necessary inputs and select theEnabled
check box next to each input. When finished, click Apply.

5. Click SETUP, and then click Groups. Assign a group to each input. When finished, click
Apply.



6. Make sure that you enable logging for all above groups.

If you do not enable the logs in the groups section when configuring the device, the inputs will
not be available and will not appear in the Generator Performance Configuration tool.

For more information on configuring the communications and digital inputs for this device, see
theSER-3200/SER-2408 Instruction Bulletin: User's Guide.

7. Add the device in Management Console.

8. Open Vista to verify communications.

9. Use theGenerator Performance Configuration Tool to assignmeasurements for generators or
ATS equipment.

After you complete the above steps, you can generate the EPSS or Generator Test Report for data
recorded by the SER-2408/SER-3200.

WARNING
UNINTENDED OPERATION

• Do not use the SER-2408/SER-3200 with either PowerMonitoring Expert or ION Setup for
critical control or protection applications where human or equipment safety relies on the
operation of the control circuit.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Refer to your powermeter's technical documentation for more information on its operation.

Adding the SER-2408/SER-3200 to Management Console
In Management Console, add the SER-2408/SER-3200 as an Ethernet device.

NOTE: For proper operation, the devicemust have theUnit ID value set to 1.
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Follow these steps to set the deviceUnit ID:

1. As you enter the device details in the Ethernet Device Configuration screen, right-click the
screen and click Advanced.

The Advanced Properties for the device appear.



2. In the Unit ID field, enter 1.

3. Click OK.

4. Verify the device status is "Device Connected" as shown next.

Verify Device Communications in Vista
After you add the device toManagement Console, you can open Vista to view the device's counter,
input/output status, and data logs.

The following examples show the device diagram and recorded data details.
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Assign Measurements for Generators or ATS Equipment
After device data is logged into the database, you can assign devicemeasurements using the
Generator Performance Configuration Tool or Generator Performance Configuration Tool with EPSS
Test Module.

Add the device and select themeasurements for the generator or ATS as explained in these
sections:

l "Define generators" on page 72

l "Define EPSS generators" on page 38

l "Define EPSS transfer switches" on page 46

The required status measurements for the SER-2408/SER-3200 are “Digital Input Status X” where
X = input of the SER-2408/SER-3200. On theGenerators tab, the selected source and
measurement resemble the following example:



Interpreting the Energy Regression Analysis Report
results

The Energy Regression Analysis Tool is a highly configurable tool that allows you tomonitor and
manage a building or facility’s energy and resource consumption. This practice, called energy
modeling, involves analyzing building energy systems, monitoring energy consumption, and
detecting anomalies or changes in system behavior that may require that you perform energy
efficiency upgrades or fixes. The Energy Regression Analysis Report allows you tomodel energy
data one independent variable at a time with a wide range of desired independent variables, such as
weather or occupancy rate.

It is recommended that users have a basic understanding of energy modeling and understand how
to create an Energy Regression Analysis Report. This section discusses in detail the purpose of
each parameter in the report and how to read and interpret meaningful results of an Energy
Regression Analysis Report. After generating the report, conclusions can be drawn from the
generated tables and charts to monitor energy consumption andmake cost saving decisions.

Energy Regression Analysis Report results provide a characterization of a building's performance.
You can perform different types of energy analysis with this information, including the following:

l Energy Benchmarking

l Energy Budgeting

l Energy Savings

Glossary of terms
Term Definition

Cooling Degree Days (CDD) Measurement designed to reflect the demand for energyneeded to cool a
building.

Cost SavingsAnalysis Comparing energyprofiles against expected profiles and identifying outlying
data that maysignify areasof improvement.

Degree Day One degree of departure, on a single day, of the dailymean temperature from a
given standard temperature.
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EnergyBenchmarking Comparing the energyperformance of similar buildings, or comparing the
energyperformance of a single building over time.

EnergyBudgeting Determining future energyuse and associated costs for different timesof the
year.

EnergyModeling Computerized simulation of a building that focuseson energy consumption,
utility bills and life cycle costs of variousenergy related itemssuch asair
conditioning, lights, and hot water.

EnergySavings Measuring savingsby comparing performance profiles before and after energy
efficiencymodifications.

EnergyUse Breakdowns Disaggregating building energy into different categories, such asweather-
dependent energyuse or weather-independent energyuse.

Heating Degree Days (HDD) Measurement designed to reflect the demand for energyneeded to heat a
building.

Performance (Regression) Line The statistical line of best fit.

Regression Analysis Statistical process for estimating the relationshipsamong variables. Includes
many techniques for modeling and analyzing several variables, when the focus
is on the relationship between a dependent variable and one or more
independent variables.

Reading the report
This section discusses how to read the different types of information in the report.

For information on how to configure and use this report, see "Configure and generate the Energy
Regression Analysis Report" on page 27.

Report Parameters Summary table
The Report Parameters Summary table appears at the beginning of the report. Based on what you
select for theShow Report Parameters Summary option on the prerequisite page, you canmake
this table appear or be hidden in the report.

This table provides important details, such as data sources, calculationmethods, and other
parameters about how the report inputs are configured that can help the user understand report
results.

Regression Analysis Chart
The Regression Analysis Chart shows the relationship between the driver andmodel data.

In this chart, the blue dots represent real data points. In this case, the data is aggregated weekly
over the course of one year, therefore, there are 52 data points with each data point representing one
week of the year. The yellow line is the regression line, or performance line, of the building. The
performance (regression) line is the best fit line--a line that indicates the expected energy



consumption. The slope of the performance line is ameasure of how much extra fuel, energy, or
other resource is consumed for an increase in the independent variable (such as degree days,
production units, and so forth).

Deviations between building performance lines over timemeans that something has changed in the
way the facility consumes energy. This may be a result of energy efficiency modifications, or it
could indicate an issue with building systems, equipment, or processes. The performance line
provides a benchmark by which changes in energy consumption can bemonitored, and appropriate
actions can be taken if variations are detected.

The point of intersection between the two performance lines is called the breakpoint. For energy
consumption analyzed with respect to average temperature, the breakpoint indicates the
temperature at which heating or cooling of a facility begins. Therefore, having a breakpoint further to
the right is better because this indicates that heating or cooling systems are running for less time,
which results in less energy usage.

Regression Analysis Main Characteristics Table
The Regression Analysis Main Characteristics Table provides information about the Regression
Analysis Chart.
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TheSide column shows the left and right sides. TheSlope column shows the slope values of the
two best-fitting lines intersect. This intersection point is called the breakpoint. TheY-Intercept
column shows a point where the graph of a function or relation intersects with the y-axis of the
coordinate system. Therefore, these points satisfy x = 0.

TheR2 column shows a value that indicates how well the data fits themodel. TheRMSE column
shows the square root of themean/average of the square of the error. TheX Value andY Value
columns show the coordinates of the Change point.

Monitoring the slopes and breakpoint values provides useful information about a facility’s energy
consumption. Flatter slope lines are better as they indicate a smaller increase in energy
consumption for every additional unit of the independent X-axis variable.

For more information on interpreting the report results, see "Interpreting the report" on page 290.

Measured Values Against Expected Values Chart
TheMeasured Values Against Expected Values Chart shows the relationship between themodel
data and time.

In this chart, the blue line indicates the real energy usage over time and the performance line
indicates the expected energy usage over time based on the regression analysis.

The time axis, or X-axis, has different units depending on the selected aggregation period. For
weekly aggregation, the numbers on the X-axis represent the weeks of the year and for daily
aggregation, they represent the days of the year. The year or years contained within the reporting
period are displayed on the chart directly below the X-axis values.

Exceptions Table
The Exceptions Table below shows information for any data point that falls outside of the exception
range defined by the Deviation Type andMax Authorized Deviation parameters.



If there are no exception points, this table does not appear in the report.

Full Table
The Full Table below shows information for all data points.

Within the Full Table, there is a row with missing values.

This row stores information about the breakpoint from the Regression Analysis Chart.

This report generates with almost any set of data and regardless of other parameter selections.
However, the generated report is only of assistance inmonitoring energy consumption if the
parameters are configured correctly and with specific intent.
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The following section provides specific examples of how to use the Energy Modeling Report to
monitor certain aspects of a facility’s energy consumption.

Interpreting the report
After generating the report, the data can be analyzed in different ways to draw different conclusions
about energy and resource consumption. Below are two examples involving different independent
variables.

Example 1: Justifying Energy Efficiency Upgrades
Regression analysis of energy or resource consumption with respect to Degree Days can provide
valuable information about a facility’s energy efficiency with respect to outside changes in
temperature. Such information can be used to determine when energy efficiency upgrades are
necessary, and tomonitor the effectiveness of such solutions after implementation.

For example, a facility manager could compare the Heating Degree Day energy profile of their
building to another facility in a similar climate. If the other building proves to bemuchmore energy
efficient, an analysis could be performed on the differences in building design that could cause
these results. Perhaps the only significant difference is that themore efficient building recently
upgraded their insulation. The less efficient building could then use this information, along with the
Regression Analysis charts to pitch the case that an insulation upgrade should take place to reduce
natural gas usage at the facility.

If the upgrade is successful, a change appears in the Regression Analysis chart the following year.
The chart above shows a possible Regression analysis for the year before the energy efficiency
modifications. The red line in the chart shows how the performance lines and breakpoint could
change when the upgrades are successful. The slopes of the lines in the second figure are flatter,
indicating less energy usage for every additional degree day. The breakpoint also occurs later,
indicating that heating does not have to begin at as low of a temperature as before, thereby saving
additional resources.

Example 2: Identifying Equipment Failure
Regression analysis can also be used to detect equipment deterioration or failure. Below are two
Regression Analysis charts showing natural gas consumption with respect to production units.

The red line in the chart has a steeper slope and an earlier X-axis intersection point. This indicates
that more natural gas is being used for every unit of production. If data for these charts is collected
over different periods of time, but with no changes tomanufacturing processes or equipment, the
steeper regression line in the second chart could indicate deterioration of equipment.



Plotting energy consumption data against any independent variable, not just time, allows you to
analyze in greater detail the energy efficiency of your buildings or facilities, and tomake necessary
upgrades or cost analysis decisions.

Conclusion
Energy modeling is a relatively new practice for monitoring and analyzing energy consumption in
buildings and facilities. It involves using computerized simulations to analyze energy consumption,
and it allows customers to understand their expected energy consumption and use this information
tomake system design decisions and perform cost benefit analysis.

The Energy Modeling Report, or XY Regression Report, allows users to create energy profiles for
their buildings or facilities. These benchmark energy models provide valuable information about
energy and resource consumption that can help Facility Managers save resources by identifying
and addressing consumption issues.

Recommendations
Many of the report parameters on the prerequisite page are interdependent and configuring this page
requires close attention. It is recommended to rely on documentation to correctly configure the
report. Note that there is no filtering of parameters on the prerequisite page.

Generator system redundancy types
You can create a generator system to achieve power redundancy for IT equipment loads in different
ways, depending on how the generators are grouped together and how they are connected to the
equipment power supplies. This configuration tool supports several industry standard
configurations.

The generator system supports the following redundancy design types:

l "N Type" on page 292

l "N+1 Type" on page 292

l "N+2 Type" on page 293

l "2N Type" on page 293

l "2(N+1) Type" on page 294

l "2(N+2) Type" on page 295

Before generator-related reports can be produced you need to define a generator system in the
Generator Power Configuration Utility.
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N Type
The N system configuration is for one or more generators that work together to supply power to the
IT load, when the utility or utilities’ power is unavailable. There is no redundancy. The intention is to
size the generator system tomatch the peak IT load on the utility power.

N+1 Type
The N+1 system configuration is for one or more generators that work together to supply power to
the IT load. There is simple generator redundancy in that one of the generators can stop functioning
or be taken off-line, if the utility power is interrupted. The load is spread among all generators, but
the peak load is such that if one generator stops working, the others will be able to assume its load.
Another way to look at it is, N generators will be able to support the peak IT load. If the peak IT load
is more than N can support, then system design redundancy will be lost.

For example, if three generators are connected to the IT loads, in an N+1 system, the peak utility
loadmust not exceed the non-redundant capacity of two of the generators. If it does, the designed
redundancy will be lost.



N+2 Type
The N+2 system configuration is for a group of generators that work together to supply power to a
medium voltage substation and is then distributed to low voltage loads. There is simple generator
redundancy in that any two of the generators can stop functioning or be taken off-line, if the utility
power is interrupted. The load is spread among all generators, but the utility peak load is such that if
two generators stop working, the others will be able to assume their load. Another way to look at it
is, N generators will be able to support the peak utility load. If the peak utility load is more than N
can support, then system design redundancy will be lost.

For example, if five generators are connected to the IT loads, in an N+2 system, the peak utility load
must not exceed the non-redundant capacity of three of the generators. If it does, the designed
redundancy will be lost.

2N Type
The 2N system configuration is for two groups of generators that supply power to the IT loads. In a
2N system, an entire group of generators can stop functioning or be taken off-line and the equipment
will still be supplied with power, if the utility power is interrupted. The load is spread among all
generators, but the peak load is such that, if an entire group of generators stop working, the
remaining generators will be able to assume the entire load. Another way to look at it is, N
generators will be able to support the peak utility load. If the peak utility load is more than N can
support, then system design redundancy will be lost.

In this example, there are two groups with three generators in each. In a 2N configuration, one group
of generators can go offline and the system will still have the designed redundancy. Therefore, the
value for N is three. So, the total peak utility load cannot exceed the derated nameplate of three of
the generators.
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2(N+1) Type
The 2(N+1) system configuration is for two groups of generators that supply power to the IT loads.
In a 2(N+1) system, an entire group of generators plus onemore generator from each of the
remaining groups can stop functioning or be taken off-line, and the equipment will still be supplied
with power, if the utility power is interrupted. The load is spread among all generators, but the peak
load is such that if an entire group’s worth of generators goes offline, plus onemore from each of the
other groups stop working, the remaining generators will be able to assume the entire load. Another
way to look at it is, N generators will be able to support the peak utility load. If the peak utility load is
more than N can support, then system design redundancy will be lost.

In this example, there are two groups with five generators in each. In a 2(N+1) configuration, one
group of generators can go offline, plus onemore generator from the remaining group and the
system will still have the designed redundancy. Therefore, the value for N is four. So, the total peak
utility load cannot exceed the derated nameplate of four of the generators.



2(N+2) Type
The 2(N+2) system configuration is for two groups of generators that supply power to the IT loads.
In a 2(N+2) system, an entire group of generators plus twomore generators from each of the
remaining groups can stop functioning or be taken off-line and the equipment will still be supplied
with power, if the utility power is interrupted. The load is spread among all generators, but the peak
load is such that if an entire group’s worth of generators goes offline, plus twomore from each of the
other groups goes offline, the remaining generators will be able to assume the entire load. Another
way to look at it is, N generators will be able to support the peak utility load. If the peak utility load is
more than N can support, then system design redundancy will be lost.

In this example, there are two groups with four generators in each. In a 2(N+2) configuration one
group of generators can stop working, plus twomore generators from the remaining group and the
system will still have the designed redundancy. Therefore, the value for N is two. So, the total peak
utility load cannot exceed the derated nameplate of two of the generators.

UPS system redundancy types
You can create a UPS system to achieve power redundancy for IT equipment loads in different
ways, depending on how the UPS units are grouped together and how they are connected to the
equipment power supplies. This configuration tool supports several industry standard
configurations.

The UPS system supports the following redundancy design types:

l "N Type" on page 296

l "N+1 Type" on page 296

l "N+2 Type" on page 297

l "2N Type" on page 298

l "UPS system redundancy types" on page 295

l "UPS system redundancy types" on page 295
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N Type
The N system configuration is for one or more UPS modules which work together to supply power to
the IT load. There is no redundancy, except optionally to the second power supply of each piece of
equipment.

Each UPS system with an N configuration can havemultiple UPS groups, where each group is
connected to a different load. The number of modules within each UPS group can be different.
Within each group, all UPS modules must have the same derated nameplate rating value (kW).

N+1 Type
The N+1 system configuration is for one or more UPS modules that work together to supply power
to the IT load. There is simplemodule redundancy in that one of themodules can be rendered
inoperative or be taken off-line. The load is spread among all remaining UPS modules, but the peak
load is such that if onemodule stops working, the others will be able to assume its load. Another
way to look at it is, N UPS modules will be able to support the peak IT load. If the peak IT load is
more than N can support, then system design redundancy will be lost.

There is the option to connect the system of modules to the second power supply of each piece of
equipment, but both power supplies are connected to the group of UPS modules.

Each UPS system with an N+1 configuration can havemultiple UPS groups, where each group is
connected to a different load. The number of modules within each UPS group can be different. The
modules within a UPS groupmust have the same derated nameplate rating value (kW).



N+2 Type
The N+2 system configuration is for a group of UPS modules that work together to supply power to
the IT load. There is simplemodule redundancy in that any two of themodules can be rendered
inoperative or be taken off-line. The load is spread among all remaining UPS modules, but the peak
load is such that if twomodules stop working, the others will be able to assume their load. Another
way to look at it is, N UPS modules will be able to support the peak IT load. If the peak IT load is
more than N can support, then system design redundancy will be lost. An example of an N+2
system is five UPS modules connected to the IT load, but the peak IT load never exceeds the
capacity of three of the UPS modules.

There is the option to connect the system of modules to the second power supply of each piece of
equipment, but both power supplies are connected to the group of UPS modules.

Each UPS system with an N+2 configuration can havemultiple UPS groups, where each group is
connected to a different load. The number of modules within each UPS group can be different. The
modules within a UPS groupmust have the same derated nameplate rating value (kW).

Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide Reference

© 2017Schneider Electric. All RightsReserved. Page 297 of 308



Reference Power Monitoring Expert 8.2 SoftwareModules– Configuration Guide

Page 298 of 308 © 2017 Schneider Electric. All RightsReserved.

2N Type
The 2N system configuration is for two or three groups of UPS modules that supply power to two
different power supplies in each IT load. For redundancy, an entire UPS group can stop working or
be taken off-line, and the IT equipment will still be supplied with power. It alsomeans that either one
of the two power supplies in an IT load can be rendered inoperative. The load is spread among all
UPS modules, but the peak load is such that if an entire group’s worth of modules is not working,
the remainingmodules will be able to assume their load. Another way to look at it is, N UPS
modules will be able to support the peak IT load. If the peak IT load is more than N can support, then
system design redundancy will be lost.

Each UPS system with a 2N configuration can have two or three UPS groups. If there are two
groups, bothmust be connected to the same load. If there are three groups, then there are three
separate loads and each group is connected to two of the loads. The number of modules within each
UPS group in a UPS systemmust be the same in a 2N configuration. Additionally, all UPS modules
within a UPS groupmust have the same derated nameplate rating value (kW).

In the first example, there are two groups with four UPS modules each. In a 2N configuration, one
group can stop working and the system will still have the designed redundancy. Therefore, the value
for N is four. So, the total IT load cannot exceed the derated nameplate rating of four of the UPS
modules.

In the second example, there are three groups with four UPS modules each. In a 2N configuration,
one group’s worth of UPS modules can be rendered inoperative and the system will still have the
designed redundancy. Therefore, the value for N is eight. So, the total IT load (for all three IT load
groups shown below) cannot exceed the derated nameplate rating of eight of the UPS modules.



2(N+1) Type
The 2(N+1) system configuration is for two or three groups of UPS modules that supply power to
two different power supplies in each IT load. The redundancy providedmeans that an entire group of
UPS modules, plus onemoremodule from the remaining groups, can stop working or be taken off-
line, and the IT equipment will still be supplied with power. It alsomeans that either one of the two
power supplies in an IT load can be rendered inoperative. The load is spread among all UPS
modules, but the peak load is such that if an entire group’s worth of modules be rendered
inoperative, plus onemore from each other group, the remainingmodules will be able to assume
their load. Another way to look at it is, N UPS modules will be able to support the peak IT load. If the
peak IT load is more than N can support, then system design redundancy will be lost.

Each UPS system with a 2(N+1) configuration can have two or three UPS groups. If there are two
groups, bothmust be connected to the same load. If there are three groups, then there are three
separate loads and each group is connected to two of the loads. The number of modules within each
UPS group in a UPS systemmust be the same in a 2(N+1) configuration. Additionally, all UPS
modules within a UPS groupmust have the same derated nameplate rating value (kW).

In the first example, there are two groups with four UPS modules in each group. One group plus one
UPS module from the other group can be rendered inoperative, and the system will still have the
designed redundancy. Therefore, the value for N is three. So, the total IT load cannot exceed the
derated nameplate rating of three of the UPS modules.
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In the second example, there are three groups with four UPS modules in each group. One group plus
onemodule from each of the other two groups can stop working and the system will still have the
designed redundancy. Therefore, the value for N is six. So, the total IT load (for all three IT load
groups shown below) cannot exceed the derated nameplate rating of six of the UPS modules.

2(N+2) Type
The 2(N+2) system configuration is for two or three groups of UPS modules that supply power to
two different power supplies in each IT load. The redundancy providedmeans that an entire group of
UPS modules, plus twomoremodules from the remaining groups, can stop working or be taken off-
line and the IT equipment will still be supplied with power. It alsomeans that either one of the two



power supplies in an IT load can stop working. The load is spread among all UPS modules, but the
peak load is such that, if an entire group stops working, plus twomore from the other group, the
remainingmodules will be able to assume their load. Another way to look at it is, N UPS modules
will be able to support the peak IT load. If the peak IT load is more than N can support, then system
design redundancy will be lost.

Each UPS system with a 2(N+2) configuration can have two or three UPS groups. If there are two
groups, bothmust be connected to the same IT load. If there are three groups, then there are three
separate loads and each group is connected to two of the loads. The number of modules within each
UPS groupmust be the same. All UPS modules within a groupmust have the same derated
nameplate rating value (kW).

In the first example, there are two groups with four UPS modules each. One group can be rendered
inoperative, plus twomore UPS modules from the other group and the system will still have the
designed redundancy. Therefore, the value for N is two. The total IT load cannot exceed the derated
nameplate rating of two of the UPS modules.

In the second example, there are three groups with four UPS modules each. One group plus two
modules from each of the other two groups can stop working, and the system will still have the
designed redundancy. Therefore, the value for N is four. So, the total IT load cannot exceed the
derated nameplate rating of four of the UPS modules.
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UPS Battery Health Report calculations
The following terms and explanations of various calculations are used in theUPS Battery Health
Report:

First Drop Analysis – Minimum Drop Voltage (V), Maximum Drop Voltage (V) and
Difference (%): The voltage dropminimum, maximum and percentage difference values are shown
in the Drop Analysis table section. To calculate these values, a valid waveform voltage dropmust
be found first by sampling the waveform data.

A valid voltage drop is defined as the first waveform section of size n, where the relativeminimum
andmaximum voltage values have a percentage difference d. In addition, the next sample n+1must
be greater in value than theminimum voltage, to ensure that the lowest value has been found in the
voltage drop.

The sampling section size n and the percentage difference d are determined by the user-defined
report parameters Waveform Drop Sample Size andWaveform Drop Percentage, respectively.

After the voltage drop has been found, theMinimum Voltage andMaximum Voltage are simply the
min andmax values in that drop samples, and the Difference is the percentage of themaximum
voltage over theminimum voltage. For example:

Minimum Drop Voltage = Min(ws1 <= WaveformValues < = wsN)

Maximum Drop Voltage= Max(ws1 <= WaveformValues <= wsN)

ws1 is the first point in the sample and wsN is the last point in the sample

Difference (%) = [(Maximum Drop Voltage –Minimum Drop Voltage) / Maximum Drop Voltage]

Recovery Analysis – Target Recovery Voltage (V), Actual Recovery Voltage (V) and
Recovery Time (ms):

Target Recovery Voltage (V): This value is calculated for the reference waveform only. This is
calculated as follows:



Target Recovery Voltage (V) = [Recovery Voltage * Recovery ValueMultiplier]

Where Recovery Voltage = Average(w1 <= WaveformValues < wN)

w1 is the very first point in the waveform and wN is the lowest point in the waveform voltage drop
and Recovery ValueMultiplier is a user-defined value in the report pre-requisite page

Actual Recovery Voltage (V): The first point in the reference and comparison waveforms that
occurs after the voltage drop, that is equal or greater than the Target Recovery Voltage value.

Recovery Time (ms): This is the time elapsed from theMinimum Voltage Drop time and the Actual
Recovery Voltage time, expressed inmilliseconds.

Additional calculations
Voltage Threshold: This is the red horizontal area that is highlighted in the waveform drop chart. It
represents a nominal voltage value, therefore there are no calculations for the Voltage Threshold.

For example, if the user sets the Voltage Threshold to 50V, then a red line will be drawn at 50v
(based on the Y-axis) and the area below the red line appears shaded in red.

Power Factor Rate File Calculation
This appendix explains the power factor calculations in the default rate files. To learn how tomodify
the rate files, please refer to the PME BillingModule Toolkit.

Power Factor Impact – Active Energy Billing with PF Adjustment Option 1

The utility charges according to the active energy and adds a surcharge or adjustment for power
factor.

Power Factor Impact – Active Energy Billing with PF Adjustment Option 2

The utility charges according to the active energy and adds a surcharge or adjustment for power
factor.

Power Factor Impact – Apparent Energy Billing.xml

The utility bills all consumed energy, including the reactive energy.

Power Factor Impact – Reactive Energy Billing.xml
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PQ Advisor - Supported meters
Themeter support list provides detailed information of Power Quality Advisor feature dependencies
onmeters. Use it for both greenfield and brownfield designs.

PQ Events and
Disturbances

Used by Supported Meters Supported Meter
Template

Interruptions PQAdvisor Diagrams
PQRating Gadget
PQRating TrendGadget
PQEventsBreakdownGadget
PQEvents Impact Gadget
PQEvents Location Gadget
PQ Impact Gadget
PQ Impact TrendGadget
PQ Impact Report

ION 7350, 7400, 7550, 7650, 8600A,
8600B, 8650A, 8650B, 8650C, 8800A,
8800B, 8800C, PM8000, PM870,
CM3350, CM4000
DDD Support: ION7550 V350 and
newer, ION7650 V350 and newer,
ION8650A/BV4.20 and newer,
PM8000, CM4000

All default meter
template

Voltage Sag Same as Interruptions Same as Interruptions All default meter
template

Voltage Swell Same as Interruptions Same as Interruptions All default meter
template

Transient Voltage Same as Interruptions ION 7650, 8600A, 8650A, 8650B,
8800A, CM4000T
DDD Support: ION7650 V350 and
newer, ION8650A/BV4.20 and newer,
CM4000T

All default meter
template

Over Voltage Same as Interruptions ION 7350, 7400, 7550, 7650, 8600A,
8600B, 8650A, 8650B, 8650C, 8800A,
8800B, 8800C, PM8000

All default meter
template

Under Voltage Same as Interruptions ION 7350, 7400, 7550, 7650, 8600A,
8600B, 8650A, 8650B, 8650C, 8800A,
8800B, 8800C, PM8000

All default meter
template

Voltage Unbalance PQAdvisor Diagrams
PQRating Gadget
PQRating TrendGadget
PQAnalysisReport

Logged By Default: ION 7330, 7400,
7350, 7550, 7650, 8600A, 8600B,
8650A, 8650B, 8800A, 8800B, PM8000,
CM3000, CM4000, TesysT, Micrologic
5.0/6.0/7.0 E/P/H (including IFE/IFM)
Not Logged By Default: PM8001,
PM3250, PM3255, PM5100, PM5300,
PM5350, PM5500, EM6400, EM7000,
Micrologic 5.2/6.2/5.3/6.3 E

All default meter
template

Current Unbalance PQAdvisor Diagrams
PQRating Gadget
PQRating TrendGadget
PQAnalysisReport

Logged By Default: TesysT,
Micrologic 5.0/6.0/7.0 E/P/H (including
IFE/IFM)
Not Logged By Default: PM8001,
CM3000, CM4000, PM3250, PM3255,
PM5100, PM5300, PM5350, PM5500,
EM6400, EM7000, Micrologic
5.2/6.2/5.3/6.3 A/E

n/a

Voltage Harmonics PQAdvisor Diagrams
PQRating Gadget
PQRating TrendGadget
PQAnalysisReport

Logged By Default: ION 7330, 7350,
7400, 7550, 7650, 8600A, 8600B,
8650A, 8650B, 8800A, 8800B, PM8000,
CM3000, CM4000
Not Logged By Default: ION 6200,
7300, 8600C, 8650C, 8800C, PM200,
PM700, PM8001, PM1200, PM3250,
PM3255, PM5100, PM5300, PM5350,
PM5500, EM3460, EM6400, EM7000,
Micrologic 5.2/6.2/5.3/6.3 E, Micrologic
5.0/6.0/7.0 H (including IFE/IFM)

All default meter
template except
PM8000with
IEEE519
template



PQ Events and
Disturbances

Used by Supported Meters Supported Meter
Template

Current Harmonics PQAdvisor Diagrams
PQAnalysisReport

Logged By Default: ION 7330, 7350,
7400, 7550, 7650, 8600A, 8600B,
8650A, 8650B, 8800A, 8800B, PM8000,
CM3000, CM4000
Not Logged By Default: ION 6200,
7300, 8600C, 8650C, 8800C, PM200,
PM700, PM8001, PM1200, PM3250,
PM3255, PM5100, PM5300, PM5350,
PM5500, EM3460, EM6400, EM7000,
Micrologic 5.2/6.2/5.3/6.3 E, Micrologic
5.0/6.0/7.0 H (including IFE/IFM)

All default meter
template except
PM8000with
IEEE519
template

Frequency Variation PQAdvisor Diagrams
PQRating Gadget
PQRating TrendGadget
PQAnalysisReport

Logged By Default: ION 7330, 7350,
7400, 7550, 7650, 8600A, 8600B,
8650A, 8650B, 8800A, 8800B, PM8000

All default meter
template

Flicker PQAdvisor Diagrams
PQRating Gadget
PQRating TrendGadget
PQAnalysisReport

Logged By Default: ION 7400, 7650,
8600A, 8650A, 8800A, 8800B

PQFramework
and EN50160
evaluation
enabled

NOTE: 1 PM800 series is supported except PM810 without PM810LOG.

Detailed information specifically for Power Factor:

Power
Factor

Used by Supported Meters

Power Factor Impact Gadget
Power Factor Impact Trend
Gadget

Allmeters that havemeasurements required by the calculation of the defined
rate structure.
For example:

l Active energy

l Reactive energy

l Active power

l Reactive power

PQAnalysisReport Allmeters that measuresactive energy, reactive energy, and power factor

PQ Advisor - Supported measurements
Themeasurement support list provides detailed information about the supportedmeasurements that
are compatible with the Power Quality Advisor module.

NOTE: For each disturbance category, choose only the appropriate/necessary measurements
from the supported list to log. Do NOT Log all of them. Logging all measurements can cause
unwanted database growth, and performance issues.

PQ Disturbances Used by Supported Measurements Label Name

Voltage
Unbalance

PQAdvisor Diagrams
PQRating Gadget
PQRating TrendGadget
PQAnalysis Report

ION Devices
Voltage UnbalanceMean 

V unbal mean

Non-ION Devices
Voltage Unbalance L-L
Worst
Voltage Unbalance L-N
Worst

Voltage Unbalance
L-LWorst
Voltage Unbalance
L-N Worst
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PQ Disturbances Used by Supported Measurements Label Name

Current
Unbalance

PQAdvisor Diagrams
PQRating Gadget
PQRating TrendGadget
PQAnalysis Report

Non-ION Devices
Current UnbalanceWorst

Current Unbalance
Worst

Voltage
Harmonics

PQAdvisor Diagrams
PQRating Gadget
PQRating TrendGadget
PQAnalysis Report

ION Devices
Voltage Total Harmonic
Distortion on Input V11
Voltage Total Harmonic
Distortion on Input V21
Voltage Total Harmonic
Distortion on Input V31
Voltage Total Harmonic
DistortionMean on Input V1
Voltage Total Harmonic
DistortionMean on Input V1
Voltage Total Harmonic
DistortionMean on Input V1

V1 Total HD1
V2 Total HD1
V3 Total HD1
V1 THD mean
V2 THD mean
V3 THD mean

Non-ION Devices
THD Voltage A-B
THD Voltage A-N
THD Voltage B-C
THD Voltage B-N
THD Voltage C-A
THD Voltage C-N
THD Voltage L-L
THD Voltage L-N

THD Voltage A-B
THD Voltage A-N
THD Voltage B-C
THD Voltage B-N
THD Voltage C-A
THD Voltage C-N
THD Voltage L-L
THD Voltage L-N

Current
Harmonics

PQAdvisor Diagrams
PQAnalysis Report

ION Devices
Current Total Harmonic
Distortion Phase A1
Current Total Harmonic
Distortion Phase B1
Current Total Harmonic
Distortion Phase C1
Current Total Harmonic
Distortion Phase A Mean
Current Total Harmonic
Distortion Phase B Mean
Current Total Harmonic
Distortion Phase C Mean

I1 Total HD1
I2 Total HD1
I3 Total HD1
I1 THD mean
I2 THD mean
I3 THD mean

Non-ION Devices
Current Total Harmonic
Distortion Phase A
Current Total Harmonic
Distortion Phase B
Current Total Harmonic
Distortion Phase C

THD Current A
THD Current B
THD Current C

Frequency
Variation

PQAdvisor Diagrams
PQRating Gadget
PQRating TrendGadget
PQAnalysis Report

ION Devices
Frequency Mean

Freqmean



PQ Disturbances Used by Supported Measurements Label Name

Flicker PQAdvisor Diagrams
PQRating Gadget
PQRating TrendGadget
PQAnalysis Report

ION Devices
Voltage Flicker Plt on Input
V1
Voltage Flicker Plt on Input
V2
Voltage Flicker Plt on Input
V3
Voltage Flicker Pst on Input
V1
Voltage Flicker Pst on Input
V2
Voltage Flicker Pst on Input
V3

V1-Flck Plt
V2-Flck Plt
V3-Flck Plt
V1-Flck Pst
V2-Flck Pst
V3-Flck Pst

NOTE: 1Use only for ION 6200, 7300, 8600C, 8650C and 8800C. Thesemeasurements are
NOT logged by default.

NOTE:
l PM8000 is categorized as an ION device.

l ION6200 is categorized as a non-ION device.
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